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!  
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 Предостережение 

без восклицательного знака указывает, что несоблюдение надлежащих предосторожностей 
может привести к потере свойств. 
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Предисловие 

 Цель руководства  
Это руководство по “CFC для S7” обеспечивает Вас информацией, которая 
требуется для использования инструмента конфигурации CFC при 
программировании CPU в программируемых контроллерах SIMATIC S7. 
Пожалуйста помните, что отдельные объекты, функции или 
последовательности, описанные здесь, могут отсутствовать или существовть 
в иной форме в других целевых системах, а следовательно не иметь точного 
соответствия описанннму здесь. Таким образом, некоторая информация о 
функционировнии CFC которая соответствует только контексту PCS 7 
Для полного описания CFC для других систем, Вам так же потребуются 
вспомогательные описания CFC для конкретных систем (например, "CFC для 
M7"). 

Аудитория  
Это руководство предназначено для персонала имеющего дело с 
конфигурированием, вводом в эксплуатацию и обслуживанием. 

Применимость  
Это руководство действительно для программного обеспечения CFC версии 
6.1 и выше. 

Стандарты  
Программное обеспечение CFC основано на международном стандарте DIN 
EN 61131-3 (IEC 1131-3) для языков программирования программируемых 
логических контроллеров.  

Соглашения  
Ссылки на другие документы обозначены числом в скобках /.../. 
Воспользовавшись номером, Вы можете проверить полный заголовок 
документации в разделе Ссылки в конце руководства 
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Дальнейшая поддержка 
Если у Вас есть, какие либо технические вопросы, пожалуйста, свяжитесь с 
вашим представительством Сименса или ответственным агентом. 

Вы можете найти контактное лицо на:  

http://www.siemens.com/automation/partner 

Вы можете найти указатели на техническую документацию для отдельных 
продуктов и системы SIMATIC на: 

 http://www.siemens.com/simatic-tech-doku-portal 

Интерактивный каталог и заказные номера систем можно найти на: 

http://mall.ad.siemens.com/ 

Обучающие центры 
Сименс предлагает ряд учебных курсов для знакомства Вас с 
автоматизированной системой SIMATIC S7. Пожалуйста контактируйте с 
вашим региональным учебным центром или с нашим головным учебным 
центром D 90327 Nuremberg, Germany для уточнения. 
Telephone:  +49 (911) 895-3200.  
Internet: http://www.sitrain.com  

В России: (095)-737-23-88 Екатерина Павлова 
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Техническая поддержка 
 
Вы можете получить техническую поддержку по всем продуктам A&D 

• Через Web для запроса поддержки 
http://www.siemens.com/automation/support-request 

• Телефон:  + 49 180 5050 222 

• Факс: + 49 180 5050 223 

Дополнительная информация о технической поддержек может быть найдена 
на странице Internet http://www.siemens.com/automation/service 

Сервис и поддержка через Internet 
В дополнение к документации, Вам предлагается интерактивные ноу-хау 
через Internet на: 
http://www.siemens.com/automation/service&support 

где Вы можете найти: 

• Листки новостей, которые постоянно информируют Вас об обновлении 
Ваших продуктов. 

• Нормативные документы через функцию поиска в Service & Support. 

• Форум, на котором пользователи и эксперты со всего света обмениваются 
своими мнениями. 

• Ваше местное представительство департамента Automation & Drives. 

• Информацию о серсисе, ремонте, запасных частях и многом другом  
вразделе "Services". 
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1 Суть CFC 

Введение 
Эта глава дает основную информацию о CFC, показывает, как он 
интегрирован в программный пакет STEP 7, описывает представление 
блоков, и объясняет шаги, которые требуются для создания структуры 
проекта и для тестирования программы.  

Для описания инсталляции, авторизации и запуска программного 
обеспечения CFC, прочитайте файл readme в пакете CFC. 

1.1 Общее 

Что такое CFC? 
CFC (Непрерывные Функциональные схемы) - это графический редактор, 
дополнительный к пакету STEP7. Он используется для создания из 
предварительно подготовленных блоков структуры программы для CPU 
(процессора) в целом. При работе с редактором Вы можете объединить 
блоки в функциональные схемы, назначить им параметры и соединить их 

Соединения означают, например, что величины переменных передаются от 
одного выхода блока к одному или нескольким входам других блоков. 

Как работает пакет 
В редакторе CFC, Вы работаете с графическими инструментами: Вы 
выбираете готовые блоки из совокупности блоков, помещаете их в схему (как 
бы на чертежной доске) и соединяете их с помощью мыши. Вам не требуется 
вникать в детали, такие как алгоритмы или использование машинных 
ресурсов, что позволяет полностью сосредоточиться на технологических 
аспектах Вашего проекта. 

Рабочие свойства блоков имеют установки по умолчанию, но их можно 
индивидуально настроить под каждый блок. Возможность копирования или 
перемещения между схемами отдельных или целых групп блоков сэкономит 
время Вашей работы. Соединения между блоками при этом сохраняются. 

После того как все функции написаны, Вы можете сгенерировать 
исполняемый машинный код, загрузить его в программируемый контроллер и 
проверить его с помощью тестовых функций CFC. 
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1.2 CFC в среде STEP 7   

SIMATIC Manager 
SIMATIC Manager используется как графический интерфейс для всех PLC и 
служит для координации инструментальных средств и объектов. Он 
управляет различными инструментами и данными, например, используется 
для создания и изменения структуры проекта (CPU, схем CFC), а также для 
запуска редактора CFC. 

 

AS3xx
AS4xx

SIMATIC Manager

CFC
Инструменты STEP 7 

WinCC 

OS 

 
Рисунок 1-1:  CFC в среде STEP 7  

Остальные компоненты 
В зависимости от PLC, Вы можете использовать такие компоненты, как 
различные языковые пакеты для создания типов блоков, и инструменты для 
создания входных данных схем CFC таких, как входные и выходные данные, 
на которые можно будет ссылаться из CFC. 
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1.3 Схема CFC 

Следующий раздел описывает схему CFC и ее элементы, устанавливает 
используемую терминологию. 

Схемы и разделы схемы 
Основной рабочий модуль редактора CFC  - это схема (Chart). Каждая схема 
имеет имя, уникальное для CPU. Вы можете создать схему или в SIMATIC 
Manager или непосредственно в редакторе CFC. 
Каждая часть схемы содержит до 26 разделов (partition). Вновь создаваемая 
схема состоит из одного раздела, остальные могут добавляться при 
необходимости. 

Лист и панель листа  
Каждый раздел схемы состоит из шести листов (sheet), располагающихся в 
редакторе CFC в две колонки по три листа (см. Рисунок 1-2). Лист состоит из 
центральной рабочей площади и панелей листа (sheet bar), содержащих 
ссылки листов и схем. На рабочей поверхности Вы можете размещать и 
соединять блоки или другие схемы.  

Страницы переполнения 
Если было создано так много соединений c другими листами, что они не 
уместились на панелях листа, то автоматически формируется страница 
переполнения. Страница переполнения является расширением 
интерфейсных панелей листа и не может содержать никаких других 
элементов. 

Вложенные схемы  
Схема CFC может быть вставлена в другую схему CFC (техника схема-в-
схеме). Это позволяет создать иерархичную структуру. Каждая вложенная 
схема может открываться, как и любая другая схема, редактироваться и 
индивидуально изменяться. 

Схема может быть “инкапсулирована" для дальнейшего использования; 
другими словами, имеет входы и выходы. Для каждой схемы, Вы можете 
решить, какие входы и выходы блоков доступны как входы и выходы схемы. 
Для более подробной информации о вложенных схемах, используйте 
руководство, Глава 3 или смотрите интерактивную справку. 
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Обзор схемы и просмотр листа 
В любой момент Вы можете выбирать между режимами обзора схемы и 
просмотра листа. 
Обзор оптимален для копирования и перемещения блоков и схем, а также 
для вставки больших блоков. Однако, так как некоторые детали не могут быть 
показаны только с подсказкой указателя мыши (tooltip), например, имена 
входов и выходов, для использования некоторых функций необходим режим 
просмотра листа.  
Вы можете использовать функции изменения размера изображения на экране 
с фиксированными шагами от минимального до максимального. 

Отображение схемы 
Вы можете настроить отображение различных элементов схемы. Для блоков, 
например, решите, показывать ли в заголовке блока имя типа или 
назначенный номер FB/FC, показывать ли для входов и выходов имя входа и 
тип данных или комментарии. Широкое (wide) представление блоков 
показывает входы-выходы и имена, а узкое (narrow) – только имена. 
Для более детальной информации смотрите интерактивную справку. 

Пример обзора схемы 
Рисунок 1-2 показывает пустую схему CFC (6 листов) в режиме обзора. 

 

Лист 1

Лист 2

Лист 3 Лист 6

Лист 5

Лист 4

Центральная рабочая область Панель листа 
 

Рисунок 1-2: Схема CFC в режиме обзора 
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Пример просмотра листа 

Рисунок 1-3 показывает просмотр листа схемы CFC с 4 соединенными 
блоками:

OB1002

PROC_S
stre_sim OB1001

BO INV_UP_

BO COM_RST
TI CYCLE
RE DISV

RE GAIN
RE LMNR_HLM_

TI TM_LAG1

BO EN

BO INV_DOWN_

RE LMNR_LLM_

TI TM_LAG2
TI TM_LAG3

TI MTR_TM

ENO BO
OUTV RE
LMNR RE

OLMNR_HS BO
QLMNR_LS BO

RE PV_FAC_
REPV_OFF
TI PULSE_TM_

TI MTR_TM
RE DISV

BOPVPER_ON

REDEADB W
TITI
RERAIN
W PV_PER
REPN_IN_
RESP_INT
TICYCLE

BOLMNDN

BOLMNR_ON
BOLMNUP

BOLMNR_HS
BOCOM_RTS
BOEN

BOLMNR_LS_

TI BRAK_TM

ENO BO
QLMNUP BO
OLMNDN BO

PV RE
ER RE

PID_S

DW_RW_DW

distur1

setpo1

manvar

Contr

 
Рисунок 1-3: Схема CFC в режиме просмотра листа 
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1.4 Блоки в CFC 

Функции в форме блоков 
В CFC Вы работаете с заранее подготовленными блоками, реализующими 
заданные функции. Вы помещаете эти функциональные блоки в схему, 
подключаете их и задаете параметры. 

Тип блока  
Определение типа для каждого функционального блока задает алгоритм, имя 
и интерфейс данных (входные и выходные параметры).  
Имя типа - это сокращение или акроним функции, например: 

- CTUD (COUNT UP и DOWN) для управляемой фронтами функции 
счета вверх и вниз. 

- COUNT_P, счетчик, который считает в прямом или обратном 
направлении (в зависимости от установок) при положительном 
фронте бинарного сигнала. 

- ADD_R, простая функция, которая складывает входные величины и 
выдает сумму на выход. 

Определение типа задает также типы данных входных и выходных 
параметров. При графическом представлении мы называем эти параметры 
входами и выходами блока.  
Тип данных входа и выхода определяет, какую величину он может принять, 
например,  
BOOL Булевский тип, может принимать только значения  0 или 1, 
STRING тип строки символов, может содержать в качестве значения строку 
символов.    
Другие типы данных описаны в Приложении, Таблица A-2.  

Экземпляр блока  
Как только Вы помещаете блок в Вашу схему CFC, Вы создаете экземпляр 
для этого типа блока. Экземпляр в этом значении – каждое использование 
выбранного типа блока.  

Вы можете создать любое количество экземпляров блока одного типа. Вы 
можете назначать имена этим экземплярам, подключать их и назначать им 
параметры без изменения функциональных спецификаций данного типа 
блока. 
Преимущества концепции экземпляра, в частности, в том, что последующие 
изменения в типе блока будут автоматически выполнены во всех 
соответствующих экземплярах блоков. 
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Комплексные блоки (мультиэкземплярные блоки) 
Функции могут быть использованы совместно, с использованием различных 
подфункций. Эти подфункции сами являются блоками и вместе вложены в 
комплексный блок. Управляющий блок может, например, содержать блок 
сообщений и блок управления работой (мультиэкземплярный блок).  
Используя CFC, Вы можете создать эти блоки путем соединения различных 
блоков (функций) и назначив соответствующие параметры в схеме. Затем Вы 
компилируете схему как тип блока (см. Раздел 3.11.2). 

Блоки с переменным числом входов  
В CFC есть блоки, в которых количество входов переменно и может быть 
изменено в схеме CFC (порождающий блок). Переменное число входов 
имеет, например, блок AND. 

Семейства блоков  
Блоки группируются согласно их функциональным свойствам, образуя 
семейства блоков. Когда создается семейство, каждый блок получает 
идентификатор семейства. Следующие блоки, например, собраны в 
семейства:  

- блоки преобразования для согласования различных типов данных  
CONVERT  (BO_BY, BY_DW, W_DW, ... т.д.) 

- мультиплексные блоки  
MULTIPLX (MUX8_R, MUXn_DI, ... т.д.) 

- блоки с математическими функциями (плавающая точка) 
MATH_FP (SQRT, ADD_R, ... т.д.) 

Имена семейств блоков используются, кроме прочего, для сортировки блоков 
в каталоге CFC.  

Организационные блоки   
Интерфейс между операционной системой CPU и пользовательской 
программой  - это задачи, называемые в S7 организационными блоками (OB). 
Использование OB обеспечивает выполнение специфических частей 
программы в определенное время и в определенных ситуациях. OB для CPU 
выполняют запуск (холодная, горячая перезагрузка), используются для 
аппаратных и циклических прерываний (с разными временными базами) и т.д. 
Организационные блоки или задачи не являются блоками в наглядном 
представлении CFC; они не могут быть ни вставленными, ни 
отредактированы в CFC. После вызова редактора последовательности 
выполнения, блоки, помещенные в схему CFC, отображаются в OB в порядке 
их обработки. 



Суть CFC 

 CFC для S7 
1-8 A5E00345244-01 

Дальнейшие особенности  
Блоки различаются также по типу. При создании блоков необходимо 
объявить их как функциональный блок (FB), функцию (FC) или базовый 
оператор (BOP). 

• FB - блок с памятью, другими словами, данные блока существуют и 
являются доступными при обработке от цикла к циклу. Для того, чтобы 
сделать данные доступными, для каждого экземпляра блока создается 
блок данных (DB). В комплексных блоках, возможно использование 
дополнительных вложенных FB, для которых создается только один 
общий DB. 

• FC  - это блок без памяти; другими словами, величины, генерируемые 
блоком, обрабатываются немедленно. Здесь не требуется блок данных.  
FC не имеет назначенных по умолчанию величин на выходах. 

• BOP также блок без памяти (подобно FC). Базовые операторы - это 
программные компоненты в CFC, которые вводятся в процессе 
компиляции в текст SCL как операторы и используются для простых 
функций, таких как AND, OR и т.д.  

Особый случай: перекрывающиеся блоки  
Перекрывающиеся блоки возникают при вставке или перемещении схем при 
недостатке свободной площади не листе. В этом случае, они перекрываются 
другими объектами полностью или частично.  
Перекрывающиеся блоки выделены светло серым, у них не отображаются 
входы и выходы до тех пор, пока они не будут перемещены на листе в 
свободную позицию. Существующие соединения и связи с панелью листа 
перекрывающихся блоков также невидимы, но, не смотря на это, существуют. 
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1.5 Каталог  

Каталог блоков, схем и библиотек  
Блоки и схемы, которые Вы хотите вставить в схему CFC (используя 
перетаскивание), можно взять из каталога. 
Каталог имеет окно, в котором перечислены существующие семейства 
блоков, библиотеки и т.д. (в древовидной структуре). Диапазон отображения 
зависит от PLC и установленных библиотек. 
Вы можете переключаться от окна к окну, используя иконки в нижней части 
окна: 

 
Блоки: Здесь Вы найдете существующие (импортированные) блоки и BOP, 
расположенные в алфавитном порядке в разделе “All Blocks” ("Все блоки") 
и согласно семействам и блокам текущей программы S7, которые Вы 
можете вставить в схему.  
Из этого окна Вы также можете вставить в текущую схему текстовый блок 
(new text) и вложенную схему (new chart). 

 
Библиотеки: Здесь Вы найдете библиотеки блоков, из которых Вы можете 
вставить новые блоки в схему. Отображаются библиотеки, известные в 
SIMATIC Manager.  
Блоки отсортированы в алфавитном порядке в разделе "All Blocks [Все 
блоки]" и в соответствии с семейством. 
Из этого окна Вы также можете вставить в текущую схему текстовый блок 
(new text) и вложенную схему (new chart). 

 
Схемы: Здесь, Вы найдете схемы CFC текущей программы S7, которые Вы 
можете вставить (скопировать) или открыть  

 
Неразмещенные блоки: Здесь Вы найдете блоки текущей программы, 
которые более не используются в схеме CFC. Схема CFC,  с которой 
связаны эти блоки, также показана здесь. Каталог показан только тогда, 
когда неразмещенные блоки существуют. 

 В нижней части каталога Вы можете найти следующие кнопки: 

 
Найти блок или схему: Вы можете определить имя схемы или блока в 
окне и найти их с помощью кнопки “Find" («Найти»). Папка (например, для 
семейства блока), в которой находится этот объект, будет открыта. Вам 
только необходимо задать первые несколько букв. Поиск остановится, 
когда искомый объект будет найден. В течение поиска отображается 
диалоговое окно с меню поиска. Здесь Вы также можете остановить поиск, 
если он слишком затянулся.  

 
Закрыть папки: Ниже кнопки “Find" («Найти») есть кнопка “Close" 
(Закрыть). С помощью этой кнопки можно закрыть все открытые папки в 
каталоге. 
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1.6 Управление и мониторинг оператором 

В процессе работы на AS генерируются сообщения, которые необходимо 
передать системе управления и мониторинга оператором (PCS 7).  
Используя конфигурирование сообщений в CFC, Вы можете непосредственно 
в блоке создать сообщения о событиях, их текст и атрибуты. 
Пока конфигурируется AS, Вы создаете данные, которые требуются OS для 
коммуникации между AS и OS; другими словами, для управления и 
мониторинга оператором. Вы можете передавать эти данные к OS в SIMATIC 
Manager, используя функцию "Compile OS" (Компиляция OS)  . 

Блоки сообщений  
Когда Вы вставляете блок, поддерживающий сообщения, в схему CFC, 
сообщения создаются автоматически. Этот блок имеет структуру сообщения 
с назанченными по умолчанию атрибутами и текстами сообщений; другими 
словами, PLC посылает сообщение, когда происходит соответствующее 
событие без любой дополнительной конфигурации пользователем. Сигналы, 
формирующие сообщения, могут также иметь связанные величины, что 
позволяет вводить в текстовые сообщения переменные величины. 
Вы можете редактировать атрибуты (такие, как класс или тип сообщения) и 
тексты сообщения для отдельных экземпляров блоков с возможностями 
конфигурации сообщений (Special Properties: “Messages" (Специальные 
Свойства: “Сообщения")). Если кнопка ”Messages” («Сообщения») не 
активирована, блок не способен посылать сообщения. 

Блоки,  управляемые  оператором  
Для блоков с входами, которые допускают операторский ввод можно 
выбирать и редактировать тексты. Вы можете запустить диалог с помощью 
кнопки “Operator control and monitoring" (“Управление и мониторинг 
оператором") в свойствах блока (Object Properties). Вы можете изменить эти 
свойства позднее для экземпляров блока, предназначенного для 
операторского управления и мониторинга. Чтобы сделать это, выберите или 
отмените опцию “OCM possible" (“Возможность управления и мониторинга 
оператором") в свойствах объекта блока. 

Соединение AS-OS  
Когда Вы закончили конфигурацию сообщений, данные, требуемые OS для 
соединения между AS и OS, передаются на OS (компиляция OS). В 
зависимости от выбора, эти данные передаются к одной или более целевым 
станциям и используются на этих станциях графическими объектами или 
панелями управления. Для этой передачи должен быть установлен 
программный пакет “AS-OS Engineering". 
Для более подробной информации о передаче данных смотрите 
интерактивную справку по “AS-OS Engineering".. 
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1.7 Шаги конфигурации 

Порядок шагов  
1. Создайте структуру проекта  

2. Создайте блоки и импортируйте их в CFC (необязательно) 

3. Вставьте блоки в схему  

4. Установите параметры для блоков и соедините их  

5. Настройте свойства выполнения во времени  

6. Откомпилируйте схемы CFC  

7. Загрузите программу CFC  

8. Протестируйте программу CFC  

Создание структуры проекта  
Для работы с CFC Вы должны, используя SIMATIC Manager, в программе 
(папка для системной программы) создать папку схем. 
Вы создаете отдельные схемы CFC в папке схем или используя SIMATIC 
Manager, или непосредственно в редакторе CFC. 
Когда Вы создаете структуру проекта, Вас поддерживает помощник “New 
Project" («Новый проект») (в зависимости от установок или для STEP 7, или 
для PCS 7). Помощник PCS 7 создает мультипроект (с мастер-библиотекой) 
или простой проект в обзоре компонент (component view) и технологическом 
представлении (plant view). По умолчанию, помощник PCS 7 также создает и 
схему CFC. 

Создание блоков (необязательно)  
CFC работает с готовыми блоками. Это могут быть блоки из библиотек, 
других программ или типы, которые Вы создали сами. Вы найдете 
информацию о создании блоков в Разделе 3.11.2, "Компиляция в качестве 
типа блока ", и в руководстве "PCS 7 Programming Instructions Blocks" 
(«Программирование алгоритмических блоков PCS 7»). 

Импорт блоков  
Способ, которым подключаются типы блоков и, в некоторых случаях, 
импортируются, зависит от PLC.  
Для более подробной информации смотрите Раздел 3.3.1. 

Вставка блоков в схему  
Блоки вставляются в схему перетаскиванием их из каталога. Это дает 
экземпляр блока с именем, которое в пределах схемы уникально. Вы можете 
создать любое количество экземпляров блока каждого типа. 
Для более подробной информации смотрите Раздел 3.3.4. 
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Установка параметров и соединение блоков 
Вы можете назначить параметры входам и выходам блоков или Вы можете 
соединить их или с другими блоками, или с глобальными адресами. 
(Глобальные адреса – это соединение партнеров вне схемы CFC, например, 
в S7: периферийные сигналы входов и выходов, меркеры, таймеры, счетчики 
и глобальные блоки данных.)  
Вы можете определить текстовые соединения на входе блока или схемы, 
целевое назначение которого еще не находится в папке схем. Это 
соединение остается открытым пока существует ссылка на партнера по 
соединению, затем соединение может быть замкнуто с использованием 
команды меню. 
Соединение означает, что величины передаются от одного выхода к одному 
или нескольким входам в течение коммуникации между блоками или другими 
объектами.  
Для более подробной информации смотрите Раздел 3.5. 

Настройка свойств времени выполнения  
Свойства выполнения блока во времени определяют, как блок будет включен 
в последовательность выполнения целевой системы в целом. Эти свойства 
обязательны для поведения целевой системы в смысле времени реакции, 
времени запаздывания или устойчивости структур, зависимых от времени, 
например, систем с обратной связью. 
Когда вставляется блок, каждому блоку назначаются свойства выполнения по 
умолчанию. Блок устанавливается в определенную Вами позицию задания. 
При необходимости Вы можете позже изменить установленную позицию и 
другие атрибуты. 
Для более подробной информации смотрите Раздел 3.8 

Компиляция схемы CFC  
В процессе компиляции в качестве программы, все схемы активного CPU 
конвертируются в машинный код. В зависимости от целевой системы 
используются разные компиляторы; но их вызов, однако, идентичен. Если Вы 
компилируете в качестве типа блока, компилируется только отдельная схема. 
Для более подробной информации смотрите Раздел 3.11. 

Загрузка программы CFC  
После компиляции Вы можете загрузить программу CFC в CPU.  
Изменения в программе могут также загружаться в интерактивном режиме 
без остановки CPU. 
Для более подробной информации смотрите Раздел 3.12. 

Тестирование программы CFC 
После компиляции и загрузки программы Вы можете протестировать ее. 
Состав и тип функций тестирования отличается в зависимости от целевой 
системы. В режиме тестирования Вы интерактивно подключаетесь к PLC.  
Для более подробной информации смотрите Раздел 4.3. 
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2 Первые шаги  

Введение  
Эта глава “Первые шаги" построена как пример для новичков в CFC, которые 
хотят быстро получить знания о пакете. Пример разделен на разные задачи и 
описан шаг за шагом от простейшего проекта до создания схемы со входами 
и выходами и блоков в CFC.  

 
 Замечание: 

Вы найдете готовый пример в SIMATIC Manager: 
File > Open... > “Sample projects" раздел > ZDt04_01_CFC (Немецкий). 
(Английский: ZEn..., Французский: ZFr..., Испанский: ZEs..., Итальянский: 
ZIt...) 

 
В этом примере предполагается, что CFC будет использоваться в среде 
STEP 7. Это значит, что установлен стандартный пакет STEP 7, SCL и CFC. В 
качестве PLC используется или S7-300, или S7-400. 
Вы можете создать простой проект “CFCEXA_2", описанный ниже, с помощью 
SIMATIC Manager.   
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2.1 Создание управления с обратной связью с 
использованием имитации процесса  

2.1.1 Создание проекта  

В этом разделе описаны шаги, включая создание проекта с помощью команд 
меню SIMATIC Manager. Вы конфигурируете аппаратное обеспечение в HW 
Config (это можно сделать позднее, но обязательно перед загрузкой в CPU). 
Этот пример создан в программе S7: 

1. В панели инструментов нажмите  или выберите команду меню File > 
New... (Файл>Новый).  
В диалоговом окне “New Project" («Новый проект») введите имя проекта  
“CFCEXA_2" и нажмите “OK". 

2. С выделенной папкой проекта, подайте команду меню Insert > Program > 
S7 Program (Вставка > Программа > Программа S7). 
В "Component View"  ("Обзоре компонент") создается программа S7 с 
папкой исходных файлов, папкой блоков и таблицей символов. 

3. С выделенной папкой программы S7, подайте команду меню Insert > S7 
Software > Chart Folder (Вставка > Программа S7 > Папка схем).  
Создается папка схем. 

4. С выбранной папкой, подайте команду меню Insert > S7 Software > CFC 
(Вставка> Программа S7 > CFC).  
Создается схема "CFC(1)"; дайте ей имя "Control". 

5. Дважды щелкните на схеме CFC для того, чтобы открыть ее. 
Все требующееся для работы с редактором CFC выполнено. 
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2.1.2 Создание схемы  

Цель  
Сейчас Вы создадите схему управления с имитатором, в котором процесс 
имитируется скользящей средней величиной. Вы используете для этого два 
блока: SAMP_AVE и CONT_C. Блок SAMP_AVE формирует среднюю 
величину из некоторого числа входных величин, а CONT_C  - это контроллер 
PID, который управляет этой переменной средней величиной. 

SAMP_AVE 
Sliding averag 

Process 

R  IN 
I   N 

   OUT   R 
30 

OB35 
2/- 

OB35
1/-

CONT_C
Continuous PID

Contr

R   SP_INT

R   PV_IN

R   MAN

R   GAIN

TI   TN
TI   TV

  LMN   R

0.0

20.0

20s

10s

2.0

0

Среднее значение формируется из 30 
последних  значений заданных на выходе 
LMN блока Contr  и передается с выхода 
OUT блока Process на вход PV_IN блока 
Contr 

Блок Process имитирует процесс 

Блок Сontr управляет переменной

BO_MAN_ON

R   DEADB_W

LMN передает 
управляющую величину 
на вход  IN блока Process

 

Вставка блоков  

1. Откройте каталог  , если он еще не открыт (по умолчанию).  

2. В каталоге нажмите кнопку библиотеки  . Здесь Вы можете открыть 
Библиотеку CFC. Это коллекция библиотек блоков.  

3. Теперь откройте папку ELEM_300. Это библиотека с блоками, 
пригодными для CPU типов S7-3xx. Если Вы используете CPU S7-4xx, 
откройте папку ELEM_400. 
Вы можете перетащить в схему блоки из открывшегося списка.  
В папке блоки хранятся отсортированными  по семействам блоков  или 
все вместе в алфавитном порядке в разделе "All Blocks" («Все блоки») . 

4. Нажмите на символ + перед папкой "All Blocks", чтобы раскрыть ее. 

5. Нажмите CONT_C, удерживая кнопку мыши, перетащите блок в схему. 
Расположите его в верхнем правом углу на листе 1.  

6. Затем возьмите блок SAMP_AVE и расположите его слева от блока 
CONT_C. 
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7. Дважды щелкните по свободной позиции для того, чтобы переключиться к 

просмотру листа (или нажмите в панели инструментов ). 

В режиме просмотра листа Вы видите блоки, как графические объекты с 
заголовком, и несколькими входами и выходами в теле блока. Входы и 
выходы (входы слева, выходы справа) показаны как поля с именем и 
типом данных, последний виден для "wide" ("широкого") отображения. С 
помощью Options > Customize > Block/Sheet Bar Width...... (Опции > 
Настройки > Ширина блока и панели листа…), Вы можете установить 
ширину блока "Narrow" ("Узкий") или "Wide" ("Широкий"). Если установлен 
"Узкий" (по умолчанию), блоки будут показаны узкими и без типа данных. 

Совет: Вы можете отобразить полную информацию о входах и выходах 
как всплывающую подсказку (tooltip), наведя курсор мыши на вход или 
выход. 

Соединение блоков  
Для соединения блоков выполните следующее:  

1. Щелкните на выходе OUT блока SAMP_AVE и затем щелкните на входе 
PV_IN блока CONT_C.  

2. На блоке CONT_C щелкните на выходе LMN, а затем щелкните на входе 
IN блока SAMP_AVE.  

Вы можете выполнить соединение и другим способом. Сначала щелкните 
на входе, а затем на выходе. Как вариант, Вы можете, используя мышь, 
перетащить выход блока на вход того блока, с которым хотите установить 
соединение. 

Теперь два блока соединены. 

Изменения видимости блоков 
Блоки показаны в схеме со всеми входами и выходами так, как предписано 
типом блока. В нашем примере, однако, нам не требуются все входы и 
выходы и для того, чтобы сделать экран проще и чище, мы можем сделать 
невидимыми некоторые ненужные входы и выходы. В том же диалоге мы 
можем поменять имя блока. 

1. Дважды нажмите на заголовок блока CONT_C: откроется диалоговое окно 
"Properties" ("Свойства") для этого блока. Имя ("1") уже выбрано, и Вы 
можете сразу же напечатать новое имя "Contr".  

2. Теперь выберите страницу "Inputs/Outputs" («Входы/выходы»). Используя 
горизонтальную линейку прокрутки, перемещайтесь вправо до появления 
колонки "Not displayed" («Не показывать»). 

3. Нажмите первую выбранную ячейку, удерживайте кнопку мыши и тащите 
курсор вертикально до конца колонки: выбрана вся колонка. При 
положении курсора в выбранной области нажмите правую кнопку мыши и 
выберите команду меню "Set" («Установить»).  
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4. Некоторые входы и выходы, которые в настоящий момент невидимы, 
могут, однако, понадобиться позднее при тестировании. Мы сделаем их 
видимыми. 

MAN_ON 
SP_INT 
PV_IN 
MAN 
GAIN 
TN 
TV 
DEADB_W 
LMN. 

Установка параметров входов и выходов и выбор их для тестирования  
1. В таблице "Inputs/Outputs" («Входы/Выходы»), выберите колонку 

"Watched" («Наблюдаемый») и установите наблюдаемыми все видимые 
входы и выходы. 

2. В колонке "Value" (Величина), введите "20" для SP_INT 
(по умолчанию для блока управления).  
Закройте Свойства объекта, нажав "OK". 

Также Вы можете непосредственно установить параметры для отдельных 
входов и выходов: 

1. Дважды нажмите на вход MAN_ON блока управления. 

2. В окне "Value" («Величина») измените "1" на "0".  
Это запрещает "Manual Mode" («Ручной режим»), который размыкает 
обратную связь. 

3. Закройте диалоговое окно, нажав "OK". 
Выполните то же с блоком SAMP_AVE (используйте диалог свойств для 
отдельных входов и выходов или диалог свойств блока, как описано ниже).  

1. Дважды нажмите на заголовок блока SAMP_AVE. Дайте этому блоку имя 
“Process".  

2. В таблице "Inputs/Outputs" («Входы/Выходы») установите для входа N в 
свойство "Watched" («Наблюдаемый») (если он еще не установлен). 

3. В колонке "Value" («Величина») введите для N значение "30".  
(это число величин входов используется для средней величины.)  

4. Закройте диалоговое окно, нажав "OK". 
Сейчас блоки соединены и имеют необходимые параметры для имитации 
процесса. 
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2.1.3 Компиляция и загрузка схемы  

Следующие шаги компилируют схему как программу.  

1. Выберите на панели CFC  кнопку   или команду Chart > Compile > 
Charts as Program.... (Схемы > Компилировать > Схемы как 
программа...). 
В появившемся диалоговом окне установите "Compile: Entire program" 
(«Компилировать: Программа в целом»). Завершите диалог, нажав "OK". 
Начнется компиляция, ее процесс отобразится в диалоговом окне. 
Согласитесь с итоговым сообщением S7 с помощью "Close" (Вы можете 
игнорировать предупреждения).  

Замечание:  
Следующие шаги возможны, только если Вы сконфигурировали и 
подключили CPU типа S7-3xx или S7-4xx к Вашему PC (или имитатор S7-
PLCSIM). Переключатель CPU должен быть в режиме: RUN-P. 

Для загрузки программы в CPU, выберите кнопку   
или PLC > Download...( PLC > Загрузить...).  
В диалоговом окне выберите тип загрузки (всегда установлен: "Entire 
program" («Программа в целом»)).  

Перед загрузкой программы CPU устанавливается в режим STOP (после 
запроса и ответа "Yes") и любые блоки в памяти CPU удаляются. Загрузка 
отображается в диалоговом окне. После удачной загрузки программы (без 
ошибок), появится сообщение, что загрузка выполнена, и запрос, хотите ли 
Вы перезапустить CPU. Если Вы ответите "Yes", Вы вернете CPU в режим 
"RUN". 

CPU перешол в режим RUN. Программа загружена, теперь ее необходимо 
тестировать. 
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2.2 Тестирование программы  

В режиме тестирования Вы можете наблюдать входы и выходы блока и 
изменять входные величины блока. Величины, зарегистрированные для 
тестирования, показаны на желтом фоне. 

Если Вы изменили некоторые из параметров, то можете наблюдать 
поведение блока управления, например, как управляемая величина достигает 
заданное значение. 

Изменение режима тестирования  
Прежде чем переключиться в тестовый режим, измените режим из "Process 
Mode" («Рабочий режим») в "Laboratory Mode"(«Лабораторный режим») ("Test 
> Laboratory Mode"). Это значит, что все входы и выходы блока автоматически 
активируются для "Watching" («Наблюдения»).  
Замечание: В "Process Mode" («Рабочий режим»), по умолчанию входы и 
выходы не установлены для наблюдения. В этом режиме для тестирования 
Вы можете выбрать нужные блоки и зарегистрировать их для просмотра 

(нажав ).  

Активирование режима тестирования: 

• Нажмите  или выберите Debug > Test Mode (Отладка > Тестовый 
режим).. 

Изменение величин в интерактивном режиме  
Вы можете, например, задать различные установочные значения, таким 
образом: 

1. На контроллере, дважды щелкните на входе SP_INT и установите в 
диалоговом окне другую величину (< 100), как внутреннюю заданную 
точку. 

2. Для подтверждения величины нажмите "Apply" (Применить), диалоговое 
окно останется открытым для других изменений.  

После того, как Вы сделаете несколько изменений и проверите реакцию на 
них, нажмите "OK".  
Вы можете, например, влиять на скорость установки через входы блока:  

GAIN (коэффициент пропорционального управления) 

TN (время сброса, определяет интегральный компонент) 

TV (время, определяющее дифференциальный компонент) 
Если Вы изменили “GAIN" на более низкую величину и  увеличили время 
“TN", динамический отклик контроллера изменится и отклик будет более 
“вялым".  
С помощью входа блока MAN_ON, Вы можете разорвать контур управления и 
включить "Manual Mode" («Ручное управление») (=1). Управляющая величина 
(величина на выходе LMN) установится в значение, заданное на входе MAN. 
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Результат 
В этой части примера Вы получили знания об элементарных аспектах 
конфигурации CFC. Вы можете создать проект с помощью SIMATIC Manager, 
создать схему CFC и вставить блоки из библиотеки. Вы соединяете блоки и 
устанавливаете параметры. Вы можете создавать работающую программу и 
загружать ее в CPU. В режиме тестирования, Вы управляете динамическим 
откликом схемы управления с обратной связью.  
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2.3 Изменения в схеме  

Мы сейчас находимся в режиме тестирования. 

• Выберите режим редактирования, отжав кнопку .  

2.3.1 Изменение свойств времени исполнения  

Введение  
Блоки схемы имеют свойства выполнения во времени в определенной 
последовательности. Эти свойства исполнения во времени определяют, 
когда и в каком порядке блоки выполняются в CPU. Чтобы организовать 
последовательность выполнения, блоки включаются в OB.  
В данном примере, блоки по умолчанию устанавливаются в OB35 (цикличес-
кое прерывание с интервалом 100 мс) и, поскольку они также включены в 
задачу перезапуска, они устанавливаются в OB100 (теплый перезапуск). 
Таким образом, Вам не нужно беспокоится о включении в рабочую последо-
вательность каждого блока, CFC установит блоки один за другим после 
одного, особенного блока. Этот блок определен для блоков, 
устанавливаемых позднее, как "Predecessor for Installation" ("Предшественник 
для установки"). Это свойство автоматически передается последнему 
установленному блоку. В строке состояния CFC (справа внизу окна) и по 
светло-зеленому цвету бокса для свойств выполнения во времени на 
изображении блока в схеме Вы можете увидеть, какой блок является 
"Предшественником для установки". 
Когда Вы создаете схему CFC, рабочая группа создается автоматически и 
имеет такое же название, как и схема. 
Вы можете назначать рабочей группе атрибуты, которые задают отношение 
циклов выполнения и смещение по фазе относительно циклов OB, в которых 
выполняются блоки. 

Изменение свойств выполнения  
Вы хотите, чтобы блоки выполнялись в другой последовательности. Режим 
тестирования деактивирован, и Вы вызываете редактор последовательности 
выполнения. 

1. Нажмите кнопку на панели инструментов   или выберите Edit > Run 
Sequence...( Редактор > Последовательность выполнения..). 

Открывшееся окно покажет все OB. Объекты уже установлены в OB100 и 
OB35, как можно видеть, по символу + перед иконкой OB.  

2. Выберите OB35 и рабочую группу "Ctrl", содержащуюся в нем. Блоки 
отображаются справа в окне детального представления.  

Помните: Рабочая группа создается автоматически при создании схемы. 

3. Держите курсор на рабочей группе и выберите команду меню Object 
Properties...(Свойства объекта) с помощью правой кнопки мыши. 
Появится диалоговое окно. 
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4. В диалоговом окне выполните следующие установки: 
 
Name (Имя): Ctrl  (по умолчанию сохраняется)  
Comment (Комментарий) U8_PV0  
Scan rate (Отношение циклов) 8  
Phase offset (Смещение по фазе) 0  (по умолчанию сохраняется) 
Optimizing the Run Sequence 
(Оптимизация  последова-
тельности выполнения) 

√ (по умолчанию сохраняется)  

Active (Активный) √ (по умолчанию сохраняется)  

5. Подтвердите установки "OK". 
С теми установками, которые Вы сделали для отношения циклов, блоки будут 
выполняться каждый восьмой цикл; другими словами, при базовом времени 
цикла OB35, равном 100 мс, они будут выполняться каждые 800 мс.  
Смещение по фазе может использоваться для достижения лучшего 
распределения загрузки CPU, когда у Вас имеются блоки в нескольких 
рабочих группах. Это не соответствует нашему примеру, значение по 
умолчанию "0", другими словами, смещения периода нет.  
Опция "Optimize Run Sequence" (Оптимизация последовательности 
выполнения) определяет, включена или нет рабочая группа в процесс 
оптимизации, что должно быть указано явно (см. Раздел 3.8.4). Посредством 
опции "active" ("активировать"), рабочая группа активируется или 
деактивируется для работы на CPU.  

Копирование блоков внутри схемы  
В качестве практического примера Вы скопируете содержимое листа 1 в лист 
2 и продолжите редактирование там. Когда Вы копируете соединенные блоки, 
соединение сохраняется. 

1. Переключитесь с редактирования последовательности выполнения на 
редактирование схемы.  
Чтобы сделать это, щелкните в любой точке окна схемы 

(CFCEXA_2\S7 Program(1)\...\\Control) или снова нажмите  и измените 

обзор нажатием . 

2. На листе 1, удерживая нажатой левую кнопку мыши, нарисуйте петлю 
вокруг соединенных блоков. Блоки будут выделены (синим).  

3. Сохраняя курсор мыши на выделении, удерживайте нажатой клавишу Ctrl 
и перетащите блоки на лист 2 (ниже листа 1).  

4. Выберите блок "Contr1", скопируйте его и вставьте снова на тот же лист. 
Блок называется "Contr2".  
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Изменение соединений 
 

1. Нажмите на линию соединения или на выход LMN в "Contr1" и нажмите 
клавишу "Del". Соединение с входом IN  "Process1" будет удалено. 

2. Нажмите на LMN в "Contr1" и затем на SP_INT в "Contr2".  
 
(Позже, Вы узнаете более элегантный метод "перемонтажа" без удаления 
и соединения заново).  

3. Нажмите на LMN в "Contr2" и затем на IN в "Process1". 

4. Нажмите на OUT в "Process1" и затем на PV_IN в "Contr2". 
При размещении блоков, как показано ниже, соединение отобразится 
следующим образом: 

Ветвление

OB 35 
1/3

CONT_C
Continuous PID

Contr1

  
LMN  R 

0.0

20.0

20s

10s

2.0

0

R  SP_INT

R  PV_IN

R  MAN

R  GAIN

TI TN

TI TV

BO MAN_ON

R  DEADB_W0.0

SAMP_AVE 
Sliding averag 

Process

R  IN 
I  N 

   OUT  R

OB 35
1/4 

30 

OB 35 
1/5

CONT_C
Continuous PID

Contr2

  LMN  R 

0.0

20s

10s

2.0

0

0.0

R  SP_INT

R  PV_IN

R  MAN

R  GAIN

TI TN

TI TV

BO MAN_ON

R  DEADB_W

 

 



Первые шаги 

 CFC для S7 
2-12 A5E00345244-01 

Компиляция, загрузка и тестирование изменений  
Схема должна быть скомпилирована снова и затем загружена в CPU. 

1. Выберите кнопку  на панели инструментов.   
В диалоговом окне установите опцию "Compile: Changes only" 
(«Компиляция: только изменения») и нажмите "OK". Начинается 
компиляция, согласитесь с сообщением, нажав  "Close".  

2. Для загрузки программы выберите кнопку . 
В диалоговом окне установите "Download: Changes only" («Загрузка: 
только изменения») и нажмите "OK".  

Когда Вы загружаете изменения (как альтернатива вводу программы в 
целом), не требуется переводить CPU в режим STOP.  
Внимание! Если Вы работаете с реальным проектом, убедитесь, что Вы в 
курсе информации "Reasons for STOP when Downloading Changes Online" 
("Причины для STOP при интерактивной загрузке изменений") в 
интерактивной справке. 

(Help > Contents, страница "Index": Напечатайте "Reasons for"  и нажмите 
кнопку "Display".) 

После загрузки Вы можете вернуться в режим тестирования и протестировать 
измененную программу. 

Результат  
В этой части Вы узнали, что блоки в схеме CFC имеют определенные 
свойства выполнения на CPU и Вы можете изменять эти свойства. Также Вы 
увидели, что подструктура, называемая рабочей группой, используется в 
последовательности выполнения, ее атрибуты Вы можете назначать сами. 
Вы можете копировать блоки внутри схемы и видите, что соединение между 
блоками сохраняется. Вы изменяли соединения и снова создавали 
работающую программу. Вы увидели различия между загрузкой программы в 
целом и загрузкой только изменений. 
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2.4 Создание входов и выходов схемы и схема-в-схеме  

В следующем разделе Вы будете создавать входы и выходы схемы CFC и 
вставлять эту схему в другие схемы CFC. 

2.4.1 Создание схемы с входами и выходами  

Схема с входами и выходами может быть использована для "модульных" 
схем CFC для дальнейшего использования. Когда Вы создаете схему с 
входами и выходами, Вы можете определить, какие входы и выходы блока 
следует соединить с другими схемами или блоками и должны быть 
добавлены к входам и выходам схемы.  

Подготовка  

1. Создайте новую схему, нажав на панели инструментов . В 
диалоговом окне введите имя объекта: "Sim_reg" и нажмите "OK". 
Появится новая схема.  

2. При нажатии на панели инструментов , схема "Sim_reg" и схема 
"Control" появятся одна за другой. 

3. Установите режим обзора для обеих схем, нажав .  

4. Скопируйте блоки листа 1 схемы "Control" в лист 1 схемы "Sim_reg" таким 
же образом, как Вы делали это при копировании блоков внутри схемы. 

5. Закройте схему "Control" и переключитесь к просмотру листа (лист 1) 
схемы "Sim_reg". 

6. Откройте в каталоге раздел блоков, нажав кнопку  и затем 
семейство блоков MULTIPLX. 

7. Протащите блок SEL_R на лист 1 и дайте ему имя "Switch" (в диалоге 
свойств). 

Для того, чтобы включить блок "Switch" в наш пример, Вы должны 
"перемонтировать" существующее соединение; другими словами, Вы 
изменяете соединение не удаляя существующее.  

8. На блоке "Contr", выберите вход PV_IN и, удерживая кнопку мыши, 
перетащите его к входу IN1 в "Switch". Выход OUT блока "Process" теперь 
соединен с входом IN1 блока "Switch". 

Как вариант, Вы можете удалить существующее соединение и создать новое.  
Выход "Switch" теперь должен быть соединен с входом для переменной 
процесса "Contr". 

9. Соедините выход OUT блока "Switch" с входом PV_IN блока "Contr".  
Теперь "Switch", в зависимости от величины на входе K, переключает 
величины с входов IN0 (K=1) или IN1 (K=0) на выход OUT. 
В реальном проекте, это позволяет Вам переключаться между симулятором 
процесса (IN1) и реальным процессом (величина с входа, соединенного с 
IN0). 
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Создание входов и выходов схемы  
Сейчас Вы создадите входы и выходы для схемы. Затем они соединяются с 
выбранными входами и выходами блоков. 

1. Нажмите кнопку  на панели инструментов или выберите View > Chart 
I/O (Обзор> Входы и выходы схемы).  
Откроется диалог для редактирования входов и выходов схемы и 
"прикрепится" к открытой части окна схемы. 

2. В левой части окна нажмите иконку группы входов IN. Входы блока 
показаны в правой части окна (сейчас пустая).  

3. В рабочей области схемы выберите на блоке "Contr" вход MAN_ON и 
перетащите вход в правое окно входов и выходов схемы на бокс "Name". 
Возникает вход со всеми его свойствами. Проделайте эту процедуру со 
всеми не соединенными входами (см. таблицу). 

4. Измените имя входа K блока "Switch" в входах и выходах схемы двойным 
нажатием в окне "Name". Введите здесь SIM. Вместо IN0, введите PV 
(величина процесса).  

5. В левом окне входов и выходов схемы  нажмите иконку группы выходов 
OUT. Выберите выход LMN на "Contr", удерживая клавишу Ctrl, 
перетащите выход в правую часть окна входов и выходов схемы на бокс 
"Name".  

Должны появится следующие входы и выходы схемы: 
Блок Вход блока Тип данных Выход блока Тип 

данных 

Contr MAN_ON BOOL LMN REAL 
 SP_INT REAL   
 MAN REAL   
 GAIN REAL   
 TN TIME   
 TV TIME   
 DEADB_W REAL   
Switch SIM (прежде: K) BOOL   
 PV (прежде: IN0) REAL   

Панель листа покажет имена входов и выходов и комментарии, тип входов и 
выходов и тип данных, применяющихся к входам и выходам схемы.  
Сейчас Вы создали все входы и выходы для схемы.   

6. Теперь Вы можете закрыть окно входов и выходов схемы, нажав  и 
можете "прибрать" схему, сделав ее более читаемой.  
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7. Поместите блок в схему так, чтобы линии соединения пересекались как 
можно меньше. Одно из возможных расположений показано ниже. 

Contr

Switch

Process
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2.4.2 Вставка схемы в другую схему  

Схема "Sim_reg", созданная в предыдущей конфигурации со входами и 
выходами, вставляется в другую схему. Создайте новую схему:  

1. Нажмите кнопку  на панели инструментов. В диалоговом окне 
введите в Object name (Имя объекта): "Top Chart" и нажмите "OK". Будет 
показана новая схема. 

2. Откройте каталог "Charts" ("Схемы"), нажав кнопку . 
В иерархии Вы увидите схемы "Top Chart", "Control" и "Sim_reg". 
Замечание: Если каталог содержит только сообщение "! "! (no hierarchy 
folder exists)" (иерархии не существует)", установите опцию "Display 
catalog with plant hierarchy" («Показать каталог с технологической 
иерархией») в диалоговом окне Options > Customize > Display... (Опции 
> Настройка > Показать...). Поскольку проект был создан без иерархии, 
эта опция должна быть запрещена (щелкните в боксе выбора: галочка 
удаляется).  

3. Выберите схему "Sim_reg" и перетащите ее в рабочую область "Top 
Chart". Оригинальная схема скопирована.  

4. Переключитесь к просмотру листа.  
Схема со входами и выходами похожа на блок и изображается как схема с 
иконкой:  

 
5. Теперь Вы можете увидеть, что это копия созданной ранее схемы, 

откройте  ее командой Open, используя меню, выпадающее по щелчку 
правой кнопки мыши. В заголовке окна Вы видите, что это "вложенная 
схема" с путем: ...\\Top Chart\Sim_reg.  

В заголовке окна Вы можете увидетье, что это "вложенная схема" с путем: 
...\\Top Chart\Sim_reg.  
В каталоге схем, спереди от "Top Chart" показан символ +. Нажатием на + 
(или двойным нажатием иконки схемы), Вы можете открыть дерево и увидеть 
иерархию схемы: схема "Sim_reg" показана в виде ветви как активная схема 
(иконка открытой папки). 
Для того, чтобы вернуться к верхней схеме, Вы можете выбрать "Open Parent 
Chart" («Открыть родительскую схему») с помощью правой кнопки мыши или 
выберите путь для "Top Chart" в меню "Window". 

Результат  
В этой части Вы узнали, как редактировать схему с входами и выходами, что 
позволяет соединять ее с другими с входами и выходами блоков и 
использовать так часто, как требуется. Вы увидели, как схема может быть 
вставлена подобно блоку (техника схема-в-схеме). Вы увидели, что в отличие 
от блока, вставленная схема может быть открыта и изменена. 
С помощью техники схема-в-схеме Вы можете создавать вложенные схемы и 
создавать структуру, с большей ясностью отражающую технологические 
особенности.  
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2.5 Создание типа блока  

Обычно, папка схем, содержащая открытые схемы, компилируется в целом. 
Это дает программу, которая затем загружается в CPU. Но Вы можете также 
компилировать одну схему и создавать из нее тип блока. При этом он 
помещается в библиотеку блоков или в программу S7 для дальнейшего 
использования.  

Компиляция схемы как типа блока  
Сейчас Вы скомпилируете исходную схему "Sim_reg" как тип блока. 

1. Закройте все схемы (Window > Close All) (Окна> Закрыть все).  
Убедитесь, что Вы открыли оригинальную схему "Sim_reg", которая 
находится на том же иерархическом уровне, что и схемы "Top Chart" и 
"Control".  

2. Выберите схему "Sim_reg" в каталоге "Charts" и откройте ее командой 
"Open"  , используя правую кнопку мыши.  

3. Выберите Chart > Compile > Chart as Block (Схема > Компиляция > 
Схема как блок).  

Появится диалог, в котором Вы введете дальнейшую информацию.  

4. В окне "Properties Block Type" ("Свойства типа блока") введите:  
 
FB number (Номер FB): 110 
Symbolic name (Символьное имя): REG_1 
Name (header)  (Заголовок): REG_1 
Family (Семейство): CONTROL 
Author (Автор):  TEST 
Version (Header) (Версия (заголовок)): 0.1 

5. Подтвердите, нажав "OK". 

Начнется компиляция и процесс ее выполнения отображается в диалоговом 
окне. После успешной компиляции, блок "FB110" находится в папке блоков, а 
символьное имя "REG_1 введено в таблицу символов. 
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2.5.1 Тестирование блока  

Следующий шаг – это создание новой схемы и вставка в нее блока REG_1.  

1. Создайте новую схему "Test".  

2. Нажмите клавишу "F5" (или View > Update (Вид > Обновить)), чтобы CFC 
прочитала изменения в таблице символов и папке блоков.  

3. Откройте программу S7 в каталоге блоков. Здесь, Вы увидите новый тип 
блока REG_1. 

4. Вставьте REG_1  в схему "Test", перетащив его мышью и переключитесь к 
просмотру листа. Вы увидите входы и выходы блока, созданные Вами, как  
входы и выходы схемы. Вход EN и выход ENO добавлены системой (для 
активации и деактивации блоков). Эти вход и выход невидимы (по 
умолчанию). Если Вы хотите отобразить эти вход и выход, Вы должны 
сделать их видимыми в свойствах объекта, таблица "Inputs/Outputs" 
("Входы/Выходы").  

5. Откомпилируйте все схемы вместе, как программу в целом, и загрузите 

программу в CPU. Нажмите .  

Вы получите сообщение, что программа была изменена и должна быть 
откомпилирована. 

6. Ответьте на вопрос "Do you want to compile now and then download?" 
("Хотите ли Вы откомпилировать сейчас и затем загрузить?")  - "Yes" 
("Да"). 

Вы увидите диалоговое окно с страницами "Compile Charts as Program"  
("Компилировать схему как программу") и "Download S7" ("Загрузка S7").  

7. Выберите "Scope: Changes" («Область: изменения») в обеих таблицах и 
нажмите "OK".  

8. Затем переключитесь в режим тестирования  для наблюдения и 
изменения входов и выходов блока.  

С помощью входа SIM, Вы можете переключаться между внутренней 
имитацией (= 0) и внешней величиной процесса (вход PV) (= 1).  

Заключение 
В этом примере, Вы получили знания о некоторых возможностях CFC. 
Упражнения проиллюстрировали, как легко Вы можете создать программу 
для задачи автоматизации, которая затем может быть выполнена на CPU.  
Как только Вы выполните этот пример, Вы узнаете CFC достаточно хорошо, 
чтобы браться за более сложные задачи. 

Следующие главы и интерактивная справка CFC дадут Вам более подробную 
информацию. 
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3 Работа с Редактором CFC  

Обзор 
В этой главе описано, как, используя редактор CFC, разработать 
структурированную программу для CPU. 

Требования  
Используя SIMATIC Manager, Вы создаете проект с папкой программы для 
заданного устройства автоматизации (например, программу S7 для SIMATIC 
S7), включающей папку схем.  

 
 Замечание: 

CFC –  "совместим вверх", это означает, что программы измененные с 
помощью других инструментов без редактора CFC, становятся 
несовместимы.  

 
Ограничения для работы множества пользователей в сети:  
Несколько пользователей могут работать в одном проекте. Это позволяет 
конфигурировать, тестировать и  запускать AS из различных точек или PC в 
сети (многопользовательский режим). 
Если PC включены в сеть, помните, что одно устройство автоматизации AS 
может одновременно редактироваться только одним пользователем. 
Если несколько человек в различных точках хотят работать в проекте, проект 
можно разделить, отредактировать, затем снова соединить. Вы можете 
распределить отдельные схемы программы S7 на несколько рабочих 
проектов, затем, после редактирования, соединить их вместе. 
Для более подробной информации обратитесь к Разделу 3.14, «Раздельная 
разработка проекта» или к интерактивной справке CFC.  
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3.1 Обработка схем  

Создание схемы  
Обычно Вы создаете схему с помощью SIMATIC Manager (команда меню 
"Insert > S7 Software > CFC" (“Вставка> Программы S7 > CFC“)); но это  
возможно и напрямую в редакторе CFC (команда меню "Chart > New" (“Схема 
> Новая")). Имя схемы должно быть уникальным в пределах CPU 
(проверяется системой) и должно содержать не более 22 символов. 

Когда Вы создаете новую схему, автоматически создается и устанавливается 
в последовательность выполнения рабочая группа (run-time group) в 
соответствии с указателем установки схемы. Имя рабочей группы совпадает с 
именем схемы. 

Открытие схемы  
Вы можете открыть схему с помощью SIMATIC Manager. Выберите проект и 
папку проекта, откройте папку схем и дважды щелкните на нужной схеме, 
чтобы открыть ее, запустив, одновременно, редактор CFC. 
Меню «Chart»("Схема") в редакторе CFC всегда показывает последние 
четыре схемы, которые Вы редактировали и закрыли. Если Вы выбрали одну 
из этих схем, откроется соответствующая схема или, если она уже открыта, 
эта схема отобразится на экране. 
Вы можете открыть схему, которая не показана в меню "Схема", выбрав 
команду меню "Chart > Open" ("Схема > Открыть") и проект в диалоговом 
окне, выбрав папку программы и тип объекта "CFC", и дважды щелкнув на 
выбранной схеме. 
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Копирование/перемещение схемы 
Копирование целых схем позволяет Вам дублировать или перемещать 
структуры или подструктуры, которые Вы хотите протестировать, даже в 
другой CPU. 
Когда Вы копируете/перемещаете схемы, ресурсы (типы блоков, FB и FC, 
включая символы, системные атрибуты и вызываемые экземпляры 
мультиэкземплярных блоков), также копируются, если они не существуют уже 
в пункте назначения. 
Помните, что на функции копировать/перемещать влияют существующие 
соединения и блоки. Если тип блока в пункте назначения CPU несовместим с 
типом блока, который Вы копируете (число, порядок, имена и типы данных 
входов и выходов блока), схема не будет скопирована. 
В таком случае, перед тем, чтобы скопировать снова:  

- Вы должны скопировать соответствующий тип блока или в папку 
блоков исходной программы или в папку блоков программы 
назначения.  

- Выберите тип блока в окне "Chart Folder" ("Папка схем") с помощью 
команды меню "Options > Block Types..." ("Опции > Типы блока...") и 
измените общий тип блока кнопкой "New Version" ("Новая версия").  

Скопированные блоки сохраняют свойства выполнения во времени блоков 
исходного CPU; другими словами, они установлены в последовательности 
выполнения так же, как и в исходном CPU. Если задачи с таким именем не 
существует в назначенном CPU, выводится сообщение о недостающей 
задаче и копирование не выполняется. 
Если Вы копируете/перемещаете схему в другую папку схем, соединения с 
другой схемой становится текстовыми. Открытое текстовое соединение 
может быть замкнуто снова (превратиться в реальное соединение блоков), 
если схема с партнером по соединению также копируется или перемещается 
в эту папку схем или если схема копируется/перемещается обратно в 
исходную папку.  
Если текстовое соединение уже существует в схеме и схема 
копируется/перемещается, текстовое соединение берется вместе со схемой  
Для более подробной информации о текстовых соединениях смотрите 
Раздел 3.6.3.  
Когда копируются схемы, помните, что соединения с глобальными 
адресами копируются в зависимости от настроек по умолчанию.  Вы можете 
установить их в диалоговом окне “Settings for Copying/Moving" ("Установки для 
копирования /перемещения") (команда меню "Options > Customize > 
Copy/Move..." ("Опции> Настройка > Копировать/ Переместить...")). 
Схемы CFC могут также копироваться /перемещаться между различными 
целевыми системами (например,  SIMATIC S7 ↔ SIMATIC M7). В этом случае 
типы блоков, используемые обеими системами, должны быть идентичными; 
другими словами, они должны быть совместимы, иначе они не копируются. 

Закрытие/Удаление схем  
Поскольку все изменения в схеме сохраняются немедленно, Вы можете 
закрыть схему или выйти из редактора в любое время. 

Удалить схему CFC Вы можете в SIMATIC Manager. 



Работа с Редактором CFC 

 CFC для S7 
3-4 A5E00345244-01 

3.2 Создание схемы  

В начальном виде (после вставки в папку схем), схема CFC состоит из одного 
раздела схемы с 6 листами. Вы можете переименовать такую схему и 
расширить ее. 
Вы можете добавить в схему входы и выходы (см. Раздел 3.2.3) так, что она 
будет соединена с другими схемами или вставлена в другую схему, где может 
соединяться с другими блоками. Если Вы используете технику схема-в-схеме 
(вставка схем с входами и выходами в другую схему), Вы создаете 
вложенные схемы (см. Раздел 3.2.4). 
Схема может быть вставлена в другую схему и без входов и выходов  
(например, если Вы хотите создать входы и выходы позже). 

3.2.1 Настройка свойств схемы  

В диалоговом окне "Properties CFC Chart" (“Свойства схемы CFC”), Вы можете 
установить параметры активной схемы, такие как, имя схемы, автор и 
комментарии. 
В CFC Вы можете отобразить диалоговое окно с помощью команды меню 
“Chart > Properties…” (“Схема > Свойства…”). 
Для дополнительной информации и информации о назначении имен в PCS 7, 
смотрите интерактивную справку CFC. 

3.2.2 Вставка и удаление разделов схемы  

При необходимости Вы в любое время можете добавить в схему CFC 
дополнительные разделы. Для каждого раздела схемы есть закладка, с 
помощью которой Вы находите нужный раздел в нижнем краю окна на высоте 
линейки прокрутки.  
Когда Вы вставляете раздел схемы, Вы можете решать, вставить ли новый 
раздел перед текущим или добавить как последний раздел. Схема может 
состоять из 26 разделов; они обозначаются буквами алфавита (A - Z). 
Буквенное обозначение отдельных разделов схемы может меняться, если Вы 
вставляете дополнительные разделы.  
Например, схема "CFC1" состоит из одного раздела, ему дана буква "A". Если 
Вы вставляете дополнительные разделы перед первым, новая часть станет 
"A", а предыдущая  - "B".  

 

Раздел схемы A

Раздел схемы C
Раздел схемы B

Раздел схемы D

Схема"CFC1" 

 
Рисунок3-1: Схема с разделами 
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В зависимости от вида (просмотр листа или обзор схемы), идентификатор 
текущего раздела схемы показан в строке состояния вместе с номером листа, 
или со словом "Overview" ("Обзор"). Пример:  

 Просмотр листа Обзор схемы:
B/Sheet 3 B/Overview  

Вы можете удалить только активный раздел схемы. Если активный раздел 
пуст, Вы удалите его после того, как выберите команду меню "Edit > Delete 
Chart Partition" ("Редактор > Удалить раздел схемы"). Если раздел схемы 
содержит объекты, Вы будете должны подтвердить удаление.  

3.2.3 Создание схемы с входами и выходами  

Вы можете создать схему с входами и выходами для расширения 
возможностей, таких как   

• Установка в различные схемы (вложенные схемы, см. Раздел 3.2.4) и 
соединение с другими схемами или блоками  

• Компиляция как типа блока  
Вы назначаете выбранным входам и выходам схемы входы и выходы 
внутренних блоков, содержащихся в схеме, или вложенных схем.  

Окно "Chart Inputs/Outputs" (" Входы и выходы схемы ")  
Вы создаете входы и выходы схемы в отдельном окне CFC. 
С помощью команды меню "View > Chart Inputs/Outputs" ("Вид > Входы и 

выходы схемы") или кнопки  на панели инструментов, Вы можете открыть 
(и закрыть) окно "Chart Inputs/Outputs" ("Входы и выходы схемы").  
Процедура для создания входов и выходов схемы подробно описана в 
примере в Разделе 2.4.1.  

Системные атрибуты  
Как и для блоков, Вы можете назначать системные атрибуты отдельным 
входам и выходам схемы. 
Схема с входами и выходами сама не имеет системных атрибутов (кроме 
собственно атрибутов входов и выходов). Вы можете назначать эти атрибуты, 
если Вы откомпилируете схему как тип блока (см. Раздел  3.11.2).  
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Замечания: 
• Вы можете соединять несоединенные входы и выходы с входами и 

выходами схемы только при совместимости типов данных соединяемых 
входов и выходов 

• Если входы и выходы уже соединены, для них невозможно изменить тип 
данных. 

• Выходам схемы не могут назначаться параметры, если они соединены. 
Исключение: Вы назначаете параметры выходам блока; эта величина 
вводится затем для соответствующего выхода схемы.  

• Вы можете назначать вход схемы нескольким входам различных блоков 
или схем.  

Назначение входов и выходов, когда схемы уже установлены  
Вы также может расширить схему, добавив входы или выходы позднее. Если 
это вложенная схема (см. также 3.2.4), другими словами, схема, которая уже 
установлена в другую схему, дополнение входов и выходов может привести к 
конфликту размещения схемы на листе. В таком случае,  вложенная схема 
отображается как перекрывающиеся блоки; другими словами, выделяется 
серым, а входы и выходы не изображаются. 
Как только схема будет перенесена в свободное место, входы, выходы и 
соединения станут снова видимы. 
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3.2.4 Создание вложенных схем  

Вы можете вставлять одну схему CFC в другую. Это позволяет Вам создавать 
программу, структурированную соответственно Вашим технологическим 
требованиям, повторно используя типовые части программы. 
Схемы, вложенные в другую схему, могут быть открыты и изменены в режиме 
редактирования, исполняются и контролируются в тестовом режиме.  
Схема, содержащая вложенные схемы, является главной схемой в SIMATIC 
Manager. В папке схем Вы можете увидеть только главную схему. 
Максимальная глубина вложенности для схем – 8 (главная схема + 7 уровней 
вложенных схем). 

Вставка схемы в схему  
Вы можете перетащить новую схему в текущую схему из каталога блоков 
(иконка  “New Chart” («Новая Схема»)) и продолжить редактирование. Если 
Вы используете команду меню "Insert > New Chart" ("Вставить > Новая 
Схема"), автоматически будет осуществлен поиск свободной позиции в схеме 
(в просмотре текущего листа) и новая схема будет помещена в найденную 
свободную позицию. 
Схемы используются в CFC подобно блокам, они показаны в каталоге схем в 
виде дерева. Оттуда Вы можете перетащить схему в текущую открытую 
схему. Когда Вы вставляете схему, то копируете ее вместе со всеми 
вложенными схемами (если она содержит дополнительные схемы).  
Вы также можете переместить родительские схемы в схему путем 
перетаскивания их мышью, удерживая нажатой клавишу Shift. В таком случае, 
они не копируются, а перемещаются. В каталоге схема более не показана  в 
месте ее предыдущего размещения, но она показана в иерархии активной 
схемы. 

Навигация в схеме  
Для того чтобы открыть вложенную схему, выберите ее в родительской схеме 
и подайте команду меню "Open" с помощью правой кнопки мыши или меню 
"Edit". Вы также можете открыть схему двойным нажатием на свободной 
позиции в ее изображении (т.е. не на заголовке или входе, выходе). Повтором 
этого Вы можете спуститься к самой нижней в иерархии схеме.  
Для перемещения вверх по иерархии, выберите вложенную схему, затем 
нажмите команду меню "Open Parent Chart" (“Открыть Родительскую Схему”) 
с помощью правой кнопки мыши или меню “Схема”.  
Также Вы можете открыть схему в каталоге схем. Выберите схему и затем 
выберите команду меню "Open" (“Открыть”) с помощью правой кнопки мыши.  

Копирование вложенной схемы в другие CPU  
Вы можете копировать вложенную схему и вставлять ее в схему другого CPU. 
Позиция, в которую будут установлены блоки, определяется "Predecessor for 
Installation" («Предшественником для установки») схемы назначения. Рабочая 
группа не копируется. 



Работа с Редактором CFC 

 CFC для S7 
3-8 A5E00345244-01 

Копирование и удаление  
Если Вы хотите удалить вложенную схему из родительской схемы, но не из 
папки схем (например, Вы можете изменить ее и использовать позже), 
сначала скопируйте ее в папку схем. Из открытой схемы (активной) выберите 
команду меню "Chart > Copy to Chart Folder" (“Схема > Копировать в папку 
схем"). Схема будет скопирована и вставлена в папку схем с новым именем. 
Теперь Вы можете удалить вложенную схему на родительской. 

Соединение  
Если вложенная схема имеет входы и выходы, Вы можете соединить схему с 
другими вложенными схемами, с блоками или с глобальными адресами.  
Как назначать входы и выходы блока входам и выходам схемы, описано в 
Разделе 2.4.1. Вы можете использовать эту процедуру, когда Вы хотите 
соединить входы и выходы вложенной схемы с входами и выходами той 
схемы, которая выше в иерархии.  
Также Вы можете выполнить соединение, если Вы выбрали вход или выход 
блока или схемы, а затем команду "Connection to Chart I/O..." (“Соединение с 
входами и выходами схемы”) с помощью правой кнопки мыши или меню 
"Insert" (“Вставка”). Окно "Chart Inputs/Outputs" (“Входы и выходы схемы”) 
открывать не нужно. Диалоговое окно показывает список всех доступных 
входов или выходов; другими словами, если Вы выбрали вход, в списке будут 
элементы типа "IN", а, если Вы был выбран выход – то типа "OUT". 

 
 Замечание: 

Помните, что схема, которую Вы вставляете путем перетаскивания из 
каталога схем в текущую схему CFC, тоже копируется. Эта вложенная схема 
не связана более с оригинальной схемой. Другими словами, изменения, 
которые Вы сделали в одной из схем, существуют только в ней. 

Замена  
Вы можете заменить вложенную схему другой (вложенной) схемой. 
Соединения “старой схемы” по возможности сохраняются в новой схеме.  

Для замены вложенной схемы, перетащите новую схему из каталога схем 
напрямую на заменяемую вложенную схему. Схема заменится, когда курсор 
будет внутри схемы в нужной точке; появится запрос, хотите ли Вы или нет 
заменить схему, согласитесь, нажав “ОК”. 

Эту функцию «замена» можно использовать, например, если Вы 
конфигурируете вложенные схемы как модульную функцию и предназначаете 
их для различного использования. Может возникнуть следующая ситуация: 
Вы имеете вложенную подфункцию как вложенную схему и соединяете 
вложенную схему со схемой. Подфункция – это, например, программа 
управления для вентиляционной системы, которая зависит от различных 
вариантов и места использования. Внутри структуры эти варианты могут 
изменяться без необходимости менять соединения. 
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3.3 Обработка блоков  

Блоки для CFC  
Базовый набор блоков поставляется с CFC. Вы можете получать 
дополнительные блоки из библиотек или других проектов.  

Помощь  
Интерактивная помощь обеспечивает описание блоков, поставляемых с CFC, 
которое можно открыть, нажав "Help arrow" ("Указатель помощи") (в схеме 
CFC, в папке блоков или каталога) или клавишу F1 для выбранного блока.  
 

 Замечание: 

"Библиотека CFC" содержит блоки для CPU 3xxx в папке "ELEM_300". Эти 
блоки не могут выполняться на CPU 4xxx. 

 

3.3.1 Импорт блоков  

Импорт в CFC  
Путем импорта существующие блоки становятся доступными в CFC. Вы 
можете использовать в CFC только такие блоки. 
Вы можете импортировать блоки, вставляя их из каталога (скрытый импорт), 
или явно с помощью команды меню "Options > Block Types..." ("Опции > Типы 
блоков..."). 
Явный импорт используется всегда, когда Вам требуется импортировать 
много различных блоков. Впоследствии, вставка из каталога будет 
выполняться намного быстрее, поскольку неявный импорт более не нужен. 
Вы можете использовать диалог "Block Types..." ("Типы блока..."), например, 
для импорта нескольких блоков из пользовательской программы (папки 
блоков) в папку схем. Вы можете также использовать этот диалог, когда Вы 
изменяете (изменение типа) в папке блоков блоки, которые существуют с 
этим же именем в папке схем и должны быть обновлены в папке схем.  
Вы можете выбрать требующиеся блоки в окне "Offline block folder" ("Папка 
блоков автономного режима") и затем импортировать блоки в папку схем, 
перетащив их  мышью или кнопкой "-->". Если блок уже существует в папке 
схем, появится сообщение. 

Совет: Импортируемые блоки появляются в каталоге блоков в 
соответствующем семействе блоков в разделе "All Blocks" (“Все блоки”). 
Затем Вы только вставляете блоки в схему из этого каталога блока. 

Конфликт номеров  
Если уже импортирован и существует блок с таким же именем объекта 
(номером блока, например, FB61), но с другим символьным именем, 
откроется диалог, в котором Вы можете переименовать блок (подобно 
SIMATIC Manager, когда копируются блоки с одинаковым именем объекта). 
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3.3.2 Импорт новой версии   

Если, вслед за изменением типа блока, Вы хотите использовать измененные 
блоки вместо ранее использованных старых типов блоков, новые типы блоков 
должны быть импортированы в папку схем. Экземпляр блока, используемый в 
схеме CFC, может затем адаптироваться к изменению типа блока 
(централизованное изменение типа блока).  
Блоки импортируются следующим образом: 

• Когда Вы вставляете измененный тип блока из программы S7 или 
библиотеки блоков в схему. 

• Используйте команду меню "Options > Block Types..." ("Опции > Типы 
блоков...") в диалоге "Block Types" ("Типы блоков"). Здесь выберите блок, 
импортируемый из списка исходных файлов ("Block Folder Offline"( "Папка 
блоков автономного режима")) и перетащите блок в список "Chart Folder" 
("Папка схем") (или нажмите кнопку "-->"). 

Использование новой версии  
Если в папке схем уже существует тип блока с таким же именем, но с другой 
версией, появится диалоговое окно "Import New Version" ("Импорт новой вер-
сии") с сообщением о последствиях и информацией, о версиях обоих блоков. 
Если Вы отвечаете на вопрос "Do you still want to use the new version of the 
block types?" ("Хотите ли Вы использовать новую версию типов блока?") 
"Yes", все соответствующие экземпляры блоков изменяются. Если Вы 
отвечаете “No”, адаптации не произойдет. Могут возникнуть три различные 
ситуации: 

1. Изменения не требуют ни загрузки программы в целом, ни повторного 
вызова передачи данных AS - OS (компиляция OS), поскольку они 
действуют только внутри ES (например, входы и выходы блоков сделаны 
невидимыми). В таком случае, Вам необходима только загрузка 
изменений в режиме RUN.  

2. Изменения, которые влияют на OS, поэтому требуется повторная 
компиляция OS (например, после изменения текстов сообщений).  

3. Изменения в структуре, например, добавление входов или выходов, а 
также, возможно, и сообщений. Это приводит к следующим последствиям:  

- Соединения и установки параметров могут быть утеряны.  

- Можно загрузить только программу в целом; другими словами, 
потребуется переход CPU в режим STOP.  

- Если блок подлежит управлению и мониторингу со стороны оператора 
(он будет выполняться на OS), необходима также компиляция OS.  

- Если Вы хотите сохранить настройки параметров на AS, перед 
загрузкой схема должна быть выгружена из CPU.  

 
 Замечание: 

Централизованное изменение блока не выполняется, если изменена 
категория типа блока (например, FB <--> FC). 

Идея централизованного изменения типа блока относится к FB и FC. Типы 
BOP не могут изменяться, поскольку они являются встроенной частью CFC. 
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Совпадение версий  
Если Вы импортируете типы блоков, и такие же версии уже существуют в 
папке схем, Вы будете проинформированы, что Вам не нужно импортировать, 
и увидите список совпадающих типов блоков. 

“Уборка” типов блока  
С помощью кнопки "Tidy Up" («Уборка»), Вы можете удалить блоки из папки 
схем и папки блоков, если они более не требуются в проекте.  

CFC проверяет, имеются ли типы блоков, неиспользуемые ни в одной из 
папок. В зависимости от результатов проверки, откроется диалоговое окно со 
списком неиспользуемых в каждой папке блоков. (Папка блоков: Типы блоков, 
которые не импортированы в систему хранения данных CFC; Папка схем: 
Типы блоков, экземпляры которых не существуют в схемах CFC).  

Блоки в библиотеке  
Если Вы изменяете тип блока, до этого находившийся только в библиотеке, 
пожалуйста, помните, что нужно включить блоки в программу S7 (папку 
блоков) перед тем, как Вы обновите блоки в папке схем с помощью "New 
Version" ("Новая Версия "). 

Если Вы изменили тип блока внутри программы S7 (в папке блоков), 
пожалуйста, помните, что библиотеку также можно обновить. 

Протоколирование типов блока  
Изменения в результате централизованного изменение типов, 
протоколируются и автоматически отображаются после обновления. Вы 
также можете отобразить их снова и, если требуется, распечатать  с 
помощью команды меню "Options > Logs...: Block Types" ("Опции > 
Протоколы...: Типы блоков "). Если необходимы изменения экземпляров 
блока, Вы можете использовать протоколы чтобы помочь Вам как сэкономить 
время, так и снизить риск ошибок.  
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Допустимость импорта типа после расширения типа данных  
Если тип данных для типа блока расширен, все данные входов и выходов 
сохраняются при централизованном изменении типа, если старый тип данных 
может отображаться на новом типе без преобразования. Это: 
BYTE -->  WORD 
BYTE --> DWORD 
WORD --> DWORD 
INT --> DINT 
STRING1n --> STRINGn+m (т.е. STRING16 --> STRING32) 

Замечание: 
Помните, что в результате централизованного изменения типа тем не менее 
теряются существующие соединения с этими входами и выходами. 

3.3.3 Влияние изменений типа на экземпляры блоков  

Если описание интерфейса (входы и выходы блока) или системные атрибуты 
типа блока изменяются в схеме CFC, все экземпляры блоков автоматически 
адаптируются. В зависимости от изменений интерфейса, это может влиять на 
дальнейшие действия.  

Влияние изменений на входы и выходы блока  
• Вход или выход добавлен 

Изменение выполняется также в экземплярах блока, а системные 
атрибуты получают значение по умолчанию. Если блоки более не 
умещаются  на занимаемой позиции после увеличения размера, блоки 
становится "перекрывающимися".  

• Вход или выход удален  
Вход или выход удаляется из экземпляров блока. Если вход или выход 
был соединен, то соединение (или доступ SFC) также удаляется. 
Удаленное соединение (или удаленный доступ SFC) вносится в протокол 
изменений. 

• Изменен порядок входов или выходов  
Порядок входов или выходов принимается во внимание, а соединения, 
назначение параметров и атрибуты сохраняются. 

• Изменен тип данных входа или выхода 
Все назначенные параметры и соединения этого входа или выхода 
утеряны. Эта ситуация появляется, когда Вы удаляете и затем 
восстанавливаете вход или выход.  

• Изменено имя входа или выхода 
Все назначенные параметры и соединения входа или выхода теряются. 
Ссылка на старое имя не может быть автоматически установлена 
системой. Эта ситуация появляется, когда Вы удаляете и затем 
восстанавливаете входы и выходы.  
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Влияние изменения системных атрибутов  
Если Вы изменили атрибуты, эффект резюмируется одним общим правилом:  
Что не может быть изменено в экземплярах блоков, автоматически 
изменяется в экземплярах как результат изменения типа.  

Влияние на другие функции  
• После этого нельзя загрузить «только изменения» (загружается только 

программа в целом).  

• Функция "Read Back Chart" («Выгрузка схемы») более невозможна, 
поскольку блок в AS более совпадает с конфигурацией в CFC.  

Влияние на WinCC  
• Если изменен тип блока, при сжатии и компиляции могут быть созданы 

DB с новыми номерами. Для гарантии сохранения интерактивного доступа 
данные должны быть заново переданы в WinCC (компиляция OS).  

• Если вход или выход блока, предназначенный для операторского 
управления и мониторинга, затронут (атрибут S7_m_c=true), применимы 
следующие правила:  

- Если добавлен вход или выход, он становится доступен в WinCC при 
компиляции OS и может там использоваться.  

- Если вход или выход удален, тег WinCC более не существует. 
Существующее соединение должно быть также удалено в WinCC.  

- Если изменено имя входа или выхода, имя тега WinCC также 
меняется. Соединения элементов рисунка, иконок блоков и лицевой 
панели должны адаптироваться.  

• При изменениях, влияющих на WinCC, всегда необходима новая 
компиляция OS.  
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3.3.4 Вставка блоков в схему  

Вставка в схему  
Вы можете вставлять блоки, как в режиме просмотра листа, так и в обзоре 
схемы.   

Вы можете выбрать тип блока из других схем, из каталога блоков или 
библиотек, и перетащить его в свою схему. Он автоматически копируется в  
текущую программу S7 и импортируется в схему CFC. Изменения затем 
появляются в каталоге блоков (в семействе блоков CFC и в разделе “All 
blocks” ("Все блоки")).  

Если Вы перетащили блок туда, где не было достаточно свободного места 
для текущего размера блока, блок вставится как "перекрывающийся". Входы 
и выходы перекрывающегося блока не отображаются, а заголовок и тело 
выделены серым. Как только Вы перенесете этот блок на свободную 
позицию, он будет показан как обычный. 

Если Вы хотите вставить блоки из каталога блоков "Программы S7" в каталог 
блоков, пожалуйста, помните следующее:  

Блоки в программе S7 еще не известны CFC (даже если блок такого типа уже 
импортирован). Это значит, что когда Вы хотите вставить блок из программы 
S7 в схему, всегда выполняется проверка, импортирован ли уже блок.  

Блоки, которые уже были импортированы в одно семейство блоков или, если 
блок не связан с семейством (определено в заголовке), помещаются в папку 
"Other Blocks" (“Другие блоки”). Они также перечисляются в алфавитном 
порядке в папке "All Blocks" (“Все блоки”).  

 
 Замечание: 

Вставка блоков из семейства блоков является самым быстрым способом 
помещения блоков в схему, поскольку не требует проверки. Всегда 
выбирайте этот метод, когда тип блока уже импортирован. 

Автоматическое назначение имени 
Когда Вы вставляете блок в схему, блоку назначается номер, как его имя по 
умолчанию. Это продолжается: каждый раз, когда Вы вставляете новый блок 
(копированием или перетаскиванием из каталога), ему назначается то же имя 
с добавлением очередного номера.  

Если Вы изменяете имя по умолчанию, то это правило применяется и к 
измененному имени блока при копировании или перемещении: 
Если  в результате копирования получается два блока с одинаковым именем, 
добавляется номер (без скобок). Если последний символ измененного имени  
- число, оно увеличивается.  

Примеры:  
Блок:  2 Копия  3 
Блок: REG Копия  REG1 
Блок: REG3 Копия  REG4 
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Определение свойств стадии выполнения 
Когда Вы вставляете блок, должны быть также определены свойства времени 
выполнения, например, указано, как блок вставляется в последовательность 
выполнения. 
Правило по умолчанию: Блок всегда вставляется после блока, показанного в 
строке состояния. 
Вы можете изменить позицию установки, выбрав блок, который считается 
"предшественником" для последующей установки, а затем подав команду 
меню "Edit > Predecessor for Installation" ("Редактор > Предшественник для 
установки"). 
Текущая точка вставки показана справа в строке состояния. Показано имя 
задачи, а также схема и имя блока, после которого будет установлен 
следующий блок в последовательности выполнения, когда блок вставляется 
в схему CFC.  
В окне схемы блок, после которого должен устанавливаться следующий блок 
в последовательности выполнения (позиция предшественника для установки) 
также выделена цветом. Поле для свойств времени выполнения в заголовке 
блока выделено светло зеленым фоном с черным шрифтом. 
Для более подробной информации о рабочих свойствах смотрите Раздел 3.7  

Выравнивание блоков в схеме  
Вы можете автоматически выровнять выделенные блоки в схеме, даже после 
того как они соединены (команда меню: "Edit > Align > Left / Right / Top / 
Bottom" ("Редактировать > Выравнивание > Влево / Вправо / По верху / По 
низу")). Исключение: Эта команда меню не работает, если выбран 
перекрывающийся блок.  
Блоки выравниваются по видимой графической границе блока (не фрейм 
выбранного блока). По самому дальнему блоку слева или справа, вверху или 
внизу решается, как выравнивать блоки. 
Если выравнивание привело к конфликту, например, блоки перекрываются, 
появится сообщение и сохранится старая ситуация. В таком случае, блоки не 
выравниваются, даже те, которые могут выровняться без перекрытия. 

Вставка и редактирование текстовых окон  

Вы можете перетащить текстовое окно (иконка:  New Text (Новый текст)) из 
каталога блоков и вставить его в любую точку схемы. Вы можете ввести текст 
после того, как Вы откроете текстовое окно простым нажатием. Вы можете 
настроить размер окна по вводимому Вами тексту. 
Для более подробной информации смотрите интерактивную справку.  
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3.3.5 Копирование и перемещение блоков  

Вы можете копировать или перемещать блоки внутри схемы или в другую 
схему. Также возможно скопировать или переместить несколько или все 
блоки схемы вместе. Это позволяет Вам быстро и без ошибок дублировать 
тестируемые подструктуры.  
Можно копировать блоки в другие CPU. Это функционирует так же, как и 
копирование схем в другие CPU.  
Скопированные блоки вставляются в другую схему в ту же точку  на одну 
ячейку сетки справа и ниже. В ту же позицию значит и то, что блок 
вставляется на лист с тем же номером.  
Если объект уже находится в этой позиции, блоки отображаются как 
перекрывающиеся, в ином случае они показаны нормально. Вы можете 
переместить блоки в нужную точку (это не обязательно, поскольку даже 
перекрывающиеся блоки могут выполняться на AS). 
С точки зрения рабочих свойств и последовательности выполнения, 
поведение копирования похоже на вставку из каталога; другими словами, 
место вставки определяется "предшественником для установки".  
Если блоки были установлены в рабочую группу, рабочая группа не 
копируется. 
Насколько возможно, имя блока сохраняется. Если возникает конфликт, к 
имени добавляется номер. 
Обратитесь к интерактивной справке. 

3.3.6 Удаление блоков  

Если Вы удалили блоки, все соединения между удаленными блоками и 
объектами, которые Вы не удалили, теряются.  

Если выход соединен с блоком, который Вы не удалили, появляется 
предупреждение. Если Вы решили удалить, входу блока, который не удален, 
вместо удаляемого соединения, будет назначена величина параметра по 
умолчанию. 
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3.4 Редактирование блоков  

Редактирование блоков в схеме означает изменение их свойств. 
Свойства могут относиться к блокам в целом или к отдельным выходам и 
входам. Установка свойств входов и выходов описана в Разделе 3.5.   

 
 Замечание 

Вы можете переключиться от выбранного экземпляра блока к 
соответствующему типу блока (Edit > Go To > Block Type (Редактировать > 
Перейти > Тип блока)). Если исходник блока находится в проекте, 
открывается соответствующий редактор (LAD/STL/FBD или SCL), в котором 
Вы можете отредактировать тип блока. В противном случае, отроется 
редактор LAD/STL/FBD, в котором Вы можете прочитать информацию о 
блоке (Исключение: Системные атрибуты входов и выходов можно 
редактировать). 

3.4.1 Установка свойств объекта  

Диалоговое окно “Properties – Blocks” ( "Свойства - Блоки") содержит 
несколько станиц, в которых Вы задаете свойства. Это следующие страницы:  

Страница “Global” ("Общее")  
Здесь Вы можете увидеть все свойства, перестроенные от типа блока или 
созданные при вставке блоков (и системные настройки в графе 
"Специальные свойства объекта”).  
Вы можете изменить свойства блоков и вложенных схем, перечисленные 
ниже: 
Имя блока уникально во всей схеме и показано в заголовке блока (максимум 
16 символов).  
Комментарии  - это свободно выбираемый текст в заголовке блока. В 
заголовке блока отображается максимум 14 символов комментария. В 
маленьких блоках отображается максимум 7 символов.  
Свойства, перечисленные ниже, применимы только к блокам: 
Установите опцию "Operator C and M possible" ("Возможно наблюдение и 
управление оператором"), когда Вы предполагаете использовать 
управление и мониторинг блоков на OS. Она активирует кнопку "Operator 
Control and Monitoring" ("Наблюдение и управление оператором"), бокс 
выбора «Block icon» ("Иконка блока") (включая бокс ввода) и бокс выбора 
"MES-relevant" (“Относится к MES”).  
Кнопка "Operator Control and Monitoring" ("Наблюдение и управление 
оператором ") открывает диалог, в котором показаны входы и выходы блока, 
которые могут наблюдаться и управляться, с их атрибутами WinCC, которые 
можно здесь редактировать. 

Блоки, предназначенные для контроля и мониторинга, могут быть показаны в 
WinCC с помощью иконки блока (через которую можно вызвать лицевую 
панель). Если для типа блока доступны различные иконки блоков, то 
различные варианты типа могут различаться (например, блок MOTOR как 
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мотор, вентилятор, насос и т.д.) и они могут назначаться определенным 
экземплярам.  

В поле ввода Вы определяете, какая иконка блока будет для него показана в 
WinCC.  

С помощью бокса выбора «MES-relevant», Вы определяете, должна или нет 
информация от этого блока передаваться на уровни управления MIS / MES, 
при необходимости.  

Нажав кнопку "Messages" (“Сообщения”), Вы можете открыть диалог для 
конфигурирования сообщений. Здесь Вы можете редактировать тексты 
сообщений. 

С помощью бокса выбора "Read-back enabled" («Выгрузка разрешена»), Вы 
можете разрешить (по умолчанию) или запретить выгрузку этого блока. 

Страница "Inputs/Outputs" (“Входы и выходы”)  
Вы можете назначать параметры и комментарии для входов и выходов блока, 
включать их в список отладки и т.д., см. Раздел 3.5.  

3.4.2 Изменение числа входов и выходов  

Если блок имеет переменное число входов одного типа данных, например 
NAND, OR, Вы можете изменить количество входов блока, используя команду 
меню "Edit > Number of I/Os..." (“Редактировать > Число входов и выходов”).  
Число входов настраивается по Вашему выбору в диалоговом окне. 
Добавление входов должно быть в пределах свободной площади блока, в 
ином случае, блок будет показан как перекрывающийся и он должен быть 
перемещен на свободное место.  
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3.5 Изменение свойств входов и выходов  

Вы можете изменить свойства входов и выходов блока. Этой цели служат два 
различных диалога: 

• Диалог для редактирования всех входов и выходов блока на странице 
"Inputs/Outputs"  ("Входы/Выходы") диалогового окна "Properties - Block" 
("Свойства - Блок") отображается двойным нажатием на блок. На 
странице "Inputs/Outputs" ("Входы / Выходы") Вы увидите все свойства 
входов и выходов в форме таблицы.  

• Для простых входов и выходов, откройте диалоговое окно "Properties - 
Input/Output" ("Свойства - Вход/Выход") двойным нажатием на 
требующемся входе или выходе блока.  
В зависимости от свойств и типа данных входа или выхода блока, 
диалоговое окно будет содержать различную информацию, часть из нее 
доступна для редактирования, а часть – только для чтения. 

Замечание: 

В диалоге свойств Вы можете ввести единицы измерения (unit) для 
редактирования непосредственно или из списка выбора. В зависимости от 
области приложения, требующейся пользователю, их можно расширять или 
изменять при необходимости (обратитесь к интерактивной справке). 
Используя единицы измерения из этого списка, Вы добиваетесь единой 
записи в различных приложениях (например, списке тегов, редакторе CFC, 
редакторе SFC) и предотвратите проблемы, которые могут появляться при 
использовании специальных символов.  

 
 Замечание: 

В диалоге свойств Вы можете сделать различные вводы путем 
редактирования или выбора в выпадающих списках (например, для единиц 
измерения, перечислений и т.д.). Использование вводов из выпадающих 
списков обеспечивает однотипную запись в различных приложениях 
(например, список тегов, редакторы CFC или SFC) и избавляет от 
трудностей, связанных с использованием специальных символов.  

См. также «Общие декларации», Раздел 3.7.  
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3.5.1 Инвертирование входа блока  

Бинарные входы можно инвертировать. После инверсии, "0" станет "1", а "1" 
станет "0". Это возможно только для соединенных входов.  

Установка инверсии  
Вы инвертируете соединенный бинарный вход, выбрав вход и нажав на 

иконку   на панели инструментов или выбрав команду меню "Edit > Invert 
Input"  ("Редактировать > Инвертировать вход") или "Invert" (“Инвертировать”) 
в контекстном меню.  
В качестве альтернативы, Вы можете дважды щелкнуть на входе блока для 
того, чтобы открыть диалоговое окно свойств входа и затем поставить 
галочку в бокс выбора "Inverted" (“Инвертировать”).  

Удаление инверсии  
Для того, чтобы удалить инверсию, повторите действия, описанные выше. 

Вы можете также отменить инверсию, удалив соединение входа или 
переместив его в другой вход, или создав новое соединение. 

Замечания: 
• Если Вы копируете сигнал с инвертируемого входа на другой вход, новый 

вход не будет инвертирован автоматически. Вы должны инвертировать 
его специально.  

• Если Вы переносите соединение с инвертированного входа на 
неинвертированный, новый вход не будет автоматически 
инвертироваться и инверсия будет удалена с неподключенного далее 
входа.  

• Входы, присваиваемые входам и выходам схемы, не могут быть 
инвертированы.  
Решение: Вставьте в соединение блок NOT.  
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3.5.2 Идентификаторы используемых величин  

Кроме идентификаторов "Text for 0" ("Текст для 0") и "Text for 1" ("Текст для 1") 
для булевских величин 0 и 1, идентификаторы величин возможны также для 
некоторых типов числовых данных (BYTE; INT, DINT, WORD, DWORD). 

Создание идентификаторов величин 
Используя идентификаторы величин для величин параметров блока или 

входов и выходов схемы, Вы можете определить символические имена. 
Вы выполняете это определение с помощью системных атрибутов:  

• "S7_enum" 
• от "S7_string_0" до "S7_string_25"  

когда Вы создаете тип блока или входы  и выходы схемы. 

Можно использовать 
• "S7_string_0" и "S7_string_1" для бинарных величин (тип данных: BOOL),  
• от "S7_string_2" до  "S7_string_25" для целых (типы данных: BYTE, INT, 

DINT, WORD, DWORD), 
• "S7_enum" для бинарных и целых (типы данных: BOOL, BYTE, INT, DINT, 

WORD, DWORD). 
 

 Замечание 
При использовании системного атрибута "S7_enum",  системные атрибуты 
типа "S7_string_0" ... "S7_string_25", которые могут существовать на этих же 
входах и выходах не имеют значения.   
 

• Системный атрибут "S7_enum" требует в качестве переменной имя 
объекта. Перечисления включаются в проект, как "общие декларации". 
Каждое перечисление может включать различные переменные. См. 
также: "Проектирование перечислений", Раздел 3.7.9. 

Текст для "S7_enum" и "S7_string_0/1" может иметь максимум 16 символов, а 
для "S7_string_2 до 25"  до 8 символов. Отображаются только 8 символов. 
Если Вы используете более 8 символов, Вы можете решить, какие из них 
будут показаны. Для этого включите символ "=" в текст.  

• Если знак равенства (=) включен в текст, будут показаны первые 8 
символов справа от знака равенства. 
Пример: Motor=ON; Motor=OFF4567890; показаны ON или OFF45678. 

• Если текст не содержит знака равенства, будут выведены первые (слева) 
8 символов.  
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Отображение и изменение в схеме  
В схеме Вы можете определить, будет ли отображаться идентификатор 
символьной величины или абсолютная величина. В диалоговом окне 
"Customize Layout", Вы можете активировать или деактивировать "Параметр: 
Идентификатор величины " ("Options > Customize > Layout...").  
Если идентификаторы величины определены для входа или выхода, Вы 
можете выбрать их из диалога свойств. Окно "Value" ("Величина") содержит 
дополнительную кнопку для открытия выпадающего списка. Выбранный 
идентификатор величины затем будет показан на входе и выходе. 
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3.5.3 Конфигурирование архивных тегов 

В CFC Вы можете выбрать входы и выходы блока, предназначенные для 
наблюдения и управления оператором (системный атрибут S7_m_c := 'true'), 
для архивирования в WinCC. 

Входы и выходы, обозначенные как предназначенные для архивации, 
создаются как архивные теги в процессе компиляции проекта OS  и, если он 
еще не существует, автоматически создается архив переменных процесса.  
Предпосылки: В мастере "Compile (Multiple) OSs", установлена опция "Archive 
tags" («Архивные теги») и в свойствах OS, установлено "Create/update archive 
tags" («Создавать/обновлять архивные теги»).  

Если на входе или выходе, предназначенном для архивирования, атрибут 
удаляется или изменяется на значение "No archiving", соответствующий 
архивный тег удаляется при следующей компиляции OS. 

Если более нет входов и выходов, предназначенных для архивирования, 
архив переменных процесса удаляется, если он не содержит более архивных 
тегов. 

Вы можете выбрать теги в свойствах объекта для входов и выходов (для 
отдельных входов и выходов) или в таблице "Inputs/Outputs" свойств блока 
(для многих  входов и выходов). 

Последовательность действий 
В выпадающем списке Вы можете выбрать, должен или нет архивироваться 
вход или выход: 

• "No archiving" («Не архивируется») (S7_archive := 'false') 
Вход или выход не архивируется (в любое время). 

• "Archiving" («Архивируется») (S7_archive := 'shortterm') 
Вход или выход архивируется OS или архивным сервером. 

• "Long-term archiving" («Долговременный архив») (S7_archive := 'longterm')  
Переменная архивируется OS или архивным сервером и сохраняется  
вдолговременных архивах на CD, DVD, MOD, ленте ... .  

Системный атрибут S7_archive поддерживается всеми всеми входами и 
выходами, совместимыми с OCM, с типами данных BOOL, BYTE, WORD, 
DWORD, INT, DINT и REAL. 

 
 Замечание 

Если в проекте используется новый тип блока, существующие экземпляры 
блока остаются без изменения в смысле системного атрибута "S7_archive". 
Новые экземпляры типа блока наследуют этот атрибут. 
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3.5.4 Разметка входов и выходов для MIS / MES  

Уровни управления предприятием MIS и MES требуют специфической 
информации от уровня автоматизации. Чтобы быть уверенным, что 
передается только информация, предназначенная для MIS/MES, могут 
создаваться проекты с соответствующим фильтром.  

Системный атрибут "S7_mes := 'true'" используется как фильтр и может быть 
установлен для блоков, а также входов и выходов блоков предназначенных 
для операторского наблюдения и мониторинга (S7_m_c := 'true'). Системные 
атрибуты определяются для типа блока и могут быть изменены у его 
экземпляров. 

Последовательность действий 
• В диалоге "Blocks", на странице "General", Вы можете активировать или 

деактивировать блок в целом для систем MIS/MES выбором в боксе 
"MES-relevant" («Относится к MES»). Опция доступна к изменению только 
при установленной опции "Operator C and M possible" («Возможны 
операторский контроль и мониторинг». 

• Вы можете изменить системный атрибут (S7_mes := 'true')для входов и 
выходов, совместимых с OCM 

- в диалоге "Properties - Block" («Свойства – Блок») на странице 
"Inputs/Outputs" («Входы и выходы») для нескольких входов и выходов  

или 

- в диалоге "Properties - Input/Output" («Свойства – Входы и выходы») 
для отдельных входов и выходов с помощью бокса выбора  
"MES-relevant"(«Относится к MES»). 
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3.6 Соединения  

В схеме CFC, соединение – это соединение между  

• выходом блока или схемы и  

- одним или более входами другого или этого же блока или схемы  

- выходом схемы  

- рабочей группой (только для типа данных BOOL)  

- объектами вне управления данных CFC (например, глобальными 
адресами) 

• входом блока или схемы и  

• выходом другого или того же блока или схемы  

- входом или выходом схемы (в преедлах схемы)  

- объектом вне управления данными CFC (например, глобальные 
адреса)  

• Типы данных входа и выхода должны быть совместимы. Соединяемые 
блоки или схемы могут быть на одном листе, на разных листах той же 
схемы или в разных схемах, относящихся к одному CPU. 

Специальная форма соединения блока – текстовое соединение, когда 
партнер соединения может находиться в разных папках схем или даже еще 
не известен (см. Раздел 3.6.3).  
Вы также можете изменить (перемонтировать), скопировать и удалить эти 
соединения. Отслеживая сигналы (см. 3.6.6) и используя переходы через 
панель листа, Вы можете передвигаться по схеме. 
Вы можете сделать соединения при просмотре в виде отдельного листа и в 
обзорном виде. При обзоре указатель мыши показывает Вам на экране 
подсказки, если Вы медленно наводите курсор на вход или выход. Это 
позволяет Вам идентифицировать требуемый вход или выход и выбрать его 
щелчком мыши. 
Соединения, переходящие от одного листа к другому или от одной схемы к 
другой, легко можно создать, открыв одновременно несколько окон и 
используя режим просмотра листа.  
 

 Замечания: 
• Каждый соединенный вход или выход блока показан на схеме с 

коннектором. Входы, которые не могут быть соединены, так как имеют 
атрибут "S7_link := false", визуально отличаются тем, что у них пропущен 
коннектор.  
Такие входы не могут быть соединены ни с входами и выходами блока, 
ни с вложенной схемой, ни с глобальными адресами. Если, однако, 
схема CFC имеет входы и выходы, можно соединить такие входы с 
входами и выходами той же схемы. 

• Действуют различные правила соединения для входов и выходов блоков 
с типами данных ANY, STRING, STRUCT и DATE_AND_TIME.  
Для информации о правилах соединения, справьтесь в интерактивной 
справке. 
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3.6.1 Соединения с глобальными адресами  

Глобальные адреса это соединения с конечными точками, расположенными 
вне схем CFC. Разные целевые системы имеют разные глобальные адреса 
(например, в глобальным блоках данных, сигналах на входах и выходах, 
меркерах, таймерах, счетчиках). 
Для выбранного входа или выхода, Вы можете отобразить список адресов с 
помощью команды меню "Interconnection to Address" ("Соединение с 
адресом"). Он содержит все символы текущей символьной таблицы, которые 
применимы для этого входа или выхода; другими словами, имеют 
совместимый тип данных. 
Для более подробной информации о возможных соединениях и примеров 
символьных и абсолютных адресов смотрите интерактивную справку 

3.6.2 Соединения с рабочими группами 

Вы можете динамически разрешать и запрещать рабочие группы. Это значит, 
что выходная величина блока определяет, выполняется ли или нет рабочая 
группа. Чтобы добиться этого, соедините бинарный выход блока (тип данных: 
BOOL) с атрибутом разрешения рабочей группы.  

Вставка  
С помощью команды меню "Insert > Interconnection to Run-Time Group" 
(“Вставка > Соединение с рабочей группой”), Вы открываете диалоговое окно 
со списком всех OB CPU и списком соответствующих рабочих групп. После 
выбора нужной рабочей группы (двойной щелчок), соединение вводится в 
интерфейсную панель листа. 

Удаление  
Если Вы удаляете рабочую группу, соединение автоматически будет удалено. 
Атрибут разрешения рабочей группы устанавливается в "1". 

Для того, чтобы удалить рабочую группу, выберите маленькое поле в панели 
листа и нажмите клавишу "Del" («Удалить»). 
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3.6.3 Текстовые соединения  

Текстовые соединения могут находиться только на входе блока или схемы и 
ссылаться на выход блока или схемы CFC. Текстовое соединение остается 
“открытым” и становится “действительным” соединением только при 
замыкании.  

Замкнутые текстовые соединения – это адресация входа с помощью строки 
символов, которые идентифицируют конкретное соединение-источник 
(выход).  

Источник  
Текстовое соединение появляется  

• автоматически, как ссылка пути (вход или выход схемы или блока) с 
путем PH (иерархия предприятия) (если он существует), при копировании 
или перемещении в другую папку схем. При копировании, текстовое 
соединение появляется на входе копии, и при перемещении, как на 
перемещенном объекте, так и на оставшемся объекте, если 
соответствующий выход не остается в той же папке схем. Соединение на 
выходе удаляется, если вход не остается в этой папке схем.  

• когда вводится пользователем на входе (выберите вход и нажмите 
правую кнопку мыши или команду меню «Insert > Textual Interconnection» 
(« Вставка>Текстовое соединение»)  

- как ссылка пути (вход или выход схемы или блока) с путем PH (если 
он существует).  
Соединение немедленно закрывается, если партнер соединения 
находится в этой же папке схем. Если партнер по соединению 
помещается в папку схем позже, соединение можно закрыть, 
используя команду меню "Options > Make Textual Interconnection" 
(“Опции > Выполнить текстовое соединение”). Получаем реальное 
соединение блоков.  

- как запрос соединения (любая строка символов, содержащая 
конкретную ссылку пути, например, комментарий). Этот запрос 
соединения не может быть закрыт (предупреждение вносится в 
протокол) и должен быть соединен пользователем вручную.  

• при централизованном изменении типа, если тип данных соединенных 
входов и выходов не соответствуют друг другу после изменения.  

Пожалуйста, помните, что текстовое соединение не даст результата  

• если источник соединения удален. В этом случае реальное соединение 
удаляется.  

• с внутренним соединением и соединением с входами и выходами схемы, 
когда источник соединения (вложенная схема или блок) удалены или 
перемещены. В таком случае назначение к входам и выходам схемы 
теряется.  

• когда централизованно изменен тип, включая изменение имени с 
изменением интерфейса. Замечание: если изменено имя без изменения 
интерфейса, соединение сохраняется. 
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Отображение в панели листа  
Открытое текстовое соединение (партнер соединения не находится в папке 
схем или ссылка не совпадает с существующим входом или выходом блока):  
В большом поле панели листа Вы видите введенный текст (одна строка).  
В маленьком поле показан идентификатор в виде желтого треугольника. 

При закрытии текстовое соединение преобразуется в реальное, другими 
словами, в обычное соединение блока.  
Идентификатор в маленьком поле (желтый треугольник) исчезает. 

Изменение текстового соединения  
Вы можете изменить текстовое соединение следующим образом:  

• Переключить к другому входу с тем же типом данных.  

• Отредактировать текст в панели листа. Двойным нажатием на большое 
или маленькое поле панели, Вы открываете диалоговое окно для ввода 
нового текста. Предыдущий текст выделен, и его можно переписать. 

• Вы можете заменить тестовое соединение:  

- соединением с глобальным адресом: Выберите вход или текст в 
панели листа, нажмите правую кнопку и выберите "Interconnection to 
Address..." (“Соединить с адресом…”).  

- соединением с входом или выходом схемы: Выберите вход или 
текст в панели листа нажмите правую кнопку и выберите 
"Interconnection to Chart I/O...” («Соединить с входами и выходами 
схемы…”). В диалоговом окне Вы найдете в списке все 
сконфигурированные входы и выходы текущей схемы и их тип (IN, 
OUT, INOUT). 

Замыкание открытых текстовых соединений 
Когда все партнеры текстового соединения находятся в папке схем, Вы 
можете преобразовать его в реальное, замыкая текстовые соединения. Для 
этого есть два пути: 

• С помощью команды меню "Options > Make Textual Interconnection" 
("Опции > Выполнить текстовое соединение "), Вы можете замкнуть все 
текстовые соединения в текущей папке схем.  
Некоторые текстовые соединения не могут быть замкнуты.  

Генерируется протокол всех замкнутых и оставшихся открытыми 
текстовых соединений (Logs > Textual Interconnections tab  (Протоколы > 
Страница текстовых соединений)).  

• Перед компиляцией, если опция "Make Textual Interconnections" 
("Выполнить текстовое соединение ") установлена в диалоговом окне 
"Compile Charts as Program" ("Компиляция схем как программы").  

Если одно или несколько текстовых соединений не могут быть замкнуты, это 
отмечается в протоколе.  

Компиляция продолжается и для входа генерируется подстановочное 
значение (величина по умолчанию для типа блока). Соединение на выходе 
игнорируется.  
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Удаление и поиск текстовых соединений  
С помощью команды меню “Options > Delete Textual Interconnections...”, 
(“Опции > Удалить текстовые соединения...”). Вы открываете диалоговое 
окно со списком всех текстовых соединений.   

В этом диалоговом окне Вы можете выполнить следующее:  

• Получить обзор всех существующих текстовых соединений в текущей 
папке схем. С помощью кнопки "Cancel", Вы выходите из диалогового окна 
без удаления соединения. 

• Используйте кнопку "Go To" («Перейти») для отображения схемы, в 
которой было установлено соединение. Соединение вспыхивает.  

• Выберите текстовое соединение и удалите его из папки схем с помощью 
кнопки "Delete" («Удалить»). Соединение будет немедленно удалено без 
запроса о подтверждении.  

Общая информация: 
• Текстовое соединение может иметь максимум 512 печатных символов.  

• Текстовое соединение может сосуществовать с замкнутым соединением 
или с другим текстовым соединением.  

• Когда текстовое соединение замыкается, действия и сообщения об 
ошибках регистрируются и отображаются в протоколе. Вы можете 
просмотреть протокол в любое время с помощью команды меню "Options 
> Logs > Make Textual Interconnections tab" («Опции > Протоколы > 
Страница «Выполнить текстовое соединение»»). 

• При компиляции открытое текстовое соединение допустимо, а именно, 
генерируется предупреждение и компиляция продолжается так, как 
описано ниже:  

- Вход: Генерируется код и для открытого соединения используется 
величина, определенная по умолчанию для типа блока.  

- Выход: Сгенерированный код игнорирует соединение. 
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3.6.4 Соединение со схемой SFC (CFC в PCS 7)  

Доступ SFC 
Специальная форма соединения – прямой доступ SFC в действиях (actions) 
или переходах (transitions) к входам или выходам (блока или вложенной 
схемы) в схеме CFC. Этот тип доступа SFC может быть "перемонтирован" в 
схеме CFC; другими словами, он может быть перенесен из одного входа или 
выхода на другой с совместимым типом данных. Если вход или выход 
соединен, Вы можете решить, переместить ли только доступ SFC или также и 
соединение. 

• Перемещение только доступа SFC: Удерживая клавишу ALT, 
перетащите выбранный вход или выход на требуемый новый вход или 
выход. Символ доступа SFC переместиться на новый вход или выход; 
существующее соединение не перемещается. 

• Перемещение соединения и доступа SFC: Перетащите выбранный вход 
или выход на новый. Появится сообщение: хотите ли Вы переместить и 
доступ SFC. Если Вы ответили "да", соединение и доступ SFC будут 
перемещены, если Вы ответили "нет", переместится только  соединение.  

• Удаление доступа SFC: Вы не можете удалить доступ SFC в схеме CFC. 
Доступ SFC в схеме CFC показан маркером на входе или выходе блока. 
Доступ для записи и чтения показан по разному. 
Маркер над входом или выходом означает "доступ чтения" и ниже входа или 
выхода - "доступ записи". Цвет маркера такой же, который используется при 
индикации типа данных соединения. 

Ссылки SFC  
Вы можете отобразить ссылки SFC в диалоге "Properties - Inputs/Outputs" 
(«Свойства – Входы/Выходы»). Если входы или выходы включают доступ 
SFC, диалоговое окно содержит кнопку "SFC Access..." («Доступ SFC»), с 
помощью которой Вы можете просмотреть окно со списком ссылок SFC.  

Дважды нажмите на имя в списке схем SFC, чтобы открыть нужную схему, где 
есть объект ссылки. 
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3.6.5 Обработка соединений  

3.6.5.1 Трассировка сигналов  

В случае, когда на листе показано много соединений, Вы можете, тем не 
менее, проследить путь отдельного соединения. 
• Нажмите на линию или большое поле в панели листа, все линии и вводы 

панели, включая страницы переполнения, соединенные с выбранной 
линией, будут выделены вспышкой. Вы можете проследить сигналы по 
ветвям линий и за коннекторами. 

• Начиная от входов и выходов вложенной схемы, сигнал может проходить 
к входам и выходам, которые соединены с ними непосредственно. Нажав 
правую кнопку мыши и выбрав команду меню "Track Signal" (Трассировать 
сигнал), Вы открываете вложенную схему; соединение, включая вводы в 
панели листа, будут выделены вспышками.  
Вы может проследить соединение из вложенной схемы, которое ведет к 
интерфейсу через панель листа, щелкнув правой кнопкой мыши во 
вложенной схеме на входе, выходе или на поле в панели листа и выбрав 
команду контекстного меню "Jump from a Sheet Bar" («Переход от панели 
листа»). Тогда открывается схема более высокого уровня и выделяется 
соответствующий вход или выход вложенной схемы, если он не 
подключен. Если вход или выход схемы подключен, соединение 
подсвечивается вспышками. 

• Чтобы отменить вспышки, просто нажмите на любое свободное место в 
схеме. 

 

3.6.5.2 Переход в панель листа 

Вы можете перейти из ввода в панели листа или страницы переполнения к 
соединенному с ним блоку на другом листе текущей схемы или другой схемы:  

• Если Вы переходите от ввода в панели листа или из входа или выхода с 
простым соединением, переход выполняется немедленно. 

Появляются лист или схема, в которой находятся подключенные блок или 
вложенная схема. Открыта схема, в которой распложены соединяемый 
блок или вложенная схема. Для соединений блоков и соединенных 
входов и выходов схемы активируется отслеживаемый сигнал 
(вспыхивает линия), для неподключенных входов и выходов вложенной 
схемы, выбирается соответствующий вход или выход схемы.  

Если переход выполняется в перекрывающийся блок, блок сдвигается в 
центр экрана и выделяется. Так как вход или выход и линии соединения 
не могут быть показаны, трассировка сигнала в этом случае невозможна.  

• Если Вы переходите от выхода панели листа, который имеет более чем 
одно соединение, откроется диалог со списком всех соединений этого 
выхода. Переход выполняется, когда Вы дважды щелкните по нужному 
входу или выходу (или выберите его и нажмете "OK").  

• С помощью команды меню "Edit > Go To > Jump Back" ("Редактировать > 
Перейти > Вернуться"), Вы вернетесь в точке, с которой Вы начали 
переход, даже если Вы закрыли выбранную схему или удалили блок.  
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3.6.5.3 Копирование соединений  

Для того, чтобы копировать соединение, выберите вход соединения и, 
удерживая клавишу Ctrl, перетащите мышью его к нужному входу (того же 
типа). Когда Вы достигните нужного входа, сначала отпустите кнопку мыши и 
только затем клавишу Ctrl. Будет создано дополнительное соединение. 

Копирование таким образом очень удобно, когда источник сигнала 
находитсяв другой схеме, так как Вам не нужно повторно его находить. 

3.6.5.4 Изменение соединения (перемонтаж)  

Вы можете переместить существующие соединения из одного входа в другой 
или из одного выхода в другой.   

• Вход: 

Позиционируйте указатель на входе, Если Вы хотите переместить 
соединение на другой вход и удерживайте кнопку мыши. Затем 
перетащите указатель мыши к другому входу (того же типа) и отпустите 
кнопку. Линия соединения перечертится.  

• Выход: 

- Если у Вас множество соединений, все они будут переключены к 
новому выходу.. 

- Если Вы перетащили соединение с адресом к выходу, который уже 
соединен с этим адресом, появится предупреждение. Вы можете 
решить, сохранить соединение с исходным блоком или удалить его.  

Если Вы хотите перемонтировать соединение, имеющее также доступ к схеме 
SFC, появится запрос, хотите ли Вы переместить и доступ SFC.  
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3.6.5.5 Удаление соединений  

Вы можете удалить соединение следующим образом: 

• Многократное соединение: 

- Если Вы хотите удалить все соединения выхода, выберите выход 
или линию (линии) соединения и команду меню "Edit > Delete" 
("Редактировать > Удалить") или нажмите клавишу DEL.  

- Если Вы хотите удалить одно из нескольких соединений выхода, 
выберите вход и нажмите клавишу DEL 
или 
установите курсор на вводе панели листа и нажмите правую кнопку 
мыши. Выделится маленькое поле перед вводом панели листа. 
Выберите "Delete Interconnection(s)" (“Удалить соединение(я)”) в 
контекстном меню и соединение с входом будет  удалено. Вы можете, 
конечно, нажать на маленькое поле в панель листа напрямую и 
удалить соответствующее соединение с помощью DEL или "Edit > 
Delete" («Редактировать > Удалить»). 

• Однократное соединение: 

Вы можете выбрать выход, вход или линию соединения и удалить 
соединение с помощью команды меню "Edit > Delete" или клавиши DEL.  

• Текстовое соединение: 

- В схеме Вы можете удалить отдельные текстовые соединения, точно 
так же, как простые соединения (см. выше). 

- Командой меню Options > Delete textual interconnections (Опции  > 
Удалить текстовые соединения) Вы открываете диалог. Диалог 
содержит таблицу с текстовыми соединениями всех схем текущей 
папки.  
В колонке "Chart" («Схема») выберите соединения, которые более е 
требуются (возможны и множественные соединения) и нажмите 
кнопку "Delete" («Удалить»). 

Замечание: Доступ SFC не может быть удален в схеме CFC.  
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3.6.6 Структуры  

Использование структур позволяет поместить любые данные в древовидную 
структуру и затем применять их в входах и выходах блока. При отображении 
блока структура имеет имя входа или выхода и тип; тип обозначается "ST".  
Структура состоит из нескольких элементов (с глубиной вложенности до 8 
уровней): 

• Элементарный тип данных (BOOL, WORD, .. )  

• Структура  
Элементы структуры содержат следующую информацию: 

• Тип (элементарный тип данных или "ST")  

• Имя  

• Величина (только для элементарного типа данных)  

Соединение  
Структурный вход или выход блока может быть соединен только с другой 
структурой, но не с  элементарным типом данных. Соединяемые структуры, 
должны быть совместимы, другими словами, порядок, тип данных и имена 
элементов элементарных типов данных должны быть идентичны. Имя 
структуры может отличаться. 
Элементы из структуры не могут соединяться отдельно, только вход или 
выход блока может быть соединен как целая структура. 

Для более подробной информации обратитесь к интерактивной справке. 

Соединения с глобальными адресами 
Вход или выход блока со структурой не может быть соединен с глобальным 
адресом, который ссылается на целый блок данных (DBx); соединение со 
структурой на первом уровне DB возможно (DBx.name_st). Аналогично, 
соединение элементарны типов данных возможно только с элементарными 
типами данных на первом уровне DB (DBx.element) 
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Редактирование элементов структуры  
Вы можете отобразить свойства объекта, структуры или элементарного типа 
данных в структуре и отредактировать ее (назначить параметры).  

Дважды щелкните на входе или выходе блока для того, чтобы показался 
диалог "Select Structure Element" (“Выбор элемента структуры”). В 
появившейся структуре выберите элемент для редактирования и откройте 
диалог свойств кнопкой "Properties" (или дважды щелкните на элементе). 
Диалоговое окно доступно в режимах редактирования и тестирования.  

Если Вы хотите отладить структуру в режиме тестирования, Вы можете 
включить отдельный элемент структуры в динамический просмотр, открыв  
диалоговое окно "Select Structure Element" (“Выбор элемента структуры”) 
(контекстное меню "Include in Dynamic Display" (“Включить в Динамический 
Просмотр”)).  

Замечание: 
• В структуре системные атрибуты "operator control and monitoring" 

(“операторское управление и мониторинг”) или "message" (“сообщение”) 
не должны использоваться ни в одной точке.  

• Вход или выход блока со структурой не может быть соединен с 
глобальным адресом, который ссылается на целый блок данных (DBx); 
соединение со структурой на первом уровне DB возможно (DBx.name_st).  

• Структура не может быть отредактирована в SFC. 
Вход или выход блока со структурой не может быть соединен с глобальным 
адресом, который обращается к блоку данных в целом (DBx); соединения со 
структурой внутри DB возможны (DBx.name_st). 
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3.7 Глобальные объявления 

Вы можете хранить в проекте глобальные объявления, которые можно 
использовать в различных приложениях. Этими глобальными объявлениями 
могут быть, например, перечисления и единицы измерения. Это гарантирует, 
что атрибуты с этими же именами используются повсюду в проекте,  

Вы используете enumerations (перечисления) для входов и выходов блока и 
ли схемы, которые имеют системный атрибут "S7_enum". Независимо от 
текущего значения системного атрибута (величина соответствует объектному 
имени перечисления), Вы можете использовать любое имя объекта из 
перечислений, которые которые существуют в проекте. Эти перечисления 
доступны в выпадающих спсиках в свойствах входов и выходов. 

Перечисления допустимы для входов и выходов логических и целых типов 
типов: BOOL, BYTE, INT, DINT, WORD, DWORD. 

 
 Замечание 

Если системный атрибут "S7_string_0" ... "S7_string_25" и системный атрибут 
"S7_enum" назначены на входе или выходе, как идентификатор величины 
используется только перечисление (системный атрибут "S7_enum"). 

Проектирование 
В компонентном представлении SIMATIC Manager непосредственно под 
уровнем проекта Вы создаете "Shared declarations" («Глобальные 
объявления»). Командой контекстного меню Insert new object > Shared 
declarations (Вставить > Глобальные объявления) Вы вставляете в проект 
папку с подпапками "Enumerations" («Перечисления») и "Units" («Единицы 
измерения»).  

Вы можете удалить, скопировать, переместить и создать эти папки отдельно. 
Папка "Shared declarations" («Глобальные объявления») может содержать 
более одной папки одного типа. 

При выбранной папке "Shared Declarations" («Глобальные объявления») кон-
текстное меню "Insert new object" («Вставить новый объект») предусматрива-
ет пункты "Enumerations" («Перечисления»), "Enumeration" («Перечисление»), 
"Units" («Единицы измерения») и "Unit" («Единица измерения»). 

Вы также можете вставить объект "Enumeration" («Перечисление») или "Unit" 
(«Единица измерения»), если не существует папок "Enumerations" 
(«Перечисления») или "Units" («Единицы измерения»); в этом случае они 
создаются автоматически в данный момент времени. 

Когда Вы вставляете папки "Enumerations" («Перечисления») или "Units" 
(«Единицы измерения»), существующие папки этого типа перекрываются, 
если Вы подтвердите появляющийся запрос. Они также перекрываются, если 
Вы переименовали существующую папку ранее.   

Папка "Units" («Единицы измерения») уже содержит список единиц 
измерения, установленных с CFC. Вы можете расширить или 
модифицировать его, если это необходимо. Папка "Enumerations" 
(«Перечисления») изначально не содержит готовых перечислений. Вы 
должны самостоятельно вставить или объявить перечисления и их величины 
вручную. 
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3.7.1 Проектирование перечислений 

Вставка перечисления 
Вы можете создать новое перечисление при выделенной папке "Shared 
declarations" или "Enumerations", используя  команду контекстного меню Insert 
new object > Enumeration (Вставить новый объект > Перечисление). 

Вы может изменить имя объекта и отображаемое имя в свойствах 
перечисления.  

Вы можете определить object name (имя объекта) перечисления, так чтобы 
оно соответствовало значению системного атрибута "S7_enum" входов и 
выходов блока, для которых предполагается использовать это перечисление. 

  
 Замечание 

В свойствах входов и выходов блока (или при представлении process object), 
поле "Enumeration" («Перечисление») активно, если входу или выходу 
присвоен системный атрибут "S7_enum". Это не зависит от того, 
соответствует ли значение системного атрибута существующему имени 
перечисления в проекте. Вы можете присвоить требуемое перечисление 
входу или выходу в любой момент используя выпадающий список. 

 

Отображаемое имя (display name) перечисления может быть переведено на 
различные языки и передано в WinCC при компиляции OS. 

Когда Вы создаете перечисление автоматически, как вариант, вводится "0.1". 
Вы можете изменить это через свойства перечисления. 

Вы можете присвоить любое число величин перечислению. (Для 
перечислений, которые будут использоваться для входов и выходов типа  
BOOL, применимы только две величины.) 

Вставка величин 
Вы создаете новую величину командой контекстного менню Insert new object 
> Value (Вставить новый объект > Величина). 

Первая величина для ввода содержит численное значение 0; это число 
инкрементируется при с каждым дальнейшим добавлении. 

Отображение имени величины можно увидеть в свойствах входов и выходов 
блока в разделе "Value" («Величина»). Каждая существующая величина 
перечисления может быть выбрана здесь из выпадающего списка. 

Вы можете маркировать перечисления для использования в SIMATIC BATCH 
для управляющих стратерий (Properties Enumeration (Свойства 
перечисления), страница "General", опция "Control strategy" («Управляющая 
стратегия»)). Если Вы выбираете эту опцию, символ для перечисления и 
величина изменяют свое отображение. 
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3.7.2 Проектирование единиц измерений 

Вы можете создать новую единицу измерений, выделив папку "Units" 
(«Единицы измерения»), используя команду контекстного меню Insert new 
object > Unit (Вставить новый объект > Единица измерения). 

Если Вы желаете отменить изменения в единицах измеренения или удалить 
добавленные единицы, Вы можете снова вставить папку "Units" («Единицы 
измерения»). Содержание существующей папки при этом переписывается 
базовым набором, принятым в CFC. 

Имя объекта это текст, который отображается как единица измерений. Через 
свойства объекта Вы можете изменить имя, версию, автора и комментарий. 
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3.8 Свойства выполнения блоков  

Свойства выполнения блоков определяют, как блок будет включен в 
последовательность выполнения в пределах CPU. Эти свойства имеют 
значение для поведения целевой системы в смысле времени реакции, 
времени запаздывания или устойчивости структур, зависящих от времени, 
например, систем с обратной связью. 

При вставке каждому блоку, по умолчанию, присваиваются рабочие свойства, 
путем их установки в последовательности выполнения задач (смотрите 
также: Изменение последовательности выполнения, Раздел 3.8.2). При 
необходимости блоки также можно установить в рабочую группу, которая в 
свою очередь устанавливаются в последовательность выполнения задач. 

Замечание: Когда Вы создаете новую схему, автоматически создается 
рабочая группа, в которую устанавливаются все блоки этой схемы. 

Рабочая группа используется для структурирования или организации задач. 
Блоки последовательно устанавливаются в рабочую группу, которой в 
диалоге свойств объекта можно давать атрибуты "scan rate" ("отношение 
циклов") и "phase offset" ("смещение по фазе").  
Каждый блок должен быть установлен в последовательности выполнения, по 
крайней мере, однажды. Блок можно установить в несколько задач, но только 
один раз в одну задачу. 

Отображение рабочих свойств 

Существует несколько путей отображения рабочих свойств; или для 
отдельного блока или для целого CPU.  

Простой блок  
Рабочие свойства каждого блока показаны в заголовке блока на выделенном 
цветом фоне.  

AND 
TE_EN 

OB 33
2 / 3

Имя задания 

Положение рабочей группы в задании или 
положение блока в задании 

Положение блока в рабочей группе 
(для блока в задании, здесь показано - 3) 

Поле рабочих свойств

 

В CFC блоки, которые не выполняются, выделены цветом (Идентификация: 
Красное поле с желтым восклицательным знаком). Она располагаются в поле 
последовательности выполнения в левом верхнем углу. 

Для более подробной информации смотрите интерактивную справку, раздел 
"Display of block execution" ("Отображение выполнения блока"). 
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CPU в целом 
Вы можете получить полный обзор последовательности выполнения 
следующим образом:  

• Двойным щелчком в окне рабочих свойств в заголовке блока. Запускается 
редактор последовательности выполнения и в окне последовательности 
выполнения открывается задача, в которой установлен блок (первый 
указатель установки). Соответствующий блок будет выделен.  

• Выбором команды меню "Edit > Run Sequence..." ("Редактор > 

Последовательность выполнения...") или нажав кнопку .  
Запустится редактор последовательности выполнения и появится окно с 
рабочей последовательностью. Если блок выбран, откроется задача, в 
которой установлен блок (указатель первой установки) в 
последовательности выполнения. Соответствующий блок будет выделен. 
В этом окне Вы можете редактировать последовательность выполнения 
CPU. (см. раздел 3.8.2).  

• Выбрав команду меню "Options > Chart Reference Data..." ("Опции > 

Справочные данные схемы...") или кнопку .  
Запустится отдельное приложение со своим собственным окном, меню 
команд и панелью инструментов.  
В обзоре "Последовательность выполнения" (активируется командой 
"View > Run Sequence" («Вид > Последовательность выполнения») или 

кнопкой ) показана полностью последовательность выполнения 
текущего CPU (блоки с информацией о типе блока и комментариями). 
Откроются задачи, в которых установлены объекты. Обзор 
последовательности выполнения Вы можете распечатать в виде списка. 
В этом окне нельзя редактировать последовательность выполнения.  
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3.8.1 Модель последовательности CFC  

Понятие модели последовательности  
Модель последовательности позволяет структурировать порядок выполнения 
схемы; другими словами, блоки схемы устанавливаются один за другим в 
порядке их выполнения. Указатель установки определяет следующую точку 
вставки в последовательность выполнения. Это указатель установки, как 
схемы, так и блока.  

В программе S7, есть один (глобальный) указатель установки для схемы и 
один локальный указатель блоков для каждой схемы.  

Вместе с рабочей группой, создаваемой автоматически для каждой схемы, 
концепция указателя установки обеспечивает лучшую ориентацию в схеме. 
Главным образом, это позволяет блокам схемы обрабатываться как группы, 
при разделении и слиянии проекта в многопользовательской разработке. Это 
позволяет Вам работать на основе технологии схема-в-схеме и определять 
последовательность выполнения блоков независимо от порядка их 
выполнения в других схемах.  

Если указатель установки не изменяется пользователем, установка 
происходит таким образом:  

• Новые схемы устанавливаются после существующих  

• Блоки устанавливаются внутри схемы непосредственно один за другим. 

Другие преимущества:   

• При основанной на схемах многопользовательской разработке другой 
разработчик не может случайно переместить указатель установки.  

• Когда изменяется только одна схема, Вам не нужно компилировать и 
загружать весь OB, а только рабочую группу изменяемой схемы.  

• Использование CPU можно организовать на основе технологии «схема-в-
схеме», поскольку выполнение отдельных схем в CPU может 
активироваться и деактивироваться (даже в режиме тестирования) без 
внешнего запроса контроллера (например SFC). 

Указатель установки схемы  
Каждая программа имеет свой глобальный "указатель установки схемы". Он 
определяет  

• OB, в котором будет установлена рабочая группа следующей схемы.  

• Позицию, определяющую, после какой рабочей группы (или после какого 
блока на уровне OB) будет устанавливаться рабочая группа следующей  
создаваемой схемы. Если OB еще не содержит рабочую группу, эта 
позиция "пустая"; другими словами, указывает на сам OB. 

По умолчанию указатель установки схемы OB35. Указатель установки схемы 
настраивается только в редакторе последовательности выполнения (не в 
Редакторе CFC). 
Позиция предшественника для установки выделяется светло-зеленым цветом 
в последовательности выполнения. 



Работа с Редактором CFC 

 CFC для S7 
3-42 A5E00345244-01 

Смотрите также "Настройка указателя установки" в Разделе 3.8.2.  

Указатель установки блока  
Каждая схема CFC (включая вложенные) имеет свой "указатель установки 
блока". Он определяет   

• OB, в котором будет установлен следующий блок. 

• позицию в последовательности выполнения, после которой установится 
следующий блок. Позиция блока однозначно связана с номером OB.  

Если схема пустая, указатель установки блока "не определен"; в строке 
состояния, вместо него показан указатель установки схемы. Когда 
устанавливается первый блок, используется текущий указатель установки 
схемы. 

Указатель установки блока устанавливается только в Редакторе CFC (не в 
редакторе последовательности выполнения). По умолчанию (после создания 
новой схемы), он устанавливается в начало автоматически создаваемой 
рабочей группы.  

Предшественник для установки отличается от остальных блоков схемы 
цветом. Поле для свойств времени выполнения в заголовке блока отличается 
светло зеленым фоном.  

Смотрите также "Настройка указателей установки" в Разделе 3.8.2  
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3.8.2 Изменение последовательности выполнения и указателя 
установки  

Запуск рабочего редактора  
С помощью команды меню "Edit > Run Sequence..." ("Редактировать > 

Последовательность выполнения...") или нажав иконку  на панели 
инструментов, Вы открываете широкое окно с окном иерархии слева и с 
окном подробностей справа. Эта структура похожа на Windows Explorer и 
работает аналогично.  

Перемещение объектов  
Вы можете переместить объект (схему, рабочую группу или блок), выделив 
его (в правом или левом окне) и перетащив его на объект, после которого Вы 
хотите установить его. 

Если Вы перетаскиваете объект на рабочую группу, 

• объект устанавливается в первую позицию внутри рабочей группы, если 
структура раскрыта [-]. 

• объект устанавливается после рабочей группы, если структура не 
раскрыта [+]. 

• и, если рабочая группа пустая: Вы получите запрос, хотите ли Вы или нет 
установить блок внутри рабочей группы. Если Вы ответили “да”, объект 
будет установлен внутрь, если Вы ответили “нет”, он встанет после 
рабочей группы. 

Если Вы перетащили объект на блок/схему внутри рабочей группы, объект 
будет вставлен после этого блока/схемы.  

Если Вы перетащили объект на задачу, он вставляется перед 
существующими объектами. 

 
 Замечание 

При перемещении блоков, убедитесь, что все блоки схемы находятся только 
в соответствующей рабочей группе. После перемещения блока в другую 
рабочую группу, ориентированная на схему структура более не существует и 
будет сложнее или вообще невозможна работа на основе схема-в-схеме при 
многопользовательской разработке. 

Удаление блока  
Вы можете удалять блоки из задач только тогда, когда они установлены 
более чем одного раза в последовательности выполнения. Блок должен 
оставаться в последовательности выполнения, по крайней мере, однократно.  

Если блок установлен только раз, Вы не можете удалить его. Если он 
повторяется в последовательности выполнения несколько раз, блок будет 
удален и последовательность выполнения блоков после этой позиции 
обновится.  
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Установка блоков  
Вы можете установить блоки и рабочие группы несколько раз в различные 
задачи, используя Copy (Копировать) и Paste (Вставить). Схемы SFC нельзя 
установить больше одного раза в циклические задачи. Вы используете 
соответствующие команды меню или кнопки на панели инструментов или 
перетаскиваете объекты, удерживая клавишу CTRL (см. также: перемещение 
объектов). 

Вы также можете установить блоки, перетащив их напрямую из схемы CFC в 
требуемое место в последовательности выполнения (когда оба окна 
показаны одновременно). 

 Замечание  
Объекты с системным идентификатором "@" устанавливаются в 
последовательности выполнения автоматически, когда генерируются блоки 
драйверов и могут редактироваться только функциями SIMATIC Manager 
"Options > Charts > Generate Module Drivers..."("Опции > Схемы > 
Генерировать Драйверы модуля..."; другими словами, их нельзя переместить 
или удалить вручную.  

Настройка указателей установки  
Вы можете изменить указатели установки следующим образом: 

• Указатель установки схемы (по умолчанию OB35)  
Для того, чтобы изменить указатель установки схемы, откройте редактор 
последовательности выполнения и выберите нужный OB, или блок на 
уровне OB (не внутри рабочей группы), или рабочую группу внутри OB.  
В редакторе последовательности выполнения выберите команду меню 
"Edit > Predecessor for Installation" ("Редактировать > Предшественник для 
установки").  

Позиция предшественника для установки отмечена в последовательности 
выполнения светло-зеленым цветом. 

• Указатель установки блока  
Вы не можете установить указатель установки блока в редакторе 
последовательности выполнения. Для того чтобы изменить указатель 
установки блока, откройте Редактор CFC и выберите блок, после 
которого будут вставляться все следующие блоки.  
В схеме выберите команду меню "Edit > Predecessor for Installation" 
("Редактировать > Предшественник для установки"). 

• Если Вы вставляете другой блок в схему, указатель установки 
переносится на этот блок; другими словами, он становится новым 
«предшественником». Прямоугольник для свойств времени выполнения в 
заголовке блока выделяется черным шрифтом и светло-зеленым фоном. 

Если блок, выбранный как предшественник установки, удален, указатель 
установки блока уменьшится, другими словами, начнет установку с блока, 
размещенного перед удаляемым. Это применимо и к случаю, когда блок 
перемещается в другую схему. Указатель установки блоков в целевой 
схеме не изменяется. Перемещенный блок сохраняет позицию установки, 
которая была в предыдущей схеме.  

Для более подробной информации о работе с редактором 
последовательности выполнения смотрите интерактивную справку. 
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3.8.3 Рабочие группы 

Применение  

Рабочие группы  необязательны, но они создаются автоматически при 
создании новой схемы. Они используются для структурирования заданий 
(OB). Блоки последовательно устанавливаются в рабочие группы. 
С помощью рабочих групп Вы можете проделать следующее: 

• Удалить или отсоединить выбранные блоки для выполнения на AS.  

• Выполнить выбранные блоки с заданным коэффициентом сканирования 
(каждый n-й цикл) и/или со смещением периода для того, чтобы лучше 
сбалансировать загрузку CPU.  

• Если OB содержит большое количество установленных блоков, они могут 
быть вместе помещены в компактный модуль. 

Преимущество: Вместо создания одной “большой” FC, когда Вы 
компилируете каждый OB, создаются "маленькие" FC в зависимости от 
числа рабочих групп. 

Если программа изменена, только рабочие группы и FC, содержащие 
изменения, имеют идентификатор "измененный". Это означает, что 
последующая компиляция и загрузка изменений займет меньше времени.  

• Когда выполняется разделение и слияние проекта для многопользова-
тельской разработки, это позволяет обрабатывать блоки схемы как 
группы. Это позволяет Вам работать на основе технологии схема-в-схеме 
и определять последовательность выполнения блока, не считаясь с 
рабочей последовательностью в других схемах.  

Как создать рабочую группу? 
Рабочая группа создается двумя способами: 

• Автоматически  

Когда Вы создаете новую схему, новая рабочая группа автоматически 
создается и устанавливается в последовательность выполнения согласно 
указателю установки схемы. Эта автоматически созданная рабочая 
группа имеет отличные свойства от рабочих групп, созданных вручную:  

Автоматически созданная рабочая группа и схема имеют определенную 
зависимость, которая сохраняется,  пока не будет изменено имя рабочей 
группы. 

Эта зависимость означает, что имя рабочей группы идентично имени 
схемы и, если схема переименовывается, название рабочей группы 
автоматически меняется. 

Если эта зависимость более не действует (поскольку в рабочей группе 
выполнены изменения) автоматически сгенерированная рабочая группа 
ведет себя далее так же, как и рабочая группа, вставленная вручную. 
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• Вручную  

Вы можете создать рабочую группу вручную в любое время (создав новые 
группы с помощью команды меню или скопировав существующие группы). 
Если Вы копируете рабочую группу и вставляете ее в последователь-
ность выполнения, к имени добавляется следующий номер (без скобок).  
Вы создаете рабочую группу выбрав в левом окне задачу, в которую 
будет вставлена рабочая группа, или объект,  после которого вставляется 
рабочая группа. С помощью команды меню "Insert > Run-Time Group..." 
("Вставить > Рабочая группа..."), Вы запускаете диалог "Insert Run-Time 
Group" ("Вставить рабочую группу”), в котором Вы можете задать свойства 
рабочей группы. 

Редактирование и удаление рабочих групп  
Вы можете отредактировать свойства рабочей группы позже. 

Для редактирования выберите рабочую группу (в левом или правом окне) и 
затем команду меню "Edit > Object Properties..." ("Редактировать > Свойства 
объекта..."). 
В диалоговом окне "Properties - Run-time Group" ("Свойства – Рабочая 
группа") Вы можете изменить существующие значения (имя, комментарий, 
смещение по фазе, отношение циклов).  

Опции "Optimization of the run sequence" ("Оптимизация рабочей 
последовательности") (см. Раздел 3.8.4) и "Active" "Активировать” 
установятся по умолчанию. С помощью "Active" рабочая группа активируется 
для работы в режиме тестирования (установка опции) или деактивируется 
(отмена опции). Замечание: в F-системе опция всегда установлена и не 
может изменяться. 
Вы можете удалить рабочую группу только, когда она не содержит объектов. 
Для того, чтобы удалить рабочую группу, выделите ее и затем выберите 
команду меню "Edit > Delete" ("Редактировать > Удалить") или нажмите 
клавишу DEL. 
Командой меню Edit > Delete empty runtime groups (Редактировать > 
Удалить пустые рабочие группы) Вы можете удалить пустые рабочие группы 
текущей программы S7 после подтверждения в возникающем запросе. 
Если удаляемая рабочая группа была выбрана  предшественником для 
установки, позиция для установки по умолчанию перемещается на элемент 
задачи перед удаляемой группой, или, если такого элемента не существует, 
на начало задачи. 
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3.8.4 Оптимизация последовательности выполнения  

Эта функция оптимизирует последовательность выполнения программы в 
соответствии с потоком данных так, как это возможно       по времени 
задержки на CPU при выполнении программы. Различается оптимизация для 
OB (задач) и рабочих групп.  

Вы начинаете оптимизацию в рабочей группе, используя команду меню 
Options > Optimize Run Sequence (Опции > Оптимизация 
последовательности выполнения) 

Что происходит во время оптимизации? 
Это делается отдельно для каждой задачи. В пределах задачи рабочие 
группы обрабатываются дополнительно вместе с заданием. Отношение 
циклов и смещение по фазе рабочих групп игнорируются.  

Поток данных получается из соединений. Он включает все соединения блока 
с блоком, а так же схемами SFC и соединения выходов блоков с ENABLE 
рабочих групп. Глобальные и текстовые соединения в расчет не берутся. 
Соединения с интерфейсом схемы прослеживается вплоть до 
действительного источника соединения. Если этот источник не существует; 
другими словами, соединение заканчивается на интерфейсе, соединение 
игнорируется. Соединения с блоками в других задачах также игнорируются, 
как и их доступ из схемы SFC к входу или выходу блока.  

Соединения внутри или вне рабочей группы считаются соединениями самой 
рабочей группы, другими словами, рабочая группа формирует фиктивный 
блок на уровне задания. Соединения между блоками рабочей группы 
используются только для оптимизации в пределах рабочей группы. Это 
гарантирует, что рабочая группа правильно организована и что рабочая 
группа сама размещается в оптимальной позиции задачи.  

Последовательная оптимизация выполняется так, что нет излишних 
изменений и пределы изменений ограничены, насколько это возможно, когда  
изменения компилируются и загружаются.  

Замечание: 
Поток данных может быть реверсирован, если блоки подключаются через 
вход-выходной параметр; другими словами, от входа к выходу. Это не может 
быть принято во внимание при оптимизации последовательности 
выполнения. В этом случае Вы должны оптимизировать последовательность 
выполнения самостоятельно и исключить соответствующие рабочие группы 
из оптимизации. 
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3.9 Создание драйверов модулей 

Для обработки сигналов в PCS 7, имеется возможность автоматической 
генерации и соединения драйверов модулей после того, как Вы создали 
аппаратную конфигурацию с помощью HW Config и сконфигурировали 
технологические функции в CFC. Эта возможность известна как "генерация 
драйверов" в ES и может использоваться таким образом:  

• Вы можете установить опцию в диалоговом окне CFC "Compile Charts as 
Program" ("Компиляция схем как программ"). Драйверы модулей будут 
генерироваться перед компиляцией. 

• Выбрав папку схем, Вы можете активировать функцию в SIMATIC 
Manager с помощью команды меню "Options > Charts > Generate Module 
Drivers...” ("Опции > Схемы > Генерировать драйверы модулей...").  

Драйверы и сообщения, описанные здесь, могут использоваться только для 
CPU S7-400. 
 

 Замечание 
Если адресное пространство для цифровых входных и выходных модулей 
сжато утилитой HW Config ("Pack Addresses" (“Сжатие адресов»)), генератор 
драйверов не сможет поддерживать соответствующие блоки с уникальными 
адресами. Чтобы гарантировать, что имеется определенное назначение 
слота для каждого подмодуля, нельзя использовать сжатие адресов. 

3.9.1 Концепция драйвера и сообщения 

Для этой функции используются типы блоков, имеющие эффект разделения 
аппаратной и программной конфигурации: 

• Канальные блоки вставлены в схему и соединены пользователем с 
соответствующим именем сигнала из символьной таблицы. Эти блоки, 
используемые для первичной обработки сигналов, являются частью 
технологической функции и всегда обрабатываются вместе с ней. 

Следующие типы блоков применяются для первичной обработки сигнала:  

- Стандартные канальные блоки: 

CH_AI, CH_AO, CH_DI, CH_DO, CH_CNT, CH_CNT1 и CH_MS. 
Используются только для обработки сигналов сигнальных модулей 
S7-300/400. Они используются, когда надо оптимизировать память и 
последовательность выполнения, и не нужна обработка устройств PA.  

- Универсальные канальные блоки: 

CH_U_AI, CH_U_AO, CH_U_DI, CH_U_DO. Эти блоки используются 
для обработки сигналов сигнальных модулей S7-300/400 или полевых 
устройств PA. Преимуществом является то, что Вы можете создавать 
схемы CFC независимо от модулей, которые можно определить 
позже. Однако универсальные блоки требуют больше памяти и 
дольше выполняются.  
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- Канальные блоки PA: 

PA_AI, PA_AO, PA_DI, PA_DO, PA_TOT. Эти блоки предназначены 
специально для полевых устройств PA. Они используются, когда 
требуются специфические свойства этих устройств. В отличие от 
блоков CH, обрабатывается не только сами сигналы, но и все 
переменные, согласно выбранной конфигурации устройств в 
определенной аппаратной конфигурации. 

• Блоки для диагностики и мониторинга входных и выходных модулей, 
полевых устройств, связи и для сигнализации и отображения событий и 
состояния CPU генерируются автоматически системой (вставка в 
системную схему из библиотеки блока генератором драйвера), с 
назначением величин параметров и подключением. 

Для более подробной информации о возможностях, функционировании и 
сообщениях блоков CH, смотрите контекстную помощь (F1) для блока. 

Использование и выбор  
Начиная с версии CFC V5.2 + SP1, используется расширенная концепция 
драйвера, в которой управление генерацией драйверов работает с системой 
метазнаний. Генератор драйвера может работать согласно предыдущей и 
расширенной концепции. Какая концепция используется в существующем 
проекте, зависит от используемых блоков обработки сигнала (блоки CH). 
Генератор драйвера ищет типы импортируемых блоков и проверяет версии 
блоков CH. 

Концепция расширенного драйвера  
С концепцией расширенного драйвера, которую поддерживает большинство 
модулей для устройств ET200M, ET200S, ET200iS, ET200X, PA, связи DP/PA, 
DP/PA-Link, Y-Link, DP V0- / DP V1 Slave, диагностические повторители, 
полевые устройства HART (диагностика) возможны и резервирование 
входных и выходных модулей, выпускаемых для PCS 7, и точное 
определение канальных ошибок в сообщениях. Возможна настройка данных 
конфигурации из SIMATIC PDM.  
С новой моделью иерархичного соединения блоков драйверов вместе с 
новыми блоками OB_BEGIN и OB_END для диагностики на CPU и соединения 
(вместо MSG_CSF), достигается оптимизация последовательности 
выполнения. 

При расширеннии аппаратной конфигурации, которое требует собственной 
концепции диагностики и сообщений и собственных блоков обработки, 
система метазнаний также должна быть расширена в форме XML файлов. В 
то же время, существующие файлы XML не должны быть изменены. 

Базовый набор файлов XML (список объектов и список действий) 
поддерживается вместе с Библиотекой PCS 7 и инсталлируется с помощью 
Setup. Соответствующие папки "Object" ("Объект") и "Action" ("Действие") 
находятся в: ...Siemens\Step7\S7data\driver\... 
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3.9.2 Модель сессии для "Генерации драйверов модулей " 

• Пользователь конфигурирует аппаратное обеспечение с символьным 
именем сигналов на входах и выходах. Имя сигналов вводится в таблицу 
символов непосредственно в HW Config (выбрать модуль, команда меню 
в HW Config: "Edit > Symbols..." (“Редактировать > Символы»)).  

• Пользователь конфигурирует технологические функции в CFC. Здесь 
блоки CH_ blocks (или PA_ blocks) используются и соединяются с 
именами сигналов из символьной таблицы ("Insert > Interconnection to 
Address..." (“Вставка>Соединение с адресом»)).  

• Пользователь запускает генератор драйверов, который создает, 
соединяет и назначает параметры всем драйверам модулей в SIMATIC 
Manager с помощью команды меню "Options > Charts > Generate Module 
Drivers..."  (“Опции>Схемы> Генерировать драйверы модулей»). 
Следующие фазы выполняются автоматически: 

- Определяются все канальные блоки (_AI, _AO, _DI, _DO), 
используемые в схеме CFC. Затем обнаруживаются все входы и 
выходы (например, величины, O_SP, I_OUT_D, ...), которые 
соединяются с символами входных и выходных каналов, 
сконфигурированными в HW Config. Для блоков PA_AO-/PA_DO 
возможны и другие символы, необходимые для соединения. Здесь 
для соединения необходим только "начальный" символ, другие 
определяются и соединяются автоматически функцией "Generate 
Module Drivers"  (“Генерировать драйверы модулей”). Используя 
адреса символов в символьной таблице, соответствующий модуль и 
канал модуля определяется из данных аппаратной конфигурации. На 
основе типа модуля, используется соответствующий тип блока 
диагностики (MOD или PADP) и затем создается экземпляр блока в 
системной схеме для каждого входного и выходного модуля.  

- Параметры, необходимые для блоков диагностики, получаются из 
данных HW Config и вводятся в экземпляры блока (также в блок 
SUBNET для оптимизации времени работы в OB ошибок).. 

- Создается соединение между канальным выходом блока MOD/PADB 
и соответствующим входом на блоке CH. Если модуль поддерживает 
“статус величины”, появляется адрес статуса величины и соединение 
с блоком CH/PA.  

Если выполнено изменение в конфигурации (аппаратной или программной), 
изменения должны обрабатываться, используя генерацию драйвера. 
Существующие блоки драйвера не удаляются и не создаются заново, просто 
переназначаются параметры. Не требуемые больше блоки удаляются 
(исключая включенные пользователем) и создаются дополнительные 
требуемые блоки. Если типы блоков уже импортированы, они используются 
из системы управления данными CFC, а не из библиотеки.  
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3.9.3 Как работает “Генератор драйверов модуля” 

Системные схемы генерируются автоматически и в них вставляются все 
необходимые блоки диагностики. Системные схемы имеют имена "@1", "@2", 
и т.д.  

 
 Замечание: 

Объекты, идентифицированные символом "@", не должны изменяться 
пользователем, следует только использовать функцию "Generate Module 
Drivers" (“Генерировать драйверы модулей”). Таким образом, блоки 
диагностики не должны вставляться вручную. 

Блоки драйверов, созданные пользователем, вставляются из каталога 
блоков. Если блоки "@" копируются, они в следующий раз удаляются 
функцией "Generate Module Drivers". 

Новые типы блока  
Если установлена новая библиотека PCS 7 с измененными  блоками, это, 
вначале, не влияет на уже использованные блоки.  
Если, однако, Вы хотите обновить блоки, проделайте следующие шаги:  

• Удалите из папки схем все системные схемы с @. 

• Выберите команду меню "Options > Block Types..." ("Опции > Типы блока") 
и удалите соответствующие блоки в окне "папка схем" (выберите блоки и 
нажмите кнопку "Tidy Up" («Уборка»)). 

• В обзоре компонент SIMATIC Manager запустите функцию "Generate 
Module Drivers" (“Генерировать драйверы модулей”).  
Будут созданы новые системные схемы и используются блоки драйверов 
из новой библиотеки, старые блоки более не существуют в CFC 
(библиотека вводится в диалоговом окне "Установки"). 

.  
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3.10  Обновление типов блоков S7 

Вы можете скомпилировать схему (другими словами, все схемы в папке схем) 
как программу, или отдельную схему как тип блока. 

3.10.1 Обновление типов блоков в мультипроекте  

В мультипроекте Вы можете сравнить все типы блоков, используемые в 
отдельном проекте, с типами блоков в мастер-библиотеке и обновить их. 
Типы блоков, которые не используются в CFC; другими словами, типы блоков 
для которых не существует экземпляров блоков, не обновляются. 

Допустив, что новая версия содержится в папке блоков, Вы можете использо-
вать функцию обновления, чтобы убедиться, что все или только определен-
ные типы блоков имеют совпадающую текущую версию во всех выбранных 
или в отдельном проекте мультипроекта. Обновление типов блоков также 
обновляет соответствующие экземпляры блоков в соответствующих схемах 
(централизованная синхронизация типов). 

Последовательность действий: 
1. Выберите блоки для обновления  в папке блоков в SIMATIC Manager (или 

все блоки, нажав Ctrl + A). 

2. Выберите команду меню "Options > Charts > Update block types..." («Опции 
> Схемы > Обновление типов блоков»). 

Отображается страница диалога 1(3) "Select the S7 program to be checked" 
(«Выбрать программу S7 для проверки»). Это список всех программ S7 в 
мультипроекте, которые отображены как выбранные. 

3. Проверьте выбор и, если требуется, исключите программы S7, в которых 
не требуется обновлять какие либо блоки. 

4. Нажмите кнопку "Next" («Далее»). 

Проверьте маркировку в колонке "Status" («Состояние»), показывающую, 
какие программы уже проверены.  

Для завершения проверки переключитесь к странице диалога 2(3) "Select 
the block types to be updated" ("Выбор типов блоков для обновления"). 
Основываясь на типах блоков, выбранных в библиотеке, эта страница 
приводит отдельные программы S7, которые содержат отличающиеся 
версии. Чтобы помочь Вам определить, какие блоки выделены, колонка 
"Consequence" ("Последствия") показывает Вам  результат нового 
импорта. Показаны следующие последствия: 

- All associated instances will be modified (Все связанные экземпля-
ры будут модифицированы) (никаких дальнейших последствий!). 

- The OS must be recompiled (OS должна быть перекомпилирована). 
Все связанные экземпляры должны быть изменены. Мастер для 
компиляции OS запускается командой меню "Options > Wizard: 
'Compile Multiple OSs' > Start..." ("Опции > Мастер: ‘Компиляция 
нескольких OS’") или командой "Compile" (“Компиляция") в 
контекстном меню при выбранной OS. 
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- Downloading entire program in operating mode STOP (Загрузка 
программы в целом в режиме STOP); другими словами, более 
невозможна загрузка только изменений в режиме RUN. Все связанные 
экземпляры должны быть модифицированы. 

5. Проверьте выбор и, если требуется, исключите блоки, которые Вы не 
хотите обновлять из-за последствий. 

6. Нажмите кнопку "Next" ("Далее").  

Проверьте маркировку в колонке "Status" ("Состояние") показывающую, 
какие блоки уже были обновлены.  

Для завершения обновления, перейдите к следующей странице диалога 
3(3) "Log" ("Протокол"). Здесь Вы можете увидеть, что происходило в 
процессе обновления, и к каким последствиям это привело: 

- Запуск обновления типов 

- Путь протокола 

- Библиотека 

- Выбранные блоки 

- Выбранные программы S7  

- Обновленные блоки 

- Конец обновления типа 

7. Если Вы хотите распечатать протокол, нажмите кнопку "Print" ("Печать"), в 
противном случае нажмите "Close" ("Закрыть") для закрытия диалога. 

Если Вы остановите обновление кнопкой "Cancel" ("Отменить"), все измене-
ния, сделанные до этого, сохраняются. Они также включаются в протокол. 

3.10.2 Обновление типов блоков в простом проекте 

Вы можете обновить типы блоков из библиотеки, которая не является мастер-
библиотекой мультипроекта в отдельных проектах по Вашему выбору. Это 
центральное обновление типа также синхронизирует все соответствующие 
экземпляры блока. Типы блоков, которые не используются в CFC; другими 
словами, для которых не существует экземпляров блоков, не обновляются. 

Последовательность действий: 
8. Откройте требуемую библиотеку в SIMATIC Manager (напр. PCS 7 Library). 

9. В папке блоков библиотеки выберите типы блоков, которые Вы хотите 
обновить в проекте. 

10. Выберите команду меню "Options > Charts > Update block types..." ("Опции 
> Схемы  > Обновить типы блоков"). Открывается диалоговое окно "Open 
project" ("Открыть проект"). 

11. Выберите проект, в котором нужно обновить типы блоков, и нажмите 
"OK". Открывается страница 1(3) диалога "Update block types" 
("Обновление типов блоков"). 

12. Выполните шаги, описанные в разделе "Обновление типов блоков в 
мультипроекте" (начиная с точки 3). 
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3.11 Компиляция  
Вы можете скомпилировать схему (другими словами, все схемы папки схем) 
как программу в целом или как тип блока. 

3.11.1 Компиляция схемы как программы  

В процессе компиляции схемы активного CPU преобразуются в машинный 
код. В S7 используется Компилятор SCL.  
Вы запускаете компиляцию с помощью команды меню "Chart > Compile > 
Charts as Program..."  ("Схема > Компиляция > Схема как программа") или 

нажав кнопку  в панели инструментов.  

Взаимосвязи  
Для управления ресурсами CPU, используя функцию "Customize Compilation" 
("Настройка компилятора"), важно понимать описанные ниже взаимосвязи.  
Структура, которую Вы конфигурируете в CFC, отображается в S7 как 
машинные объекты FC и DB.  
FC, необходимые для вызова блоков, обрабатываются в схеме CFC согласно 
сконфигурированной последовательности выполнения таким образом: 
• Один FC для каждого используемого OB 
• Один FC для каждой рабочей группы 
DB используются следующим образом: 
• Экземпляр DB создается для каждого экземпляра FB. 
• Для хранения промежуточных результатов, например, из FC, создается 

DB, внутренний относительно CFC. Один DB требуется на один тип 
данных. Когда достигается максимальная длина (4 кбайта), создается 
дополнительный DB. 

Что такое компиляция? 
Когда Вы компилируете, то выбираете между двумя возможностями:  
• Range: Entire program (Диапазон: Программа в целом) Если Вы 

компилируете всю программу, содержание всей папки схем 
компилируется, несмотря на то, сделаны изменения или нет.  

• Range: Changes (Диапазон: Изменения) 
Если Вы компилируете изменения, компилируются только те объекты, в 
которых произошли изменения. Изменениями считаются исключительно 
изменения содержания (соединения, атрибуты блока, число входов и 
т.д.), но не перемещения объектов внутри схемы. При выборе "только 
изменений", время, затраченное на компиляцию, будет меньше и обычно 
Вам следует использовать этот вариант.  

 Замечание:  

Когда Вы компилируете изменения, проверяются только они. Если Вы хотите 
проверить всю программу, выполните проверку непротиворечивости (Check 
Consistency). 
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Необязательные функции до компиляции  
Перед компиляцией Вы имеете возможность выбрать определенные опции, 
которые будут выполняться перед запуском компиляции. Они включают в 
себя следующие: 

• Опция "Generate Module Drivers" ("Генерировать драйверы модулей") 

Если установлена эта опция, драйверы модуля для существующих блоков 
обработки сигналов генерируются и соединяются перед компиляцией.  

• Опция "Update sampling time" ("Обновить время получения выборки") 

Если блоки имеют входы для времени выборки (в блоках PCS 7, вход 
SAMPLE_T, атрибут "S7_sampletime = true"), время получения выборки 
может быть обновлено.  

Если Вы установили опцию "Обновить время выборки " (в диалоге 
компиляции), система проверяет, какое прерывание цикла блока OB 
установлено перед компиляцией. Циклическое время OB записывается на 
вход. Если блок установлен в рабочую группу при вычислении времени 
выборки, принимается во внимание и отношение циклов 

• Опция "Delete empty run-time groups" ("Удаление пустых рабочих групп") 

Если установлена эта опция, пустые рабочие группы будут удалены 
перед компиляцией. Эти пустые группы - результат копирования при 
разделении и слиянии данных проекта. 

Замечание: Рабочие группы созданные автоматически, когда создается 
схема, могут быть пустыми, если схема еще не содержит блоков. Эта 
автоматически создаваемая рабочая группа не удаляется. 

• Опция: "Make Textual Interconnections" ("Выполнить текстовое 
соединение")  

Если установлена эта опция, все текстовые соединения перед 
компиляцией будут замкнуты, если находится партнер по соединению; 
другими словами,  они преобразуются в реальные соединения.  

Замечание: Если опция не установлена или текстовое соединение не 
может быть замкнуто, генерируется замещающая величина; то есть 
используется величина параметра по умолчанию для этого типа блока. 

Consistency Check (Проверка на непротиворечивость) 
В процессе компиляции проверка на непротиворечивость выполняется 
автоматически. Вы также можете запустить эту проверку вручную, например, 
перед тем, как Вы перезапишете старую программу CFC в процессе 
компиляции. 

Подготовка к компиляции  
С помощью команды меню "Options > Customize > Compilation..." (“Опции> 
Назначения> Компиляция…») Вы вызываете диалоговое окно, в котором Вы 
можете зарезервировать номера FC и DB для собственного использования. 
Эти области не используются CFC.  

Для объяснения диалога и дополнительной информации об установках 
обратитесь к интерактивной справке. 
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После компиляции  
Когда компиляция завершена (или прервана), будет показано диалоговое 
окно "Logs" ("Протокол"). Здесь протоколируются результаты компиляции, 
включая предупреждения и ошибки. Основываясь на протоколе, Вы можете 
проверить, была ли компиляция правильной, и можете распечатать протокол, 
нажав кнопку "Print".  

Вы также можете просмотреть протокол вновь, и если требуется, распечатать 
его с помощью команды меню "Options > Logs..." («Опции> Протоколы»). 

 
 Замечание: 

Компиляция программы в целом не обязательно предполагает загрузку 
программы в целом. Если программа была загружена в CPU до компиляции, 
можно загрузить только изменения. 
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3.11.2 Компиляция схемы как типа блока  

Вы можете создать типы блоков из существующих схем CFC, если хотите 
использовать их многократно. Вы можете назначать системные атрибуты 
этим типам блоков. 
Вы запускаете компиляцию с помощью команды меню "Chart > Compile > 
Charts as Block Type..." (“Схема > Компиляция > Схемы как тип блока…"). 
Откроется диалоговое окно с двумя страницами.  
На странице "General" ("Общее") Вы можете перед компиляцией определить 
свойства типа блока (номер FB, символьное имя, имя (заголовок), семейство, 
автор и версия (заголовок)) и определить целевую систему, в которой будет 
использоваться блок (S7-300 или S7-400).  
Вы можете оптимизировать код. Для оптимизации выберите между "local data 
requirements" ("требования к локальным данным") и "download changes in 
RUN" ("загрузка изменений в RUN"):  

• Требования к локальным данным: 
При этом типе оптимизации, изменения в схеме не увеличивают 
требований к объему локальных данных, поскольку все временные 
переменные хранятся в экземпляре DB (область VAR). Это приводит, 
однако, к изменениям в структуре экземпляра DB, а, следовательно, и к 
изменениям метки времени его интерфейса. В этом случае не возможна 
загрузка изменений в интерактивном режиме.  

• Загрузка изменений в RUN: 
При этом типе оптимизации, если изменяется схема, временные 
переменные, по мере возможности, хранятся в области VAR_TEMP. По 
мере возможности означает, что все промежуточные результаты в потоке 
данных хранятся здесь. Только промежуточные результаты не из потока 
данных (например, в обратной связи) продолжают храниться в области 
VAR (экземпляр DB). Преимущества этого способа оптимизации в том, 
что не все изменения приводят к изменениям метки времени интерфейса 
экземпляра DB, так что в большинстве случаев изменения могут быть 
загружены в интерактивном режиме. Единственный недостаток – 
увеличение потребности памяти локальных данных. 

Как опцию Вы также можете активировать защиту ноу-хау. В результате 
алгоритм блока может быть просмотрен, и, при необходимости, изменен 
только, когда имеется соответствующий исходный файл SCL.  
На странице "Attributes" (“Атрибуты”) Вы можете ввести системные атрибуты 
для типа блока (например, системный атрибут S7_blockview" величина "big").  
Для более подробной информации смотрите интерактивную справку. 
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3.12 Загрузка пользовательской программы в целевую 
систему  

Для тестирования и запуска пользовательской программы в CPU, ее нужно 
туда загрузить.  
Программа загружается в CPU, назначенное активной схеме. 

 
 Замечание: 

Программу, созданную в CFC, Вы должны всегда загружать в целевую 
систему из CFC, поскольку только функция загрузки из CFC гарантирует 
согласованность данных конфигурации с данными AS.  

Такая же функция используется, если Вы выбрали команду меню "AS > 
Compile/Download Objects" ("AS > Компиляция/Загрузка Объекта" в SIMATIC 
Manager. 

С другой стороны, копирование блоков из "Offline Block Folder" ("Папки 
блоков автономного режима") для того, чтобы вставить их в "Online Block 
Folder" ("Папку блоков интерактивного режима"), не возможно. 

Записи в протоколе изменений  
Загрузка в CPU подобна работе в тестовом режиме, это функция S7, которая 
может быть защищена паролем. Предпосылка: Установлен SIMATIC Logon 
Service. Действия по защите вносятся в протокол изменений, если текущая 
папка схем активирована для протокола изменений (Chart folder > Object 
properties... > Change log tab (Папка схем > Свойства объекта >: Стр. 
«Протокол изменений»)).  

Чтобы проверить, поддерживает ли другая система протокол изменений, 
смотрите в интерактивную справку для заданной целевой системы. 

Если при компиляции программы в протокол вносятся предупреждения, это 
может означать, что загрузка может быть отклонена или оборвана. В этом 
случае до загрузки проверьте, какие предупреждения в протоколе 
компиляции относятся к загрузке. 

Для более подробной информации о протоколе изменений, смотрите раздел 
интерактивной справки "Change log" («Протокол изменений»). 

Запуск загрузки  
Для того, чтобы загрузить пользовательскую программу, выберите команду 

меню "PLC > Download" ("PLC > Загрузка") (или нажмите кнопку    на 
панели инструментов).  
Затем появится диалоговое окно, в котором Вы выбираете тип загрузки и 
запускаете дополнительный диалог для выбора опций.  
Если в программе выполнены изменения, существенные для загрузки, 
появится сообщение о том, что программа сначала должна быть 
откомпилирована и Вас спросят, хотите ли Вы откомпилировать программу, а 
затем загрузить. 
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Замечания:  

• Компиляция программы в целом необязательно означает полную 
загрузку. Если программа уже загружалась в CPU перед компиляцией, 
можно загрузить только изменения. 

• Если полная загрузка была прервана, загрузка изменений невозможна до 
завершения полной загрузки. Причина: Блоки  удаляются из памяти CPU 
перед загрузкой.  

• Вы можете компилировать программу так часто, как Вы хотите (только 
изменения или всю программу) без утери способности загрузить только 
изменения. 

Загрузка  
Вы можете загрузить программу следующими способами:  

• Вся программа 

• Только изменения  

• Загрузка в тестовый CPU (вся программа). 

 

Загрузка: Вся программа 
Передаются все загружаемые объекты программы; если Вы выберите  
"Changes only" («Только изменения»), Вы загрузите только изменения со 
времени последней загрузки. 
"Программа в целом" может быть загружена в режимах STOP или RUN-P. В 
режиме RUN-P, CPU установится в STOP после запроса о согласии, и все 
блоки будут очищены. После успешной загрузки, появится сообщение "Do you 
want to restart the CPU?" ("Хотите ли Вы перезапустить CPU?"); ответьте “да” 
для включения теплого рестарта. 
 

Загрузка: Только изменения 
Вы можете загрузить "изменения" в режиме CPU "RUN-P". Правильная 
загрузка упорядочит ячейки, необходимые для данных. Пожалуйста, учтите, 
что из-за возможных противоречий не существует абсолютной гарантии, что 
CPU не перейдет в режим STOP.   
Система выполнит широкую проверку, что предотвратит загрузку, если 
обнаружится ошибка. Также обратитесь к интерактивной справке CFC 
"Downloading the User Program to the AS" ("Загрузка Пользовательской 
программы в AS"), раздел "System Support for Avoiding Causes of CPU STOP" 
("Системная поддержка по предотвращению перехода CPU в STOP”).  
Замечания по загрузке изменений:  

• Загрузить изменения в принципе возможно, если  

- Полная загрузка выполнена хотя бы раз.  

- Вы загружаете структуру программы, которая была загружена ранее. 

• Каждая загрузка включает в себя асинхронное уплотнение памяти CPU. 
Это исключает предупреждения и сообщения об ошибках из-за 
недостатка памяти при перезагрузках изменений. Уплотнение памяти 
CPU при загрузке имеет другой эффект по сравнению с уплотнением 
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области номеров DB/FC. В последнем случае, загрузка изменений не 
возможна. 

• Компиляция программы в целом не требует загрузки в целом. Если 
программа была загружена в CPU до компиляции, можно загрузить только 
изменения. 

• Вы можете компилировать программу в целом или только изменения так 
часто, как желаете, без утери возможности загрузить изменения.  

• Если загрузка изменений была прервана, оставшаяся часть может быть 
загружена в новой попытке.  

• Если Вы сделали изменения в программе и тестируете программу на  
другой системе или с помощью PLCSIM до загрузки в рабочую систему, 
после этого невозможна загрузка только изменений. 

• Заметьте: Если Вы используете опцию "Scope: Download to Test CPU 
(Entire Program)" ("Диапазон: Загрузка в тестовое CPU (Программа в 
целом)"), возможность загрузки изменений в оригинальное CPU 
сохраняется. 

Загрузка в тестируемый CPU  
С использованием этой возможности, Вы можете загрузить изменяемую 
программу для тестирования в иной CPU или в PLCSIM без потери 
возможности загрузки только изменений. 

При загрузке для проверки в тестовое CPU (или в PLCSIM) загружается 
программа в целом без потери идентификаторов загрузки и без меток  
сравнения, которые записываются в систему управления данных ES.  

• Чтобы избежать случайной аварийной перезаписи программы при 
тестовой загрузке, загрузчик проверяет, совместимы ли изменения 
программы с загрузкой только изменений. Если это имеет место, должен 
быть включен оригинальный, а не тестовый CPU. Отображается 
сообщение о данном результате и загрузка не может быть выполнена 
(кнопка "OK" заблокирована). 

Замечание для H CPU:  

Если H CPU в режиме "solo", например, после неисправности CPU и это 
неисправный CPU, интерактивный доступ покажет диалоговое окно выбора. В 
этом диалоге Вы можете выбрать нужный CPU. В этом диалоге Вы должны 
выбрать требуемый CPU. В режиме резервирования этот диалог не 
появляется.  

Замечание для F-системы:  

Для программы с измененными F-компонентами Вы можете загрузить 
изменения только после ввода пароля. Без  допуска загрузка прерывается.  

!  
Внимание! 

Дополнительные причины остановки перечислены в интерактивной справке 
под заголовком "Reasons for STOP when Downloading Changes Online" 
("Причины перехода в STOP при загрузке изменений"). Пожалуйста, 
прочитайте этот раздел перед тем, как Вы загрузите изменения в 
интерактивном режиме на CPU в режиме "RUN-P". 
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Опция: Включение пользовательских блоков данных 
Если установлена эта опция (установка по умолчанию), когда Вы загружаете 
изменения, блоки данных, которые находятся не в области CFC, 
обрабатываются следующим образом: 

• Они включены в загрузку, если различаются метки времени или блоки 
данных добавлены. 

• Они удаляются в CPU, если не существуют в программе S7. 
Если Вы хотите, чтобы блоки данных пользователя игнорировались при 
загрузке, деактивируйте эту опцию.  
Учтите следующее: 

• Если блок пользовательских данных существует в программе S7, но не 
существует в CPU, загрузка будет прервана, появится сообщение об 
ошибке. 

• Если блок данных пользователя существует в CPU, но не существует в 
программе S7, появится предупреждение; также будет в случае, если 
блок данных пользователя в программе S7 отличается от блока в CPU. 
Правильное выполнение программы – ответственность пользователя. 
Сохранение установок без загрузки  

Вы можете сохранить установки в диалоговом окне без запуска загрузки 
(кнопка "Apply" (“Применить”)). Это может, например, быть полезным, если Вы 
хотите использовать в SIMATIC Manager функцию "Compile and Download 
Objects" (“Компилировать и загрузить объекты”).  
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3.13 Выгрузка схем  

Измененные данные  
Вы можете сохранить (выгрузить) параметры всех схем CFC, содержащихся в 
активной папке схем и те данные AS, которые были изменены (например, 
ограничения управляющей величины, измененные оператором на OS).  

Выгрузка  
Вы запускаете выгрузку с помощью команды меню "Chart > Read Back...."  
(“Схема > Выгрузить»). 
Если Вы выбираете "Program of the CPU" ("Программа CPU"), как источник в 
диалоговом окне "Read back" ("Выгрузить"), программа из CPU (папка блоков 
интерактивного режима) выгружается в папку схем с текущими параметрами.  
Другим способом, Вы заранее выгружаете данные из CPU, используя 
SIMATIC Manager (команда "PLC > Upload Station to PG"). При этом возникает 
"Программа в автономном режиме" (Offline), которая используется как 
источник в диалоговом окне "Read Back". Данные затем считываются из папки 
блоков в автономном режиме (offline) и записываются в папку схем.  
В ином случае, в диалоговом окне Вы можете выбрать, хотите ли Вы выгру-
зить все параметры входов блоков или только параметры, с системным 
атрибутом для "управления и мониторинга оператором" (S7_m_c:='true') или 
со специальным назначением для выгрузки (S7_read_back := 'true'). 

После выгрузки  
Чтобы убедиться в согласованности, после выгрузки производится 
автоматическая компиляция всей программы. Это не заставляет, однако, 
загружать целую программу, ее можно загрузить с сохранением режима RUN 
на CPU (только изменения). 
При окончании выгрузки создается и отображается протокол. Вы можете 
посмотреть протокол позже на странице ”Options > Logs > Read Back" (“Опции 
> Протоколы > Выгрузка”). Помимо прочего, протокол показывает, какие 
входы и выходы были выгружены и изменены, и где появились проблемы.  

Замечания к выгрузке  
Независимо от выбранного диапазона: 

• Входы и выходы, которым нельзя назначить величины параметров 
(Атрибут: S7_param := 'false'), нельзя выгрузить. Могут быть прочитаны 
только входные и вход-выходные параметры (но не выходные). 

• Величины входов FC и типы данных ANY, ARRAY, POINTER, UDT 
игнорируются при выгрузке. Типы данных ANY, ARRAY, POINTER, UDT 
игнорируются при выгрузке. 

• Входы с доступом для записи в SFC не читаются. 

• Если величины изменены на AS и схема затем выгружена, эти изменен-
ные величины помечаются как загруженные, другими словами, если Вы 
затем загружаете в CPU только изменения, эти величины не загружаются 
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• Определенные блоки могут исключаться из функции выгрузки (например, 
блоки BATCH). В таком случае, тип блока имеет атрибут S7_read_back := 
'false' (Block Properties > Option: Read-back enabled (Свойства блока > 
Опция: Выгрузка разрешена)). 

• Замечание для H CPU: Если H CPU в режиме «solo», например, после 
неисправности CPU и это неисправный CPU, интерактивный доступ 
покажет диалоговое окно выбора. В этом диалоге Вы можете выбрать 
нужный CPU. В этом диалоге Вы должны выбрать требуемый CPU. В 
режиме резервирования этот диалог не появляется.  

Замечания по загрузке конфигурации:  
Помните, что при загрузке конфигурации данные помещаются в загрузочную 
память. Изменения, сделанные при операциях мониторинга и модификации 
или в тестовом режиме существуют только в рабочей памяти. При приеме 
данных из загрузочной памяти, изменения в рабочей памяти теряются, 
поскольку они перекрываются начальными значениями из загрузочной 
памяти. Если до загрузки конфигурации Вы провели выгрузку, чтобы получить 
значения, введенные оператором,  Вы можете передать этот вариант 
загрузкой в CPU программы в целом (в STOP). 

Для диапазонов "OCM-capable parameters" («Параметры, совместимые с  
OCM») и "Designated parameters" («Определенные параметры») 
применимо следующее: 

• Значения входов FC игнорируются.  

Для диапазона "All parameters" («Все параметры»), применимо 
следующее: 

• Входы FC, подключенные к входам и выходам схемы выгружаются. Это 
применимо также к схемам и выходам схемы с многократным 
подключением к входам блока (FB и FC). 
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3.14 Раздельная разработка проекта  

Всегда возможно выполнить раздельную разработку одного проекта или 
мультипроекта. Это позволяет конфигурировать, тестировать и вводить в 
действие AS отдельно, для выполнения работ в разных точках или в сети PC 
(режим множества пользователей). 

Основные возможности  
• PC с сетевой структурой.  

Проект находится на сервере, и несколько инженеров конфигурируют 
определенные части проекта одновременно (AS, OS). Убедитесь, что 
схемы AS или экраны на OS редактируются одновременно только 
одним PC (одним пользователем).  

• Проекты внутри Мультипроекта.  
Проекты мультипроекта хранятся централизованно на одном компьютере 
и могут распределяться для редактирования на других компьютерах. Для 
редактирования отдельных станций, проекты передаются разработчикам 
на их рабочие станции. Несколько проектов могут быть представлены на 
одной рабочей станции одновременно. 

После редактирования и слияния в мультипроект данные должны быть 
согласованы с помощью системной поддержки (команда меню "File > 
Multiproject > Adjust Projects" (“Файл > Мультипроект > Согласование 
проектов”)) и нужно запустить соответствующие межпроектные функции 
(например, компилятор OS). Эти функция должны выполняться позже, 
когда конфигурация подготавливается к вводу в действие.  

• Разделение и слияние данных проекта.  
Вы можете разделить схемы программы S7 на несколько проектов. 
Разделение отдельных схем проекта и затем их слияние после 
отдельного редактирования возможно в новой версии V6.0, которая 
обеспечивает ориентированную на схемы структуризацию  
последовательности выполнения.  
Смотрите также: Модель последовательности выполнения CFC, Раздел 
3.8.1 и Текстовые соединения при разделении и слиянии данных проекта, 
Раздел 3.14.1.  
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Как разделять и сливать данные проекта  
13. Скопируйте технологическую часть проекта (простая схема, несколько 

схем) в другой проект. 
Результат: Копия содержит текстовое соединение со всеми источниками, 
которые были не скопированы. 

14. Редактируйте скопированную часть отдельно (добавить, удалить, 
изменить блоки и схемы). 

15. Скопируйте отредактированную технологическую часть проекта обратно в 
оригинальный проект. 
Результат: Система сначала удалит схемы с одинаковыми именами в 
оригинальном проекта. Сейчас текстовое соединение находится во всех 
схемах, которые ждут данные из удаленных схем. Система затем 
копирует схему или схемы из другого проекта. 

16. Замкните все открытые соединения с помощью команды меню "Options > 
Make Textual interconnections" (“Опции > Выполнить текстовые 
соединения"). 
Результат: соединения снова замкнуты как во всех схемах другого 
проекта, так и в оригинальном проекте, в котором текстовые соединения 
появились как результат удаления схемы.  
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3.14.1 Текстовые соединения при разделении и слиянии данных 
проекта  

В связи с разделением проектов и созданием отдельных конфигурируемых 
модулей, которые могут затем сливаться вместе, возникают отдельные 
аспекты, касающиеся текстовых соединений. 

Последовательность и процедура  

Когда Вы разделяете проект (известен как мастер проект), Вы копируете 
часть папки схем в другую или несколько других папок схемы, например, во 
временные проекты (ветки проекта) для разных разработчиков. В общем, это 
одна или более схем (но не все), которые передаются в различные проекты. 
Соединения с другими схемами преобразуются в текстовые соединения на 
входах и удаляются на выходах.  

Когда Вы возвращаете отредактированные схемы в мастер-проект (копирова-
ние или перемещение), схемы с одинаковыми именами обнаруживаются в 
мастер-проекте, то Вас запрашивают, хотите ли Вы переписать 
существующий проект. Если Вы ответили "нет”, схема вставляется как копия 
("нет" для множества схем), если Вы ответили “да”, существующая схема 
переписывается ("все" для множества схем). Перед тем, как будет вставлена 
схема из отделенного проекта, она будет удалена из мастер-проекта, но в 
отличие от обычного удаления (Del), с сохранением текстового соединения.  
Команда меню "Options > Make Textual Interconnections" (“Опции > Выполнить 
текстовые соединения"), преобразует их в реальные соединения. 

Вместо копирования схем в другие проекты, Вы можете переместить их 
(вырезать и вставить). Преимущество копирования, однако, в том, что Вы 
сохраняете функциональный мастер-проект до тех пор, пока не возвратитесь 
к отредактированной схеме. 

Замечания: 
• Когда соединение разрывается, никакой из партнеров соединения не 

должен быть переименован, в ином случае текстовое соединение не 
может быть замкнуто.  

• Изменения  в схемах мастер-проекта отбрасываются, когда схемы с 
одинаковыми именами возвращаются в мастер-проект из разделенного 
проекта. 

• Нежелательное соединение может появиться в мастер-проекте, если, 
например, соединение между схемами было изменено в отделенном 
проекте и только одна схема была возвращена в мастер-проект. 
Пример: Блок в схеме CFC_A соединен с блоком в схеме CFC_B. Обе 
схемы были скопированы в отделенный проект и там отредактированы. 
При редактировании соединение между схемами было удалено. Только 
CFC_A была возвращена в мастер-проект. В результате в мастер-проекте 
CFC появилось текстовое соединение, которое можно замкнуть. 
Результат: Соединение, удаленное в отделенном проекте, возникло в 
мастер-проекте. 

• Текстовое соединение, созданное перед копированием/перемещением, 
включается в целевой проект. Оно может быть конкретной ссылкой пути 
(которую можно замкнуть) или символьной строкой (нужное соединение, 
которое будет сконфигурировано в целевом проекте).  
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4 Тестирование и ввод в эксплуатацию 

Обзор  
При вводе в эксплуатацию нового проекта редактор CFC обеспечивает Вас, 
функциями тестирования, позволяющими Вам выполнять наблюдение и, при 
необходимости, изменять входы и выходы блоков в контроллере. 

4.1 Общие сведения  

Редактор CFC имеет два рабочих режима: редактирования и тестовый. 

• В режиме редактирования, Вы конфигурируете всю структуру 
программного обеспечения CPU в автономном режиме (offline) (см. также 
Главу 3 "Работа с редактором CFC").  

• Когда Вы переключаетесь в тестовый режим, Вы можете наблюдать и 
назначать параметры входам и выходам блоков; другими словами, 
выполнять мониторинг  и модификацию переменных в интерактивном 
режиме (online)..  

Во время тестирования, должно быть однозначное соответствие между 
объектами в графическом представлении программы и физическими 
адресами в CPU. По этой причине в тестовом режиме, в отличие от режима 
редактирования, Вы не можете сделать изменения, влияющие на структуру 
пользовательской программы (например, вставку или удаление блоков, 
изменение подключения входов и выходов и т.д.). 

Дополнительные функции тестирования  
• Чтобы обеспечить Вам одновременное наблюдение в CPU некоторых 

входов и выходов из различных блоков и схем, Вы можете отобрать эти 
входы и выходы и отображать их постоянно обновляемые значения в окне 
динамического отображения (dynamic display window). 

• С отображением трендов в CFC Вы можете непрерывно следить за 
изменениями более чем одного сигнала CPU. Отображение тренда может 
использоваться всеми целевыми системами, которые поддерживают 
работу, в обычном интерактивном режиме. Одновременно можно 
записывать максимум 8 величин. Справьтесь в раздел 4.5 "The Trend 
Display" («Отображение тренда»). 

• В дополнение к функциям непосредственного тестирования, есть также 
группа функций, которые помогают Вам в подготовке к тестированию и 
вводу в эксплуатацию, например, отображение информации о модуле, 
установка времени дня и т.д  
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Требования  
Для использования функций тестирования и запуска, пользовательская 
программа, созданная в редакторе CFC должна быть сначала без ошибок 
откомпилирована и загружена в CPU.  

4.2 Функции до и во время тестирования 

В дополнение к прямым функциям, имеются также некоторые функции, 
которые окажутся полезными Вам для тестирования и ввода в эксплуатацию. 
К ним относятся: . 

• Общие функции, такие как "Set Time and Date" ("Установка времени и 
даты"). 

• Функции, поддерживающие Вас при системной диагностике и устранении 
проблем, такие как, отображение режима или информации о модуле. 

Эти функции описаны ниже. 

4.2.1 Сравнение временных меток программ CPU  

Вы можете отобразить временные метки загружаемой пользовательской 
программы командой меню "PLC > Compare..." ("PLC > Сравнить..."). 

В диалоге будут показаны три временные метки: 

• The last download-relevant change (Последнее изменение, существенное 
для загрузки) 

• Last offline program change (Последнее изменение программы на 
программаторе (offline)) 

• Last online program change (Последнее изменение программы в CPU 
(online)) 

 Замечание: Временная метка "Last download-relevant change" ("Последнее 
изменение, существенное для загрузки") изменяется также при присвоении 
параметров входов и выходов блоков в тестовом режиме.  

Программа пользователя, которую Вы загружаете в CPU, только в том 
случае идентична программе CFC и машинному коду, когда идентичны все 
временные метки.  

По меткам времени, которые могут сочетаться или не сочетаться, Вы можете 
увидеть, какие изменения были сделаны в пользовательской программе, и  
решить, нужно ли Вам перекомпилировать и загрузить заново программу. 

4.2.2 Запуск и остановка программ CPU  

Вы можете запустить или остановить программу CPU, выбрав команду меню 
"PLC > Operating Mode..." ("PLC > Рабочий режим...") и нажав нужную кнопку 
"Cold Restart"/"Hot Restart"/"Warm Restart" ("Холодный рестарт"/ "Горячий 
рестарт"/"Теплый рестарт") или "STOP" ("Стоп") в диалоговом окне "CPU 
program:stopping" (Программа CPU: останов").  

Эта функция идентична соответствующей функции SIMATIC Manager. Эта 
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager. 
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4.2.3 Очистка/сброс CPU  

Очистка или сброс - средство полного удаления пользовательской программы 
CPU и всех существующих соединений. CPU должен быть в режиме STOP. 

Эта функция идентична соответствующей функции SIMATIC Manager. Эта 
процедура описана в интерактивной помощи SIMATIC Manager. 

 
 Замечание: Если Вы загружаете пользовательскую программу полностью, 

все блоки в CPU удаляются после подтверждения Вами запроса. В этом 
случае, у Вас нет необходимости в предварительной очистке памяти CPU. 
Если Вы очищаете память CPU, удаляется не только пользовательские 
данные в CPU , но и соединения с модулями. 

 

4.2.4 Установка времени и даты  

Вы можете установить "Date and Time" ("Дата и время") на отдельном CPU, 
выбрав команду меню "PLC > Set Time and Date..." ("PLC > Время и дата"). 

Эта функция идентична соответствующей функции SIMATIC Manager. Эта 
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager. 

4.2.5 Отображение информации о модулях 

Вы можете отобразить текущее состояние модуля CPU командой меню "PLC 
> Module Information..." (PLC > Информация о модуле). 

Эта функция идентична соответствующей функции SIMATIC Manager. Эта 
процедура описана в интерактивной помощи (Нelp) SIMATIC Manager. 
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4.3 Работа в тестовом режиме  

Редактор CFC имеет тестовые функции, поддерживающие Вас при вводе в 
эксплуатацию. Они позволяют вам наблюдать и воздействовать на 
выполнение блоков в CPU и, если необходимо, изменять установки.  

Тестовый режим соотносит CPU с текущей активной схемой.  

Изменение цикла отладки 
Входы и выходы, наблюдаемые в тестовом режиме, циклически обновляются 
значениями переменных из CPU.  

По умолчанию для обновления этих входов и выходов установлен цикл 2 с. 
Эта установка задается для CPU, иными словами, она применима ко всем 
схемам текущей папки схем. 

Вы можете изменить время цикла в режимах редактирования или 
тестирования следующим образом: открыть диалоговое окно "Debug > Test 
Settings..." ("Отладка > Установки тестирования ), в котором Вы можете 
задать время цикла для мониторинга. 

Тестовые режимы 
Тестирование возможно в одном из двух режимов: 

• Process Mode (Рабочий режим) 

• Laboratory Mode (Лабораторный режим) 

Вы можете выбрать режим для тестирования в режиме редактирования 
используя  команды меню "Debug" ("Отладка"). Если Вы находитесь в режиме 
тестирования, переключить тестовые режимы невозможно. 

В рабочем режиме, коммуникации для интерактивного динамического 
отображения блоков ограничены и вызывают ограниченную дополнительную 
нагрузку на CP и шину. Когда активируется тестовый режим, все блоки 
получают состояние "отладка отключена". 

Лабораторный режим обеспечивает удобное и эффективное тестирование и 
ввод в эксплуатацию. В лабораторном режиме, в отличие от рабочего 
режима, коммуникации для интерактивного динамического отображения схем 
CFC не ограничены. Когда активируется тестовый режим, все блоки получают 
состояние "отладка включена". Вы можете наблюдать входы и выходы, 
зарегистрированные для тестирования. 

Записи в протоколе изменений 
Работа в тестовом режиме подобно загрузке в CPU является защищенной 
функцией S7, которая должна быть запротоколирована. Предпосылка: 
установлен SIMATIC Logon Service. Защищенные действия вносятся в 
протокол изменений, если текущая папка схем активирована для протокола 
изменений (Chart folder > Object properties... > : Change log tab (Папка схем > 
Свойства объекта > Протокол изменений)). 

Для более подробной информации о изменении протокола, смотрите  раздел 
интерактивной справки "Change log" («Протокол изменений»). 
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Активация тестового режима: 
Выберите команду меню "Debug > Test Mode" ("Отладка > Тестовый режим") 

или нажмите кнопку  в панели инструментов. Активируется тестовый 
режим. Теперь Вы можете активировать функции из меню Debug (Отладка); 
большинство функций из меню Edit (Редактирование) деактивируются. 

Если пользовательская программа в это время была изменена, то при 
переходе в тестовый режим, будет показано сообщение.  

Деактивация тестового режима  
Когда Вы переключаетесь из тестового режима в режим редактирования, 
функции тестирования деактивируются и снова активируются функции 
режима редактирования.  

Вы выключаете тестовый режим, отжав на кнопку  в панели 
инструментов или выбрав команду меню (сняв «галочку») "Debug > Test 
Mode" ("Отладка > Тестовый режим").  
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4.4 Мониторинг и назначение параметров входам и 
выходам 

Входы и выходы, которые зарегистрированы для тестирования, в тестовом 
режиме обеспечиваются текущими значениями переменных от CPU, если для 
этих входов и выходов активировано "watch" ("наблюдение"). См. также 
раздел Error! Reference source not found. "Советы по тестированию".  

Когда Вы активируете тестовый режим, активируется и функция "watch on" 

("наблюдение включено")  для схем CFC в лабораторном режиме.  

Это означает, что в тестовом режиме Вы можете отобразить изменение 
переменных значений входов и выходов блоков и схем, зарегистрированных 
для отображения; другими словами, переменные циклически читаются из 
CPU и отображаются. Вы можете изменить настройки для этого 
динамического отображения и параметры входов и выходов в тестовом 
режиме.  

В рабочем режиме активирована функция "watch off" ("наблюдение 

выключено") .  Это значит, что Вы должны сначала выбрать в схеме 
блоки для динамического отображения, которые Вы хотите наблюдать; и 
после этого выбрать "watch on" ("включить наблюдение").  
Если, с другой стороны, возникает перегрузка, Вы можете удалить отдельные 
блоки и схемы из списка наблюдения  (выбрать блок или схему и затем 
команду меню "watch off"  ("выключить наблюдение")).  

Предупреждение: Если наблюдение деактивировано, и Вы выбрали вход 

или выход для его регистрации для тестирования кнопкой  , наблюдение 
активируется для этого и для всех остальных входов и выходов этого блока, 
зарегистрированных ранее для тестирования.  

Когда Вы активируете тестовый режим, соединения с CPU устанавливаются 
для всех входов и выходов, перечисленных в окне динамического 
отображения. Вы активируете функцию "watch" ("наблюдение"), путем 
отметки в колонке "Watch" ("наблюдение") отдельно для всех входов и 
выходов.  

 
 Замечание: : 

• Вы не можете наблюдать входы и выходы блока, которые не хранятся в 
DB. Это имеет место, например, для неподключенных входов FC или 
BOP и для выходов типов STRING, DATE_AND_TIME, ANY.  

• В тестовом режиме, если вход EN=0, функциональные блоки (FB) не 
показывают для подключенных входов переменные от подключенных 
источников. Вместо этого на подключенном входе показывается 
величина, с которой блок был выполнен последний раз. Напомним, что 
переменные на подключенных входах могут изменяться, только когда 
вход  EN=1. FC и BOP, напротив, всегда показывают значения 
подключенных источников.  
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4.4.1 Входы и выходы блоков и схем в окне схемы  

Добавление и удаление входов и выходов в списке отладки 
В режиме редактирования или в тестовом режиме (рабочем или лаборатор-
ном), Вы можете зарегистрировать для тестирования отдельные входы и 
выходы блока или схемы, выбрав вход или выход и вызвав команду меню 
"Debug > Inputs/Outputs > Add to Watch List" ("Отладка > Входы/выходы > 

Добавить в список наблюдения") или нажав кнопку  в панели 
инструментов.  

В тестовом режиме, наблюдение активируется одновременно; другими 
словами, входы и выходы показывают текущее значение на желтом фоне. 
Если наблюдение для этих блоков и схем было ранее деактивировано, 
функция наблюдения активируется для всех других входов и выходов, 
которые ранее были добавлены в список наблюдения.  

Вы можете удалить входы и выходы из списка наблюдения, выбрав их и 
подав команду меню "Test > Remove from Watch List" ("Тест > Удалить из 

списка наблюдения") или нажав на кнопку  в панели инструментов.  

Альтернатива: Вы можете также выбрать или отменить выбор входов или 
выходов блоков и схем для тестирования в режиме редактирования 
отобразив "Object Properties" ("Свойства объекта") для выбранного блока и 
выбрав или отменить выбор входа или выхода в колонке "Watched" 
("Наблюдаемый") на странице "Inputs/Outputs" ("Входы/выходы"). 

 Замечание: Вы должны избегать наблюдения излишне большого числа 
входов и выходов одновременно, или, иными словами, слишком большой 
коммуникационной нагрузки на шину и CPU. Если нагрузка слишком велика 
(например >500 при цикле наблюдения 1 с), это может обнаружить бит 
работоспособности; переменные на входах выходах в этом случае 
отмечаются, как временно "нарушенные". 

 
Активирование и деактивирование наблюдения входов и выходов  

Вы активируете наблюдение (отображение текущих значений) входов и 
выходов блоков и схем в списке наблюдения следующим образом: 

• автоматически, активацией лабораторного тестового режима. 

• командой меню "Debug > Watch On" ("Отладка > Включить наблюдение") 

или кнопкой  в панели инструментов. В лабораторном режиме, эта 
функция применяется ко всем блокам; в рабочем режиме только к 
блокам, предварительно выбранным в схеме. 

• Выбором команды меню "Debug > Watch Off" ("Отладка > Наблюдение 

выключить") или нажатием на кнопку , Вы можете прекратить 
наблюдение; другими словами, переменные на входах и выходах более 
не обновляются.  
В лабораторном режиме это применимо ко всем блокам; в рабочем 
режиме только к блокам, выбранным в схеме.  

Все переменные на выходах и входах активируются в списке наблюдения и 
обновляются в цикле мониторинга.   
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Отображение переменных  
Переменные отображаются вблизи входов и выходов в соответствии с их 
типом данных. Они показаны на экране на цветном фоне.  

• Черные звезды на желтом  = величины, измененные динамическим 
дисплеем  

• Черные цифры на желтом = переменные читаются из CPU  

• #### на красном фоне = когда динамические переменные от CPU не 
поступают (проблемы)  

Установка значений входов и выходов  
Если активен тестовый режим, Вы можете модифицировать значения всех 
неподключенных входов. Перед тем, как модифицированные переменные 
будут приняты CPU, проверяется их правильность.  
Пожалуйста, заметьте, что параметры, модифицируемые в тестовом режиме, 
всегда включаются в управление данными CFC. 

4.4.2 Подсказки тестирования (расширение экранной подсказки) 

Наведя курсор мыши на вход, выход или линию соединения, вы можете 
отобразить величину из контроллера, как экранную подсказку. Информация 
активно читается из CPU, когда Вы наводите указатель мыши, независимо от 
того, зарегистрирован ли вход или выход для отладки. Указатель мыши 
действует подобно «щупу» измерительного прибора. Это возможно только в 
том случае, если входы и выходы могут обновляться в интерактивном режиме 
(например, на подключенном входе FC). Обновление осуществляется с 
секундным интервалом, независимо от цикла выбранного для отладки.   

Величина заменяется величиной, получаемой интерактивно и фон 
отображения экранной подсказки изменяется со светло желтого на желтый 
(такой, как на входах и выходах при отладке). 

Для соединений отображается выходная величина. Исключение: для 
соединений с глобальными адресами, отображение переключается на 
входные величины. Инверсия принимается во внимание. 
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4.5 Динамическое отображение  

В этом тестовом режиме, переменные входов и выходов блоков и схем могут 
динамически отображаться в отдельном окне. Это возможно для 
элементарных типов данных (BO, W, R, ...) и для элементов структур.  

4.5.1 Окно динамического отображения  

 
Окно динамического отображения может открываться и располагаться в окне 
редактора CFC одновременно с любым окном схемы. Вы можете настроить 
размер окна. Имеется только одно окно динамического отображения без 
отдельного меню для всех схем CPU. Когда окно закрывается (или когда 
выходим из редактора CFC), содержание сохраняется (только статическое 
содержание, не переменные) и загружается снова при его открытии. 

Вы можете создать и управлять любым числом динамических дисплеев для 
каждого CPU. Каждый дисплей имеет свое собственное имя, которое Вы 
вводите, когда создаете дисплей и которое Вы можете изменить в любое 
время. В окне динамического дисплея одновременно может быть активным 
только один дисплей. Вы делаете Ваш выбор, используя бокс в заголовке. 
Эта панель содержит также кнопки для создания, удаления и 
переименования динамического дисплея. 

В этом окне могут отображаться, наблюдаться и изменяться значения входов 
и выходов различных схем из CPU. При этом не требуется, чтобы 
соответствующие схемы были открыты. Должно быть установлено 
соединение с CPU. 

Окно динамического отображения активируется и деактивируется "View > 
Dynamic Display" ("Вид >  Динамическое отображение"). Оно разделяется на 
колонки (Вы можете изменять их ширину) с следующими заголовками и 
информацией:  

• Status (Состояние): 
В этой колонке показываются сообщения о состоянии (например, ошибка 
CPU, ошибка переменной, ...). 

• Watch (Наблюдение) 
В этом боксе выбора, Вы определяете должен ли, или нет наблюдаться 
данный вход или выход; другими словами, должно или нет, значение 
переменной отображаться динамически. 
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• Chart (Схема) показывает имя схемы. Если это вложенная схема, 
показываются также имена схем верхнего уровня (предков) (например, 
ToptChart\Sim_reg ). 

• Block (Блок) показывает имя блока CFC или вложенной схемы 
(например, switch, controller, ...)  

• I/O (Входы/выходы)  показывает имя входов и выходов (например, LMN, 
IN1, ...)  

• Value (Величина) показывает текущую величину входа или выхода блока, 
прочитанную из CPU (если отмечен бокс выбора в колонке "Watch" 
(Наблюдение)). Если при этом возникают проблемы, показывается 
значение ####. 

• Unit (Единица измерения) показывает текст для выбранной физической 
величины (если она существует) (например, s, %, ...) 

• Comment (Комментарий) показывает комментарий для входов и выходов 
(если он существует).  

Совет: Если, из-за недостаточной ширины колонки, текст не может 
отобразиться полностью, Вы можете при установке указателя мыши на 
данное поле увидеть полный текст на экранной подсказке. 

4.5.2  Входы и выходы в окне динамического отображения  

Вставка входов и выходов  
Вы можете вставить входы и выходы в динамическое отображение в режимах 
редактирования и тестирования. Это делается аналогично вставке и 
удалению входов и выходов блоков и схем в окне схемы.  
Вы можете включить входы и выходы открытой схемы в окно динамического 
отображения следующим способом:  
• Выбрать нужный вход или выход блока и затем команду "Debug > 

Inputs/Outputs > Include in Dynamic Display" ("Отладка > Входы/Выходы > 
Включить в динамическое отображение"). 

• Перетащить мышью требуемый вход или выход в окно динамического 
отображения.  

Входы и выходы блока типа STRUCT: До вставки входа или выхода в 
динамическое отображение, открывается диалоговое окно, в котором Вы 
можете выбрать элементы структуры для отображения их значений.  
Если Вы хотите включить в динамическое отображение все входы и 
выходы блока или вложенной схемы, Вы должны выбрать блок или схему и 
перетащить их в окно динамического отображения. Исключение: входы и 
выходы типа данных STRUCT не будут включены.  

Удаление входов и выходов  
Для удаления входов и выходов выберите соответствующую строку или 
строки в динамическом отображении и удалите ее (или их) командой "Edit > 
Delete" ("Редактировать > Удалить") в контекстном меню (по правой кнопке 
мыши). 
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Отладка переменных  
Вы можете наблюдать величины на входах и выходах блоков и схем без 
открытия соответствующих схем.  
Величина отображается динамически (на желтом фоне) в соответствии с 
выбранным циклом наблюдения если: 
• Активирован тестовый режим,  
• Входы и выходы (или элементы структуры) разрешены для наблюдения 

(выбором в колонке "Watch" ("Наблюдение")) 
• Установлено соединение с CPU.  
Если с величиной связана ошибка, она отображается, как ####  и величины 
на входах и выходах, которые не могут наблюдаться, показываются как  -----.   

Открытие схемы  
Если Вы выбираете строку в динамическом отображении, Вы можете перейти 
к тому месту, где расположен соответствующий данной строке вход или 
выход. Командой меню "Edit > Go To > Chart" ("Редактировать > Перейти > 
Схема") открывается соответствующая схема и выделяется вход или выход.  

Распечатка содержания 
Вы можете распечатать содержание дисплея динамики, используя обычную 
функцию печати (Chart > Print...). Распечатываются текущие значения 
переменных на время начала печати. 
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4.6 Отображение трендов 

Используя отображение трендов в CFC, Вы можете непрерывно следить за 
изменениями одного или нескольких сигналов. Дисплей трендов может 
использоваться со всеми целевыми системами, которые поддерживают 
обычный интерактивный режим. Одновременно могут записываться не более 
8 величин. 

Замечание: Если блоки, входы и выходы которых включены в дисплей 
трендов, удаляются или перемещаются из программы S7, соответствующие 
вводы из дисплея трендов удаляются. 

 
Вы можете создавать и управлять любым числом дисплеев трендов для 
каждого CPU. Каждый дисплей имеет свое собственное имя, которое Вы 
вводите при его создании, и которое может быть изменено в любой момент. В 
окне отображения одновременно может отображаться и быть активным 
только один тренд. Вы выбираете тренд в заголовке в выпадающем списке 
"Trend display:" («Дисплей тренда:»). Эта панель содержит также кнопки для 
создания, удаления, переименования и экспорта дисплея тренда. 

Окно дисплея тренда активируется и деактивируется через View > Trend 
display (Вид > Дисплей тренда).  

Для более детальной информации об окне отображения тренда справьтесь в 
интерактивной справке в разделе "Trend display window" («Окно отображения 
тренда»). 
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5 Документирование  

Обзор 
Эта глава обзорно знакомит Вас с созданием исчерпывающей документации 
для Вашей проектируемой структуры CFC. Она включает в себя: 

• Схему  

• Справочные данные по схеме 

• Протоколы  

5.1 Распечатка схемы CFC 

Используя функцию печати, Вы можете распечатать в CFC текущую схему  

• Вы должны установить требуемый шаблон ("Chart > Page Setup..." 
("Схема > Настройка страницы")) и предварительно просмотреть схему 
("Chart > Print Preview" ("Схема > Предварительный просмотр страницы")), 
если Вы хотите ее распечатать. 

• Вы можете распечатать текущий дисплей динамики. 

Страницы свойств блока или вложенной схемы Вы можете распечатать, 
используя кнопку "Print..." («Печать»). 

Распечатка активной схемы  
Командой меню "Chart > Print" ("Схема > Печать") Вы распечатываете 
активную схему на принтере, установленном по умолчанию. 

Открывается диалоговое окно, в котором Вы можете выбрать, что Вы хотите 
печатать, например "текущий лист (sheet), текущий раздел схемы (current 
chart partition), все разделы схемы (all chart partitions)". 
Если схема имеет входы или выходы, Вы должны решить, печатать ли схему 
с входами и выходами или без них. Входы и выходы схемы распечатаются на 
отдельной странице в виде таблицы (содержит всю существенную 
информацию, такую как тип данных, начальное значение, невидимость). Если 
входов и выходов слишком много для одной страницы, распечатываются и 
все последующие страницы. 
Когда Вы печатаете из SIMATIC Manager, схемы нижнего уровня, другими 
словами, схемы, вложенные в схему базового уровня, тоже распечатываются 
(по умолчанию). Вы можете отменить вывод на печать этих схем, 
деактивировав бокс выбора Include nested Charts (Включая вложенные 
схемы) (в SIMATIC Manager). 
Кнопкой "Options" в диалоговом окне, Вы можете отобразить дополнительные 
свойства принтера. Независимо от текущего шаблона схемы (он может быть 
установлен через "Options > Customize > Layout..." ("Выбор > Настройки > 
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Шаблон")), в этом диалоге Вы можете определить, должны ли выводиться на 
печать адреса, входы,  выходы и информация из заголовков блоков.  

Распечатка текущего дисплея динамики 
Вы можете распечатать активный дисплей динамики, используя обычную 
функцию печати (Chart > Print...(Схема > Печать)). Должны распечататься 
текущие значения переменных на момент запуска задания на печать.  

Ширина колонок устанавливается оптимальной для печати. По умолчанию 
используется горизонтальное расположение листа, что может быть временно 
изменено через свойства принтера. 

Блок / Вложенная схема 
В диалоге "Properties – Block" («Свойства – Блок») и "Properties – Chart" 
(«Свойства – Схема»), Вы можете распечатать таблицу входов и выходов, 
используя кнопку "Print..." («Печать»). 

Ширина колонок устанавливается оптимальной для печати. По умолчанию 
используется горизонтальное расположение листа, что может быть временно 
изменено через свойства принтера. 

5.1.1 Колонтитулы  

Печать в DOCPRO  
С дополнительным пакетом DOCPRO Вы можете распечатать схему (или 
схемы) CFC вместе с колонтитулами. В колонтитулах делаются различия 
между глобальными и локальными данными схемы. 
Вы можете ввести глобальные данные проекта, используя  DOCPRO или 
SIMATIC Manager; локальные данные, заданные для схемы, должны 
вводиться в редакторе CFC. Обратите внимание, что данные, заданные для 
схемы, для отдельных схем перекрывают введенные глобальные данные. 
Вы можете также ввести данные, заданные для схемы даже, если Вы не 
имеете установленного дополнительного пакета DOCPRO. Эти данные 
сохраняются и могут быть напечатаны позднее, когда DOCPRO будет 
доступен для заданий печати. 
Колонтитулы включают фиксированные поля с непрерывной нумерацией 
страниц задания на печать. Для заданий до 99 страниц показывается как 
последовательный номер, так и общее число страниц; например, 2 / 14.  
Если в заданной обложке более 99 страниц, глобальный номер страницы не 
отображается, однако номер страницы следует за "+" , что является 
указанием на то, что следует большее число страниц; например 1+ .... 7+ и 
т.д.  
За номером последней страницы следует "-"; например, 127-. 
В глобальных колонтитулах Вы можете ввести ключевые слова,  которые 
заменяются текущим текстом при печати. Текущие тексты получаются из 
свойств схемы (Object Properties) (например, комментарий схемы, дата 
создания и т.д.). Вы можете использовать ключевые слова, а их значения 
разъяснены в интерактивной помощи для CFC. 
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Колонтитулы для заданной схемы  
Командой меню "Chart > Footers..." ("Схема > Колонтитулы"), Вы выводите 
диалоговое окно с несколькими страницами: от "Part 1" ("Часть 1") до "Part 4" 
(Часть 4") и "Свободные поля". 

Здесь Вы делаете вводы в активных полях, таких как: Type of document (Тип 
документа), Date created (Дата создания), Document number (Номер докумен-
та), Date  modified (Дата изменения), Free texts (Свободный текст) и т.д. 

5.2 Справочные данные схемы  

Обзор 
Командой меню "Options > Chart Reference Data..." («Опции > Справочные 

данные схемы…») или нажав на кнопку  в панели инструментов,  Вы 
можете запустить и отображение, и печать различной информации в виде 
списка или как древовидную структуру (см. 5.2.1). 
Этот список помогает Вам  при проверке спроектированной Вами структуры.  

Различные версии 
Список создается только системой и не обновляется автоматически. Каждый 
список содержит информацию о состоянии проекта на момент создания 
списка. Различные версии этого списка могут быть открыты одновременно.  
Если необходимо, Вы можете обновить список, используя команду меню 
"View > Update" («Вид > Обновить») или клавишу "F5". 

Дальнейшие возможности 
Вы можете сгенерировать списки не только для проекта, редактируемого в 
CFC, но имеете доступ ко всем другим проектам CFC. Это позволяет Вам 
сравнить различные проекты. Списки различных проектов могут быть 
открыты одновременно. 
Командой меню "Edit > Find..." («Редактировать > Найти»), Вы можете найти 
термы (текстовые строки) в активном окне. Если терм найден, показывается 
его расположение.  
Если дважды щелкнуть имя в первой колонке, Вы можете открыть схему, в 
которой расположена указанная точка. Соответствующий объект будет 
выделен. 

Документация 
Наряду с распечаткой схем, справочные данные обеспечивают Вас полной 
документацией о спроектированной Вами структуре.  

Экспорт 
Вы можете сохранить сгенерированный список как файл в формате CSV 
(например, для использования в EXCEL) командой меню "Reference Data > 
Create Export File..." («Справочные данные > Экспортировать файл»).  
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5.2.1 Список справочных данных по схеме 

Вы можете отобразить на экране или распечатать следующие справочные 
данные: 

• Run Sequence (Последовательность исполнения)   
Графическое представление всей последовательности выполнения CPU. 

• Cross-References Chart Element -> Address (Перекрестные ссылки 
элементов схемы > Адреса) 
Список включает все глобальные адреса, используемые в проекте с 
элементами, которые обращаются к ним. 

• Cross-References SFC -> Chart Element (Перекрестные ссылки SFC > 
Элементы схемы) 
Доступы всех схем SFC к входам и выходам элементов схем CFC. 

• Cross-References Chart Element -> Run-Time Group (Перекрестные 
ссылки элементов схемы > Группы исполнения) 
Список включает доступы ко всем рабочим группам всех схем CFC и SFC. 

• Block Types (Типы блоков) 
Список включает соответствие между объектами проекта CFC и 
ресурсами S7. 

• S7 Resource Allocation (Назначение ресурсов S7) 
Список включает соответствие между объектами проекта CFC и 
ресурсами S7. 

• Local Data (Локальные данные) 
Список включает все OB в программе с вычисленными потребностями в 
локальных данных и размере локальных данных отдельных классов 
приоритетов, используемых в проекте и реально существующих на CPU. 

• Block Call Hierarchy (Иерархия вызова блоков) 
Графическое представление иерархии вызовов всех блоков программы.  

• Textual Interconnections (Текстовые соединения) 
Этот список включает все текстовые соединения (путь, указывающий на 
цель соединения) с именем схемы и элемента – источников соединения. 

• Statistics (Статистика) 
Графическое представление числа всех объектов CFC и SFC и 
используемых  ресурсов S7, а также временные метки текущей 
программы и объектов проекта. 

Для детального описания списков и значения колонок обратитесь к 
интерактивной справке по CFC. 

5.3 Протоколы 

Протоколы не принадлежат к документации спроектированной структуры, но 
могут обеспечить важную информацию в процессе проектирования и пробных 
пусков, если происходят ошибки. 

Для дальнейшей информации о протоколах справьтесь в интерактивной 
справке в разделе "Logs" («Протоколы»). 
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A Технические Спецификации 

A.1 [S7] Технические спецификации 

Требования к аппаратному обеспечению 
 
• SIMATIC PG или PC 
• Процессор Pentium 1 ГГц (или выше) 
• RAM не менее 512 Мбайт ( или больше) 

• Графическая карта SVGA 1024 x 768 (или выше) 
• Соединение MPI для интерактивной работы  
• SIMATIC S7-300, S7-400 

Требования к программному обеспечению  
 
• Microsoft Windows 2000 (SP3) 

или  
• Microsoft Windows XP (SP1) 

или 

• STEP 7 V5.3 SP1 или выше 
• S7-SCL V5.1 SP3 или выше   
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A.2 Длины полей/имен и договоренности  

 
Объект Длина Примечания 

Схема 22 Имя не должно содержать следующие символы:  
 \  .  "  %  

Комментарии к схеме 255 Доступны все символы ANSI . 
Группа выполнения 22 Те же символы что и для "схемы" 
Задача 22 Те же символы что и для "схемы" 
Тип блока 8 Определяется STEP 7. 
Комментарии 
для экземпляра блока  

80 Доступны все символы ANSI. 

Имя параметра 24 Определяется STEP 7. 
Первый символ не может быть числом (0 - 9). 

Комментарии параметра 80 Доступны все символы  ANSI. 
Имя экземпляра блока 16 Имя не должно содержать следующие символы:  

 \  .  "  %  
Глобальные переменные 24 Символы определяются редактором. Разрешается 

использовать любые, в том числе пробелы и специальные 
символы за исключением   ". 
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A.3 [S7] Типы данных 

 
Сокр. Ключевое слово Значение Биты 

A ANY Указатель на элемент данных 80 
BO BOOL Логическая переменная 1 
BY BYTE Последовательность из 8 бит 8 
C CHAR Простой символ 8 
CR COUNTER Номер счетчика S7  16 
D DATE Дата 16 
DB BLOCK_DB Номер DB 16 
DI DINT Двойное целое 32 
DT DATE_AND_TIME или DT Дата и время 64 
DW DWORD Последовательность из 32 бит 32 
FB BLOCK_FB Номер FB 16 
FC BLOCK_FC Номер FC 16 
I INT Целое 16 
P POINTER Указатель на область памяти 48 
R REAL Число с плавающей точкой 32 
S STRING Строка произвольной длины  256 байт 
SD BLOCK_SDB Номер SDB 16 
SN  STRING[n] Текстовая строка с максимум n символами, 1 < n 

< 253 
 

ST STRUCT Круглые скобки для элементарных типов данных 
и других структур (глубина вложенности: 8) 

 

T TIME_OF_DAY или TOD Время дня 32 
TI TIME Интервл времени 32 
TR TIMER Номер таймера S7  16 
T5 S5TIME Длительность в формате S5  16 
W WORD Последовательность из 16 бит 16 

 
Для более детального описания типов данных пользуйтесь интерактивной 
справкой. 
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B Список сокращений 

BOP Основные операции 

C / C++ Язык программирования высокого уровня 

CFC Непрерывные функциональные схемы  

CPU Центральное процессорное устройство 

DB Блок данных 

ES Инженерная система 

FB Функциональный блок 

FC Функция  

HID Наивысший уровень обозначения 

IEA  Ассистент импорта/экспорта 

LAD Контактная схема 

OB Организационный блок 

OCM Управление и мониторинг оператором (WinCC) 

OS Операторская станция  
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PC Персональный компьютер 

PCS 7 Система управления процессом (SIMATIC)  

PG Программирующее устройство 

PH Иерархия производства 

PLC Программируемый (логический) контроллер 

SFB Системный функциональный блок 

SFC Последовательные функциональные схемы   

SINEC Сетевая архитектура Siemens  

STEP 7        Оболочка разработки программного обеспечения для SIMATIC S7/ M7 

STL Список команд 
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